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1. INTRODUCTION

QU'EST CE QUE LUTECE ? .U T E .E

OPEN SOURCE PORTAL

Lutece est un logiciel libre diffusé sous licence BSD par la Mairie de Paris depuis
septembre 2002. Il a été accepté en 2014 au sein du consortium Open Source international OW2.

Lutece était a I'origine un Gestionnaire de contenu / Portail, mais a évolué au fil des années vers un outil de développement
d'applications Web. Il est tres largement utilisé par la Mairie de Paris pour la réalisation de ses sites, ses services
numériques et ses applications métiers.

Lutece est un outil complet prét pour les plus grandes exigences et certaines normes. Si, au niveau de |'utilisation, il partage
I’essentiel avec des CMS plus répandus, I'existence de plug-ins métier spécifiques en fait un outil hautement personnalisable
en terme fonctionnel.

Lutece est ou a été utilisé par de prestigieuses références telles que MétéoFrance.fr, Notaires.fr, AtosWorldline.com,
GeoPortail.gouv.fr, Paris.fr ou Marseille.fr.

A PROPOS DE CE LIVRE

Ce document offre une vision fonctionnelle du framework Lutece.
Il peut étre lu pour apprécier les fonctionnalités de Lutece et consulté pour servir d’appui au paramétrage d’une application
a la suite d’une intégration de modules métiers.

Ce livre s’adresse a un panel varié d'utilisateurs fonctionnels, du webmestre souhaitant construire son site, au responsable
de maitrise d’ouvrage d’un organisme public cherchant a répondre a des besoins d’usagers.

PRESENTATION DE L’OUVRAGE
Ce document est construit sur plusieurs themes :

¢ Informer le public décrit un panel de fonctionnalités permettant de diffuser de I'information aux usagers, pages
institutionnelles, pages événements, pages actualités...

* Proposer des services au public détaille les modules les plus utiles pour proposer des services en ligne,
dématérialisés, aux usagers. Ceux-ci permettent de gérer par exemple des demandes, des échanges de documents
administratifs, d'effectuer des démarches sans avoir a se déplacer, etc.

* Faire participer le public expose les outils permettant de s’adresser directement aux usagers, de recueillir sous
diverses formes leurs avis — sondages, quizz, évaluations —, traiter et gérer leurs réponses, commentaires ou
notations. En particulier ces fonctionnalités sont utiles pour évaluer les besoins futurs, les retours d’expériences
d’actions aupres des usagers, et la communication entre les deux mondes.

o Aller plus loin regroupe des fonctionnalités qui ont été apportées au portail, mais qui sont plus générales et parfois
supports des autres modules.

LES AUTEURS

Ce livre a été rédigé durant un Booksprint de 5 jours en aolt 2015, organisé par Floss Manuals Francophone et I'’équipe de
Lutece. Les coauteurs de cet ouvrage sont : Magali Bouvat, Baptiste Gabourin, Cédric Gémy, Jon Harper, Laurent Hohl, Elysa
Jouve, Magali Lemaire, Isabelle Lenain, Pierre Levy, Alexandre Mangot, Loic Martinez, Frangois-Eric Merlin, Yvan Michel,
Jérome Poirier, Marie-Pierre Roux, Elisabeth Saumard, Rémi Zara et Elisa de Castro Guerra.




Cet ouvrage est sous licence GPL et licence Creative Commons By SA. Vous étes libre de le lire, le partager, le modifier.



2. QU'EST-CE QUE LUTECE ?

Doté d’une interface intuitive permettant de simplifier la création de portails internet, intranet et extranet, ou encore
d’'applications métiers, Lutece a pour vocation :

de fournir les briques principales de création de votre site ou application

de vous permettre de créer simplement des formulaires, quizz, sondages et de les partager sur les réseaux sociaux,
de faciliter la gestion éditoriale de vos contenus,

d'intégrer tout type de charte graphique

d’offrir une interface d’administration simple.

Articulé autour d’un socle commun et de modules fonctionnels (appelés plug-ins), Lutece permet la mise en place des
fonctionnalités suivantes :

création d'une arborescence sur mesure d’un site.

Insertion dans les pages de types de contenus classiques (textes, fichiers, images, vidéos, lettre d’informations...) ou
plus interactifs (formulaires, quizz, sondages, fil RSS...).

Processus de gestion des contenus éditoriaux (Documents) selon un circuit de validation (workflow) qui peut s'adapter
a votre organisation (Rédaction, Correction, Validation, Publication).

acces facilité a la mise a jour des contenus (navigation via I’ergonomie du site public, recherche en texte intégral dans
les documents, acces par le plan du site dynamique, accés par saisie du numéro/identifiant de la page...).

Utilisation de cartographie dynamique

gestion de groupes de travail collaboratif

mise en place de portail de gestion et de suivi de demandes dématérialisées

outils web applicatifs dans le cadre de développements spécifiques, liés en général aux métiers de I'Administation
francaise (gestion des cimetiéeres, gestion des concours et examens professionnels, outil de suivi des Projets de
Délibération d'un Conseil Municipal ou Départemental, ...)

Lutece ayant été développé au sein du service informatique de la Ville de Paris, il s'adresse naturellement aux collectivités
locales et aux administrations.

Il respecte ainsi la réglementation liée aux déploiements des services numériques tels que le Référentiel Général
d'Accessibilité des Administrations (RGAA), ou encore |le Référentiel Général de Sécurité (RGS).

Il bénéficie aujourd'hui d'un catalogue important d'applications métiers liées aux administrations et d'une communauté
d'utilisateurs et de développeurs francophones.



3. QUELQUES EXEMPLES DE SITES

Nous proposons ici quelques exemples de sites qui utilisent Lutece personnalisé et adapté a des besoins différents
(informations, espace de vote, téléservices).

MAIRIE DE PARIS

SITE DU BUDGET PARTICIPATIF

LES PROJETS 2015
EOMNT EM LIGME !
Ll R

Varle 2015 Le Budgel Parlivipalil 7 Edilion 2014 Aclualile FAR Conlasl

Kit de communication
du hudget participatii 2015

voir sur https://budgetparticipatif.paris.fr/bp/

La Mairie de Paris est a |'origine du projet Lutece. Elle est donc particulierement bien placée dans son utilisation avec pas
moins de 180 sites qui |'utilisent. Parmi ceux-ci, on pourra mentionner les sites des mairies d’arrondissement, les
téléservices de Paris.fr — encombrants, inscriptions aux concours, état-civil...

Dans ce site le travail sur la page d’accueil est particulierement graphique, et met en ceuvre de nombreuses fonctions
d’édition et de gestion de document. Mais surtout, il démontre a quel point un site internet peut devenir un moyen de
développer I'interaction avec les usagers.
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Le rapport du Médiateur a la Maire de Paris Parm:;'l:snms du Médiateur assurées en juillet et
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PLAN DU SITE CONTACT ESPACE INTERNE NOUS SUIVRE
Home Porser une question ? Beprésentants du médiatenr
Eaxe appel au médateur
Propostions
Documentation
Actug
MralFaus

Voir a I'adresse : https://mediation.paris.fr/mediation/

La mise en ceuvre du site du Médiateur de la Ville de Paris a été réalisée uniguement sur la base des plug-ins existants de
Lutece et n'a pas nécessité de développement. Le plus gros travail a concerné I'intégration graphique.

L'équipe de la Médiation est désormais totalement autonome pour mettre a jour le site, modifier la page d’accueil, modifier
et mettre a jour des articles, le fond documentaire ou encore la liste des questions les plus fréquemment posées. lls
accedent également aux saisines des usagers qui ont déposé un recours via le formulaire présent sur le site.

PRISE DE RENDEZ-VOUS POUR LES SERVICES DU STATIONNEMENT

Le service de la Mairie de Paris assurant la mise a disposition de cartes de stationnement bénéficie d'un site Lutece
permettant aux Parisiens résidant ou travaillant a Paris de prendre rendez-vous avec le service afin d’obtenir une carte de
stationnement pour leur véhicule.

La mise en place de ce site de rendez-vous a permis au service d’organiser de maniére plus efficace la distribution des

cartes, en évitant en particulier aux Parisiens de devoir se déplacer sans rendez-vous avec le risque d'une attente pouvant
parfois atteindre deux heures.

Le site est accessible sur le lien suivant : https://teleservices.paris.fr/rdvssvp/

STATIONNEMENT RESIDENTIEL, STATIONNEMENT


https://mediation.paris.fr/mediation/
https://teleservices.paris.fr/rdvssvp

PR ONNEL,
RENDEZ-VOUS POUR
EFFECTUER VOTRE DEMANDE

MAIRIE DE PARIS & Le service de prise de rendez-vous pour les cartes de stationnement est mis en place par la Section du
nemert sur Vioie Publique de Ia Direction de I Vioirie et des Déplacements. Conformément & ks loi

‘omulée par ecrit auprés du service gestionnaire

indiquant nom, prénom, e-mail et adresse. Toute demande doit &tre signée et accompagnée de la
photocopie d'un titre didentité portant la signature et préciser ladresse & laquelle doit parvenir la reponse.
Une réponse sera alors adressée dans un délai de 2 mois suivant la réception de la demande.

LUNDI MARDI MERCREDI JEUDI VENDREDI SAMEDI DIMANCHE
10/08/2015 11/08/2015 12/08/2015 13/08/2015 14/08/2015 15/08/2015 16/08/2015

T ol
| ' ; L

Disponible Disponible

Disponible Disponible Disponible

Disponible Disponible Disponible

Disponible Disponitle 10h00 - 10h15
S _.ﬁ

Disponible Disponible Disponible

Disponible Disponible Disponible

STATIONNEMENT RESIDENTIEL, DEMANDE DE RENDEZ-VOUS

Prénom *

Marc

Email *

marc duval@gm .

Objet du rendez-vous *

® Je souhaite obtenir ou renouveler une ou des carte(s) de stationnement résidentiel

© Je souhaite obtenir une ou des carte(s) véhicule basse émission (véhicules électriques, au gaz naturel et
hybrides rechargeables)

® e souhaite obienir une ou des carte(s) de stationnement résidentiel et une ou des carte(s) véhicule basse
émission
la rubrique dédiée de paris.fr

En cochant cette case, jaccepte d'étre contacté par la Mairie de Paris dans le cadre d'enquétes de
satisfaction :

9 Jaccepte

MAIRIE DE MONT-DE-MARSAN

SITE DE LA VILLE ET DE LA MEDIATHEQUE




_en
capitale

MA VILLE MA MAIRIE VISITE GUIDEE J'ENTREPRENDS
Etratives = Démnizit es

Vous étes ici : accueil = JAl BE

d"Etat civil
Actes d'Etat civil Le Conseil Gardons le contact
Envoyer un courriel
Expression Tél.: 05 58 05 87 87
Je suis... Rens. . Sewice population, 05 58 05 8 i
Sélectionnez... - Services coordonnées

eclarations

Jai besoin de | You
Bl &R

Recevoir la
newsletter

Sélectionnez j

Renseignements

pratiques Journal municipal

Sélectionnez...

E.SERVICES

Démarches d’Etat civil

Plan de Ia ville

P, . n . S'abonner a m2m
Infos travaux « Copie intégrale d'un acte de naissance de mariage

Panneaux lumineux

Menus scolaires

et de reconnaissance

[T O TR e EMoaioe oa do Coansail municinal

La mairie de la ville de Mont-de-Marsan a décidé de passer son site sous Lutece. Elle a particulierement exploité les
fonctionnalités éditoriales proches en utilisant principalement les fonctionnalités du CMS. Dans la foulée, d’autres sites de la
région ont suivi comme celui de la médiatheque du Marsan (http://lamediathequedumarsan.fr).

Voir a I'adresse : http:/www.montdemarsan.fr
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4. CONCEPTS GENERAUX

Dans ce chapitre, vous trouverez les principes de base du fonctionnement d’un site sous Lutece. Vous verrez notamment les
différences dans I'utilisation du Front-office et du Back-office, les principes généraux de I’ergonomie ainsi que le tableau de

bord, la notion d’utilisateur ou de workflow.

Vous retrouverez dans le guide tous ces éléments de facon plus détaillée quand cela sera nécessaire. Leur mise en
application en détail et la mise en pratique pas-a-pas se trouvera donc dans les chapitres suivants.

FRONT-OFFICE/BACK-OFFICE

Il est important de distinguer :

¢ Le site public, destiné aux internautes, que I'on appelle le front office. Ce site public est concu et mis a jour a I'aide

de I'interface d’administration,

¢ L’interface d’administration Lutece, destinée a la gestion du site (création de I’arborescence, intégration des

contenus, gestions des droits d’'acces...), que I'on appelle le back-office.

o Le front-office et le back-office auront deux URL distinctes.
o Le front-office est accessible via I’adresse : http(s)://<nom_domaine>/<nom_site> ou
http(s)://<nom_domaine>/<nom_site>/jsp/site/Portal.jsp

o Le back-office est accessible via I'adresse :
http(s)://<nom_domaine>/<nom_site>/jsp/admin/AdminLogin.jsp

Front-office :

LUTECE aze

Source code

Documentation

OPEN SOUR

Free and powerful Java™ based

Easy to Use...

Have a look at the back-office and connect as
the site Administrator or the site Webmaster

...Easy to Install

Try to install as a

Docker container

Documentation

Access the Documentation.

Back-office :

Connect to back-office

User code
Type admin or webmaster

Log as "admin", all rights and features or
"webmaster"

Password

Modular

It provides a very modular architecture with over 300
plugins and a powerful assembling system based on
Apache Maven.

® Sauthentifier

Open Source

LUTECE is released under the BSD License and
maintained on GitHub . It uses best of breed Open
Source software libraries Spring, Encache, Freemarker,
Lucene, ...

Responsive Design

Build with the Iatest releases of Twitter Bootstrap CSS
framework.
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1.3 2 admin Admin ~

Administration du Site Liste des annuaires

Derniére page modifiée Titre Actions
2 B [+] =]

Administration du Site @

I

Nombre d'utilisateurs.

Liste des annuaires ©
Gestion des utilisateurs @

Liste de formulaires

47 Administration du Site Titre Actions
Nombre de plugins installés Derniére rubrique modifiée A ou'attendez vous d'un CMS open-source 7 E En
B contents available - Html ou Texte libre E Nombre de réponses 0

Gestion des Plugins ©

Liste de formulaires @
Administration du Site ©@

Termes les plus recherchés

Liste des workflows

Termes

Mon dernier document

I

Titre Actions
Aucun document trouvé correspondant aux critéres définis
Liste des workflows ©
Gestion de documents @

Dernier document publié
Aucun document trouvé correspendant aux critéres définis

Gestion de documents @

INTERFACE D’ADMINISTRATION OU BACK-OFFICE

Pour accéder au back-office on utilise donc I'adresse :
http(s)://<nom_domaine>/<nom_site>/jsp/admin/AdminLogin.jsp

La connexion a l'interface d’administration nécessite une authentification. Pour se connecter sur I'administration de votre
site, cliquez sur le lien de I'URL qui vous aura été transmise par votre administrateur, entrez votre code d’acces et votre mot
de passe et cliquez sur le bouton Se connecter.

Si 3 tentatives d’authentification échouent, I'accés a I'interface est bloqué temporairement.

ERGONOMIE DE L'OUTIL

Comprendre les principes d'ergonomie de Lutece permet de pouvoir utiliser tout les types de fonctionnalités, toutes basées
sur les mémes principes de navigation.

LE TABLEAU DE BORD

Apres l'identification, I'écran ci-dessous apparait sous la forme d’un tableau de bord et permet d’accéder :

e ala zone d'information (nombre d’utilisateurs, plug-ins installés, statistiques de recherche) ;
I’administration du site ;

des acces directs vers certaines applications.

[Vl Vg g
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OUTILS DE
PARAMETRAGE
VISUALISATION ACCES AUX FONCTIONNALITES (mot de passe, langue
DU SITE D'ADMINISTRATION accessibilité, déconnexion)

.U T E.[ ? Contenu ~  Sitew  Applications » Ges €5 N ﬁ 1;3dr“m Admin =

4 Administration du Site Liste des annuaires

Derniére page modifiée Titre Actions

Nombre d'utilisateurs @Hgme u E

Gestion desutilsateurs © Administration du Site ©

Liste des annuaires ®

I

Liste de formulaires

47

Administration du Site Tire aclians

Nombre de plugins installés Deanitrerubrigee modihle u Qu'attendez vous d'un CHS E E
n Contents available - Html ou Texte libre E open-source 7 u
Gestion des Plugins @ Nombre de réponses 0
Administration du Site @ Liste de formulaires ©

Termes les plus recherchés

Termes les plus recherchés @ Mon dernier document Liste des workflows *
Aucun document trouvé correspondant aux critéres définis Titre Actions
Gestion de documents © Liste des workflows ©

ACCES A LA ZONE Dernier document publié
D’|NFURMAT|0N Aucun document trouvé correspondant aux critéres définis

Gestion de documents @

ACCES DIRECT ACCES DIRECT AUX
A CADMINISTRATION DU SITE APPLICATIONS
ET AUX DERNIERS DOCUMENTS CREES

LES UTILISATEURS

Deux types d’utilisateurs sont a distinguer :

o Les utilisateurs de I'interface d’administration Lutece ou Gestionnaires Lutéce
e Les utilisateurs visiteurs du site public ou Internautes

Les gestionnaires peuvent disposer de droits d’acces différents (les uns par rapport aux autres) aux fonctionnalités
d’administration. Les internautes, eux aussi, peuvent disposer de droits d’accés a certaines pages du site public.

La création et I'attribution de ces droits est totalement paramétrable avec Lutece, ce qui permet de répondre aux
spécificités de votre organisation interne.




La gestion des utilisateurs est traitée plus en détail dans le manuel de I'intégrateur.
LES PROPRIETES DU SITE

Les propriétés du site permettent de définir les éléments indispensables a son référencement, a sa gestion par les
internautes.

Vous pourrez donc modifier via I'interface d’administration :

la description meta, connue pour intervenir dans I'affichage des résumés de page dans les moteurs de recherche

les mots-clés a associer par défaut au site

les mentions de copyright qui doivent étre mis en méta (informations invisibles a I'utilisateur, mais utiles aux outils
d’'indexation), au niveau des mentions |égales (ce texte apparait le plus souvent en bas de page)

les e-mails associés au site, e-mail du webmaster qui sera le contact par défaut des formulaires, e-mail no-reply
souvent associé a des fonctions particulieres...

Pour avoir le détail des propriétés et de leur impact, reportez-vous au manuel intégrateur.

LE WORKFLOW

Le workflow désigne dans Lutece le circuit de traitement des demandes. La demande en fonction de I'avancement de son
traitement et des actions effectuées passe dans des états différents.

Par exemple, des candidats souhaitent postuler pour obtenir une bourse, la collectivité va définir un circuit de traitement de
la demande :

1.
2.

3.
4.

elle va vérifier si la candidature répond aux critéres de recevabilité, si elle ne I'est pas le candidat en sera informé
en fonction des critéres de la demande, celle-ci va étre redirigée au jury compétent pour évaluer les motivations du
candidat

il sera procédé ensuite a la sélection des lauréats

si le candidat est sélectionné ou non sélectionné, il en sera informé par un mail personnalisé

Avant de créer un workflow, vous devez donc définir le circuit de traitement de votre dossier ou de votre demande.

Pour en savoir plus référez-vous au chapitre concernant les formulaires.

14


http://fr.flossmanuals.net/lutece-guide-integrateur/gerer-les-utilisateurs/
http://fr.flossmanuals.net/lutece-guide-integrateur/gerer-les-utilisateurs/
consulter-et-diffuser-les-resultats-du-formulaire

5. QUICK START

Pour prendre en main Lutece apres que le paramétrage du site ait été réalisé, il faut accéder au back-office qui va vous
permettre de gérer les utilisateurs, leurs droits, définir les propriétés de votre site et enfin commencer a apporter du contenu.

SE CONNECTER AU BACK-OFFICE

La connexion a I'interface d’administration nécessite une authentification. Pour se connecter sur I’'administration de votre
site, entrez votre code d’'accés et votre mot de passe et cliquez sur le bouton Se connecter.

N.B. Si 3 tentatives d’authentification échouent, I’accés a I’interface est bloqué temporairement.

Bienvenue sur LUTECE

Authentification

Se connecter

Veuillez saisir vos login et mot de passe pour accéder
au module d'administration

Mot de passe oublié ? Code d'accés oublié ?

rFowereD BY

SE DECONNECTER DU BACK-OFFICE

A tout moment, il est possible de se déconnecter de I'interface d’administration par le lien Deconnexion en haut a droite.

#A L admin Admin -

& Mot de passe

@ Activer le mode accessible

2 Langue

. Engish [N

/& Administration technique

SE
DECONNECTER

©@ Documentation

= Déconnexion

LA DECONNEXION AUTOMATIQUE

La non-utilisation de I'interface d’administration aprés une durée correspondant au paramétrage du serveur web entraine une
déconnexion automatique.

CHANGEMENT DE MOT DE PASSE

Tout gestionnaire Lutece a la possibilité de changer le mot de passe qui lui a été initialement attribué. En revanche,
I'identifiant (code d’acces) ne peut étre modifié que par un gestionnaire ayant le droit de modifier les comptes utilisateurs.

Pour changer de mot de passe :

1. Cliquer sur Mot de passe dans la page d’accueil de I'interface d’administration. (Zone a droite de I'écran)

15



A | L admin Admin ~

Mot de passe

@ Activer Te mode accessible

3 Lanue CHANGER DE
| e MOT DE PASSE

/ Administration technique

© Documentation

= Déconnexion

L'écran qui apparait propose d’effectuer la saisie ci-dessous (tous les champs sont obligatoires).
. Saisir son mot de passe actuel (Champs Mot de passe actuel).

. Saisir son nouveau mot de passe (Champs Nouveau mot de passe).

Saisir a nouveau son nouveau mot de passe (Champs Confirmation).

. La validation de cette saisie (via le bouton OK) valide le changement de mot de passe.

oOUAWN

[ 1T 0 13

Saisie des informations de changement de mot de passe

Mot de passe actuel * -
Nouveau mot de passe * a
Confirmation * ]

Complexité du mot de passe

(*) CHAMPS OBLIGATOIRES
Le champ complexité du mot de passe vous indique le niveau de sécurité de celui-ci. Il est conseillé d’associer au moins une
majuscule dans le texte saisi et quelques chiffres.

IMPORTANT : le mot de passe doit avoir au minimum 8 caractéres, sans espaces ni caractéres accentués ou
spéciaux. La limite a ne pas dépasser est de 100 caractéres. La pratique courante est de définir un mot de
passe d’environ 15 caractéres contenant des lettres et des chiffres.

NAVIGUER DANS LE BACK-OFFICE
Une fois authentifié, vous serez dirigé vers le back-office qui vous permettra de modifier de nombreux paramétres et de

faire vivre le site. Vous devez obtenir un écran proche de I'écran ci-dessous, méme s'il peut varier en fonction des droits qui
vous sont attribués.
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4 Administration du Site Liste des annuaires 2
Dernié difié Titre Actions

Nombre d' utilisateurs eriicre page modilice -
Home n =

Liste des annuaires ©

sasim s willen e Administration du Site @

I

Liste de formulaires

47

Administration du Site

Titre Actions
Nombre de plugins installés Derniére rubrique modifiée 3 au'attendez vous d'un CMS z [ =]
u Contents available - Html ou Texte libre E open-source?

Gestion des Plugins © MNombre de réponses 0

Administration du Site @ Liste de formulaires ©

Termes les plus recherchés

Mon dernier document Liste des workflows +

Aucun document trouvé correspondant aux critéres Titre
définis

Actions

Liste des workflows @
Gestion de documents &

Dernier document publié

TESTER LA PLATE-FORME LUTECE

Si vous souhaitez tester les différentes possibilités avant de vous lancer, une plate-forme de démonstration est disponible
sur le site en ligne Lutece.
Elle est accessible a cette adresse : http://dev.lutece.paris.fr/site-demo/

n LUTECE tr Source code  Documentation @ s'authentifier

Free and powerful Java™ based Content M
Framework

User code

Easy to Use... Log as "admin®, all rights and features or “webmaster”

Have a look at the back-office and connect as the site Administrator Password

or the site Webmaster
seesnssnse

...Easy to Install

Log Me |
Ty towsatzse

Modular

Docker container It provides a very modular architecture with over 300 plugins and a
powerful assembiing system based on Apache Maven.

Documentation

Access the Documentation.
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La connexion au back-office d'administration se fait par la mire de connexion intégrée sur la page d'accueil (code utilisateur
"admin" pour obtenir les droits administrateur (le plus élevé) et webmaster si vous souhaitez tester avec des droits plus
restreints), mot de passe "adminadmin").

Il suffit ensuite de cliquer sur le bouton de connexion.

Vous pourrez ensuite tester les différentes fonctionnalités proposées dans le site de démonstration.

Les chapitres essentiels pour commencer:

Introduction a la gestion de contenus
Créer I'arborescence de son site
Créer mes premiers contenus

Gérer et publier des contenus

Créer une FAQ

Et si vous souhaitez aller plus loin....

Comment créer un formulaire

Consulter et diffuser les résultats du formulaire
Prise de rendez-vous usager

Créer une enquéte

Commenter, évaluer, noter et partager les contenus
La gestion des utilisateurs

Créer une billetterie

Les petites annonces

Cette liste peut étre complétée par d'autres fonctionnalités si vous décidez de réaliser votre propre site personnalisé (voir le
Guide d'Intégration Lutéce)

Pour développer des plug-ins Lutece, référez-vous au guide développeur Lutece.
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http://fr.flossmanuals.net/lutece-guide-developpeur/introduction/

INFORMER LE PUBLIC

6. INTRODUCTION A LA GESTION DE CONTENUS

7. CREER L'’ARBORESCENCE DE SON SITE ET ORGANISER
SES PAGES

8. CREER MES PREMIERS CONTENUS

9. GERER ET PUBLIER MES CONTENUS

10. CREER UNE LETTRE D'INFORMATION

11. CREER UNE FAQ
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6. INTRODUCTION A LA GESTION DE CONTENUS

Pour faire vivre le site, publier un nouvel article ou ajouter une information, il convient de modifier les contenus par la partie
administration du site. Ce chapitre est consacré a la description et I'explication du traitement des contenus par Lutece.

L'’ADMINISTRATION DU SITE

L'administration du site (Accés via le menu Site > Administration du site ou via le Tableau de Bord « Administration du
site ») permet :

e de concevoir I'arborescence des pages du site public ;

e d'insérer au sein de chacune des pages, des blocs de contenus (appelés Rubriques) et leurs contenus associés (texte,
images, liens) ;

e de choisir (et de modifier) le positionnement (ordre d’affichage) des rubriques les unes par rapport aux autres et le
placement des rubriques dans I'une des colonnes disponibles sur la page ;

e de modifier ces blocs/rubriques et leurs contenus ;

e de choisir le mode d'affichage (écran large, tablette, smartphone, plein écran).

MENU DEROULANT D'ACCES AUX
FONCTIONNALITES D’ADMINISTRATION INSERTION DE PAGES,
CHOIX DU MODE DU SITE RUBRIQUES ET GESTION
D’AFFICHAGE / \ DE LEUR POSITIONNEMENT

AdministMtion du Site

Oﬂom Bfubrique » [ Dxtensions = FPropiétés - Pagefille g Plandu site [ ERERIE Q
(T H T Secherher

GESTION
DES RUBRIQUES

W Suivre Glutecensws '

LES DIFFERENTS TYPES DE CONTENUS

Lutece dispose de différentes fonctionnalités permettant I'insertion de contenus différents pour répondre a des besoins
éditoriaux.

Pour I'insertion du texte ou des médias :

o les contenus que I'on peut insérer directement en un seul clic (exemple : Rubrique HTML/Texte Libre qui permet I'ajout
et I'édition de texte directement a partir de la rubrique) ;

e |es contenus que I'on insére dans des documents disposant de fonctionnalités plus avancées et soumis a un circuit de
production, validation et publication.

Pour les contenus plus spécifiques :

e du contenu participatif pour créer une interaction avec les utilisateurs (formulaires, sondages, vote, enquétes,
partage des contenus, notation, réseaux sociaux) ;

e du contenu informatif pour aider les utilisateurs dans la compréhension d’un domaine particulier (FAQ) ;

e du contenu orienté métier proposant des services aux usagers (créer une billetterie, petites annonces, prise de
rendez-vous ...).

LES BOUTONS D’ACTION

Les boutons d’actions, visibles en fonction des actions et des droits des utilisateurs, permettent d’'effectuer les actions selon
les contextes. Certains sont utilisés régulierement alors que d’autres sont plus spécifiques a certaines fonctionnalités.

BOUTONS COMMUNS A DE NOMBREUSES FONCTIONNALITES

Parmi les boutons tres utilisés par Lutece, nous trouverons les suivants :
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] Modifier
B Suspendre
Supprimer
Valider
Archiver

LA GESTION DES UTILISATEURS

Selon la taille de votre structure, vous serez seul ou plusieurs a pouvoir modifier le site. Tous les utilisateurs, qu’ils soient
visiteurs inscrits ou contributeurs, n'auront certainement pas les mémes autorisations de modification et d’édition.

Un compte utilisateur sous Lutece réunit I'association de droits, d'accés aux fonctionnalités, de réles (ensemble de
permissions sur une fonctionnalité) et éventuellement de groupes de travail (restrictions sur des données).

Lutece possede un module pour créer les comptes et gérer les droits et permissions d’acces aux écrans. Il est possible de
gérer assez finement les permissions entre chaque profil.

Pour connaitre le fonctionnement de ce module reportez-vous au chapitre Gérer les utilisateurs du guide intégrateur.
LA CREATION ET GESTION DES BLOCS DE CONTENUS (RUBRIQUES) DANS LES PAGES

Les rubriques sont créées dans les pages et accueillent un contenu qui varie selon le type de rubrique.

B8 Rubrique Extensions =  # Proprictéd

Document

Formulaire

Html ou Texte libre

Liens vers les pages du site
Liens vers les pages filles
Liste de documents

Liste des flux RSS

MNuage de tags du site
Rubrique Alias

Rubrique quicklinks
Syndication de contenu externe (RS5)
XPage

Une rubrique n'accueille qu'un seul type de contenu, il n’est pas possible de mélanger plusieurs types de contenu dans une
méme rubrique. Il est possible également d’associer une catégorie a une rubrique (exemple article a la une, sport, écologie
...). Si une catégorie est affectée a une rubrique, elle ne pourra accueillir que les contenus de la catégorie qui lui a été

affectée.
L’AGENCEMENT DES RUBRIQUES DANS LA PAGE
Les rubriques, une fois créées, sont positionnées dans les pages en fonction du gabarit de la page (nombres de colonnes

disponibles sur les pages). Ces rubriques peuvent étre ordonnées les unes par rapport aux autres dans une méme colonne du
gabarit (voir schéma ci-dessous, exemple sur deux colonnes).
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COLONNE1

COLONNE2

Rubrique1
Ordre1 Colonnel

Rubrique2
Ordre2 Colonnel

Rubrique3
Ordre3 Colonnel

Rubrique1
Ordrel1 Colonne2

Rubrique2
Ordre2 Colonne2

Rubrique3
Ordre3 Colonne2

Il est possible de modifier :

¢ |e positionnement (ordre d’'affichage) des rubriques les unes par rapport aux autres ;
o |le placement des rubriques dans I’'une des colonnes disponibles sur la page ;
e ces blocs/rubriques et leurs contenus.

LA GESTION DES DOCUMENTS

Un document est un type de contenu dont la structure est paramétrable. Ce document bénéficie d’un processus de gestion de
contenu évolué. Il est soumis a un circuit de validation comprenant production (création du document), validation et
publication.

Il est possible de structurer par type, les documents que |'on souhaite créer.
Plusieurs types sont proposés par défaut : article, enregistrement sonore/fichier son, fiche acteur, image, fichier PDF, vidéo,
etc.

La création d'un type de document et d'un document est plus amplement détaillée dans le chapitre Gérer les types de
documents.

22


http://fr.flossmanuals.net/lutece-guide-integrateur/gerer-ses-types-de-documents/

7. CREER L’ARBORESCENCE DE SON SITE ET ORGANISER SES PAGES

Dans ce chapitre, nous allons étudier les premieres étapes nécessaires a la création d'un site sous Lutece. Nous allons
comprendre le principe de |'arborescence, et ensuite créer, et organiser les pages.

Un site congu a partir de Lutece se présente sous la forme d’une arborescence dynamique de pages, dont la racine est la
page d’'accueil appelée aussi Home Page. La gestion de cette arborescence se fait par le menu Site > Administration du Site.

.U. E . E = Contenu - Site + Applications + Utilisateurs -

Adm ration du Site

Gestion des propriétés du site

Administration du Site

Le schéma ci-dessous présente un exemple d’arborescence de site :

page A page B page C
2 page Al page A2 page A3 page B1 page B2 page B3 page C1 page C2 page C3

La page d’accueil (niveau 0 ou racine du site) est la porte d’entrée du site, elle permet un acces intuitif a tous les types de
contenus disponibles.

Les pages de niveau 1 sont les pages principales du site qui permettent d’organiser les contenus selon des thématiques
prédéfinies (les pages de niveau 1 sont souvent accessibles par des onglets apparaissant sur la page d’accueil).

Les pages de niveau 2 permettent d’associer une sous-arborescence aux pages de niveau 1 et ainsi de suite.
Les intitulés des pages sont totalement renommables par les gestionnaires du site.

L'arborescence du site se crée a partir de la page d’accueil. Il est ainsi possible de déplacer facilement une page fille dans
I'arborescence en changeant sa page mere.

CREATION D’UNE PAGE FILLE

Rendez-vous dans I'administration du site via le menu Site > Administration du site. Depuis la page meére, il est possible de
créer une page fille en cliquant sur le bouton + Page fille.
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AJOUTER UNE PAGE FILLE

@ FARIS =

Administration du Site

Qrome D 0 8 ¥ Sfubriue » 0 Edtensions = FPropriété. 4 Pagefile gy Plan da site

. v t. E Rechercher

Un formulaire de création apparait ou vous indiquez :

e |le nom de la page fille ;

o |e descriptif (breve description de la page que I'on retrouve dans le plan du site) ;

e sa mise en page (parmi les 6 templates fournis par défaut ou des templates personnalisés que vous aurez créés via
Charte > Gestion des modéles de page) ;

e son ordre d’apparition (position de la page par rapport aux autres pages filles du méme niveau) ;

e éventuellement, associez une vignette apparaissant dans le plan du site ou dans la liste des pages filles, grace a une
image présente sur votre disque dur.

Seul le champ Nom de la page fille est obligatoire, les autres champs sont facultatifs.

Administration du Site © e
@rome @ 0 & ¥ Hrubique » [ Extersions = FPropriétés  dPagefille g Plandusite [ Q
Pls@
Créer une page fille Mise en page Associer une image
“.‘"“ de la page Qui sommes-nous ? Hise & Unecolonne| | © Dewccolonnes| [ | Nouvelle image W Parcouris
fille * en
PAage Tegis colonmnes | -
. T 121207 Mattre 3
Description Deeseriptif optionnel 18 2catonnesl T '| r:‘::’:‘:‘"’”r
Dreux cotonne-se'-sales[“
Trols colonnes -négale-s. I
CHAMP OBLIGATOIRE ordee

ptiicll | &= AJOUTER LA PAGE FILLE

Cliquer sur le bouton Ajouter pour valider. La page apparait automatiquement dans la navigation. Votre nouvelle page
devient visible.

Administration du Site Nouvelle page crée O Ade

onome (== I - B - S fubique » [ Extensions = FPropridtés k- Pagefille  JyPlan du site [T q

Free and powerful Java ™
Fra

W Supire @iatecenows |

LES OPTIONS D’AFFICHAGE DE LA PAGE DANS L’ADMINISTRATION DU SITE

Lutece utilise ce que I'on appelle le "responsive design", c'est-a-dire que ses interfaces web s’adaptent aux différentes
tailles d'écran (ordinateur de bureau, tablette et smartphone).
Il propose la visualisation de I’affichage de I'interface d’administration dans les différents formats d’écran suivants :

Tahlatia
24



1 E 0 =5 — Plein

T t écran

Ecran Smartphone
large 480px

Ce systéeme permet de visualiser le site sur les tablettes et smartphones.
DEPLACEMENT D’UNE BRANCHE DE L’ARBORESCENCE

Toutes les pages du site portent un numéro d'identifiant ("page id"=x) affecté a la création et un nom de page. La page
d’accueil, aussi appelée homepage, porte I'identifiant 1 ("page id"=1). Cette information est visible en haut a gauche
lorsque I’on est positionné sur la page. Le champ /d de la page mére indique I'identifiant de la page meére. Il est modifiable
pour permettre de déplacer la page dans I'arborescence du site.

N° D'IDENTIFANT DE LA PAGE
Admipistration du Site

" :
€ @age accueil

La page d’accueil est la seule page du site a ne pas avoir de page mere.

Pour les autres pages, toute modification de I'ID de la page meére entraine une modification automatique de I'arborescence.
Cette modification du site est répercutée automatiquement dans le plan du site et dans les menus de navigation.

RECHERCHER UNE PAGE DANS L’ARBORESCENCE

Il est possible de naviguer dans I'arborescence via la recherche par le numéro d’'identifiant des pages, via le plan du site, et
via les liens de prévisualisation d’une page.

NAVIGATION
NAVIGATION PAR  paR N°

NAVIGATION VIA LES PLAN DU DE PAGE
LIENS DE PREVISUALISATION SITE |

B Medation =

Administration du Site

H T

Mais lorsque le nombre de pages augmente, cela devient fastidieux. Il est aussi possible de rechercher et d’accéder
directement a une page par son numéro d’identifiant (Id).

Renseignez le champ de recherche avec le numéro d’ld de la page recherchée, et cliquez sur I'icéne loupe.
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Administration du Site Recherche par numéro d’ld \A O ade

Quvome T 0 0 X B8 ubrique -

Free and powerful Java ™ hased
Framework

W Suivre @iatecenews

Si I'identifiant fourni correspond bien a une page existante de votre site, la page d’administration de la page recherchée
apparait.

Si I'identifiant fourni ne correspond a aucune page de votre site, la page d’administration de la page d’accueil apparait, un
message placé sous le champ de recherche indique que cette page n’existe pas.

Pour remonter a une page mére, il faudra se positionner sur la page désirée via I'administration du site. Dans les propriétés
du site, cliquer sur le bouton remonter a la page mere (fleche verte) et valider.

PERSONNALISER LES PROPRIETES DE LA PAGE

Le bouton Propriété situé dans la barre d’outils de la page permet de définir ou de modifier les propriétés de chaque page.
Pour accéder aux propriétés de la page, cliquer sur |'icOne Propriétés. La saisie ou modification des champs suivants est
proposée :

Le champ Nom permet de spécifier le nom de la page (limité a 50 caractéres). Ce nom apparait :

e dans le plan du site,

e dans le chemin de navigation ou fil d’Ariane du site,

e dans les menus de navigation du site. L'affichage du nom dépend du niveau d’arborescence. Il est actif pour les 3
premiers niveaux du site, mais cela peut varier en fonction de votre charte graphique.

Le champ Description permet de spécifier une bréeve description de la page. Cette description apparaitra dans le plan du site.

Le champ Ordre permet de spécifier la position de la page par rapport aux autres pages du méme niveau.

Le champ Mise en page permet, le cas échéant de définir la structure de la page selon un gabarit prédéfini.
Sélectionnez une structure de mise en page (bouton radio) parmi les modéles proposés.

Il est possible de créer en amont d’autres structures de mise en page afin de définir plusieurs gabarits selon le type de
contenu.

Administration du Site © Ade
© uisommesnous? @ O 2 X + B Sfubrigue~ € Edensions v+ ALPopridtis  dkPagefille  LPlandusite [ a
Fhis@
Propriétés de la page Mise en page Associer une image
:;m‘deh page Quil somemes-nous ? Mise @ Une colonmi' ...... 1 Deuxcolonﬂes[m T Nouvelle image B Parcoutic
e en ] i
page Trois colonnes| | | |
ipti Mettre & jour
Description Deseription optionnelle 142 colonnes Fimage ﬂ
Deuxwlonneséga:es. } ]
1d de |a page . Trols colonnes mégalesi".m_.
mére
Ordre 1

Plus @
Des options supplémentaires sont accessibles en cliquant sur le bouton situé en haut a droite.
Les champs sujet et description des métadonnées permettent de définir les mots-clés nécessaires au référencement de la
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page.

Le champ Acceés restreint au réle permet de restreindre |'accés de la page a un réle c6té internautes.
Sélectionner I'option No restriction pour que la page soit accessible librement.

L'acces a la gestion des roles est accessible dans le menu Utilisateurs > Gestion des réles.
Le champ Neceud d’autorisation permet de définir des restrictions de visualisation ou de gestion de la page, pour les
gestionnaires Lutece. Il s’applique a I'ensemble des pages filles jusqu’au prochain nceud d’autorisation.

Par défaut, I’'option Non est sélectionnée.
Sélectionner I'option Oui pour pouvoir poser des autorisations spécifiques sur la page et ses pages filles (réservé aux
utilisateurs avancés).

Méta-données

Sujet
Description

Renseigner des mots-clefs séparés par une virgule
Théme de la page =<Utilise le thime global= B
Accis restreint au rble Mo restriction B
Hoeud d'auterisation o B

Toute modification apportée dans les propriétés de la page doit étre validée en cliquant sur le bouton modifier.
SUPPRIMER UNE PAGE

Se positionner sur la page a supprimer via I'administration du site. Dans les propriétés de la page, cliquer sur I'icéne de
suppression de page (corbeille).

L'application vous demandera une confirmation de suppression de page.

O Confirmation

Etes-vous sir de vouloir supprimer la
page?

Le numéro d’une page supprimée n’est ni réutilisé ni réutilisable.
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8. CREER MES PREMIERS CONTENUS

Aprés la création de I'arborescence, nous allons maintenant étudier les diverses possibilités d'insertion de contenus sous
Lutece. Nous verrons la notion de rubrique, comment créer, gérer, modifier et insérer une rubrique, pour pouvoir leur ajouter
des documents. Nous passerons par |'ajout et la mise en forme de texte et I'insertion de documents multimédias.

GESTION DES RUBRIQUES DE CONTENUS

Une rubrique est un élément dans lequel le contenu est modulable. Une rubrique est un bloc de contenu qui peut étre
positionné de manieres différentes sur une page. Elle accueille des documents, tous du méme type, qui y sont publiés.

CREER UNE RUBRIQUE

Dans I'administration du site, positionnez-vous préalablement sur la page devant accueillir votre contenu et cliquez sur
I'icéne Rubrique pour faire apparaitre la liste des types de rubriques.

Comme évoqué dans le chapitre d'introduction, Lutece dispose de différentes fonctionnalités permettant I'insertion de
contenus. Nous allons commencer par le contenu éditorial (texte et éventuellement image).

Il faut distinguer deux types de contenus :

o les contenus que I'on peut insérer directement en un seul clic (exemple : Rubrique HTML/Texte Libre qui permet I'ajout
et I’édition de texte directement a partir de la rubrique)

e |es contenus que I'on insére dans des documents disposant de fonctionnalités plus avancées et soumis a un circuit de
production, validation et publication.

Pour I'exemple ci-dessous, nous avons choisi I'insertion d'un contenu en un clic : HTML ou texte libre. La création d'un
document est abordée un peu plus loin.

Administration du Site © aide

) Quisommes-nous? @ 0 & X + W Matrigeer O Edensions »  FPopiitis Pagefile s Plandusite Q

L Agenda
Authentification MyLutece

Document

Farmulabne

Interrogation dune base de données
Liens vers les pages filles

Liste de decuments

Mes tableaux de bard

Mini agenda

Rubrique Alias

XPage

INSERER UNE RUBRIQUE
Apreés avoir choisi I'insertion d'une rubrique HTML ou texte libre, un formulaire apparait avec les champs de saisie

disponibles pour ce type de rubrique. Il est possible d'ajouter du code HTML dans la source via le bouton © de I'éditeur de
texte.
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Administration du Site © aide

OHome HOoo & 8 Rubrique » Bitensions v A Propriétés e Pagefile  giPlandusite [eSraie Q

»

B Modifier une rubrique Html ou Texte libre z

Titre de la rubrique *

Identifiant de ) Textelb
Ceci est une rubrique HTML/Texte libre
la page !
! @ Affichageavectitre © Affichage sans titre
Colonne Contenu HTML:
1 = Fichier »  Editer * Insérer» Voir~ Format» Tableau +  Outils »
Ordre 5 ¢ O Fomas- B J A-A-E E = E - E E
;L e m el o
Style
Défaut |+ Lorem ipsum dolor sit amet, consectetur adipiscing elit. Fusce maximus auctor placerat.
- Integer id luctus nunc. Donec dignissim mauris tellus, in dapibus ante interdum quis.
Plus Cras quis ligula nec nisi interdum fringilla. Donec mollis diam et lectus volutpat |

malesuada pharetra sit amet libero. Praesent purus turpis, auctor sit amet dictum eget,
imperdiet vel ante. Nullam a massa est. Sed a bibendum magna. Praesent ultricies, orci
quis ultrices ultrices, mauris nis| cursus risus, ac euismod magna purus sed diam.
Pellentesque a magna a est maximus hendrerit. Mauris a iaculis dui. Fusce ut metus ut
turpls uIIamcorper fringilla non fat:|I|5|s dolor Mauns Iacmla tempus uma, nec mattis

p Mots - 118 _

LES CHAMPS COMMUNS A TOUTES LES RUBRIQUES SONT LES SUIVANTS :

Le champ Titre de la rubrique peut apparaitre ou non en front office selon I'option choisie ici : Affichage avec titre ou
Affichage sans titre.

Le champ Colonne permet de positionner la rubrique dans la colonne souhaitée. Le nombre de colonnes disponibles dans la
page en cours et leur agencement, sont visibles dans Propriétés > Mise en page.

Attention : |le positionnement dans une colonne doit étre cohérent avec les parameétres de I'attribut Mise en page. Exemple
: si la mise en page (dans les propriétés de la page) comprend une colonne unique, et que I'on positionne une rubrique dans
la colonne 2, cette rubrique n’apparaitra pas sur la page, car la colonne 2 n’existe pas dans le template de la page.

Le champ Ordre correspond a la position de la rubrique dans la colonne de votre page. Par exemple, définir I'ordre a 2,
positionne la rubrique en deuxieéme position en partant du haut de la colonne.

Le champ Style permet de choisir le modéle de présentation de la rubrique. Celui-ci détermine le rendu graphique de la
rubrique.

Le champ Accés restreint au réle permet de restreindre I'acces de la page a un réle cété internautes. Sélectionner I'option No
restriction pour que la page soit accessible librement (par défaut)

L'acces a la gestion des roles est accessible dans le menu Utilisateurs > Gestion des réles. Le champ Noeud d’autorisation
permet de définir des restrictions de visualisation ou de gestion de la page, pour les gestionnaires Lutéce. Il s'applique a
I'ensemble des pages filles jusqu'au prochain noeud d'autorisation

Par défaut, I'option Non est selectionnée.

Sélectionnez I'option Oui pour pouvoir poser des autorisations spécifiques sur la page et ses pages filles (réservé aux
utilisateurs avancés).

Les boutons radio accepte Alias permettent de spécifier si la rubrique accepte ou pas les alias. Un alias permet de dupliquer
une rubrique et de I'insérer dans n'importe quelle autre page. Le contenu de la rubrique alias sera automatiquement mis a
jour en méme temps que celui de la rubrique source. En revanche, le contenu de la rubrique alias n’est pas modifiable.

Afficher sur des écrans de type permet d'activer ou désactiver |'affichage d'une rubrique sur téléphone, tablette, écran et
grand écran.

Apres validation de la création de la rubrique, celle-ci apparait alors sur la page courante, dans la colonne et a la position
choisie.
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Administration du Site O hide

OHume H00 ¥ B Rubrique » () Edensi FPropridtés  dePagefile &Plandusite (R Q

010:0:

Ceci est une rubrique HTML/Texte libre %] EIG

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Fusce maximus auctor placerat. Integer id luctus nunc. Donec dignissim mauris
tellus, in dapibus ante interdum gquis. Cras quis ligula nec nisi interdum fringilla. Donec mollis diam et lectus volutpat malesuada pharetra
sit amet libero. Praesent purus furpis, auctor sit amet dictum eget, imperdiet vel ante. Nullam a massa est. Sed a bibendum magna.
Praesent ultricies, orci quis ultrices ultrices, mauris nisl cursus risus, ac euismod magna purus sed diam. Pellentesque a magna a est
maximus hendrerit. Mauris a iaculis dui. Fusce ut metus ut turpis ullamcorper fringilla non facilisis dolor. Mauris lacinia tempus umna, nec
mattis diam molestie nec. Sed ornare nisl non aliquet sagittis. Aliquam eleifend rhoncus luctus.

Ceci est une rubrique Document BEBOHO0 Ceciest une rubrique Document SB00o

Ceciestun document Ceciestun document

Mauris tempus finibus moliis. Praesent efficitur
sapien non nunc melis sollictudin, Sed eleifend
tortor sit amet lacus tristigue mattis. Praesent at
feugiat nibh. Nulla augue leo, egestas in risus sit
amet, fringilla pellentesque arcu. Vivamus convalis
nec elit in aliguet. Proin miturpis, posuere eget quam|
volutpat, mattis rutrum arcu. Vivamus ut dui et arcu

Donec pharetra mi arcu, a mollis urna rhoncus sed.
Nulla eu lacus eu purus fringila interdum. Ut augue
maurig, condimentum euismod dui at, condimentum
luctus arcu. Etiam aliguam ipsum tortor, eget sagittis
quam porta sit amet. Pragsent ac elit sodales,
suscipt ex in, fermentum nulla. Sed ornare justo est,
eget consequat negque cursus et Duis dictum

feugiat ornare. Nunc cursus ex ultricies, sagittis massa at tellus venenatis, ac viverra telus egestas. [ i \ i :
massa a, bibendum lacus. Integer pellentesque efficitur quam quis iaculis. Sed turpis eros, Cras justo negue, pharetra ac ornare id, sagittis nec tortor. Duis faciisis est ipsum, sit amet
aliquam ullamcorper nulla id, velutpat ernare mauris. In luctus semper odio non laoreet. dictum nisl commodo vitae. Mauris eleifend mauris ac eros pharetra, blandit pellentesque
Suspendisse egestas duinec dui faucibus hendrerit. Mauris biendum condimentum nisi nich porttiter. Aenean non lobortis libere. Morbi solicitudin tellus consectetur, pretium arcu sit
quis maximus. amet, efficitur mi. Morbi vulputate tortor £st, non posuere neque pulvinar non. Proin a sem

tellus. Phaselus vel feugiat enim. Mauris efficitur pellentesque urna a vulputate.
Mauris porttitor urna quis velt congue, id scelerisque odio vestibulum. Suspendisse viverra g P = .

velit ut lacinia porta. Vestibulum feugiat metus vel sem suscipit auctor.

L’EDITEUR DE TEXTE

Le champ de texte enrichi (ou rich text) est proposé sur plusieurs types de contenus. Il permet d'effectuer les actions
suivantes sur les contenus saisis :

o mettre en forme le texte (Gras, italique, styles...),
e insérer des liens a partir d'un texte sélectionné,
e concevoir des tableaux,

o insérer divers liens vers du contenu existant du site avec la fonction Linkservices (bouton &)

Fichier = Editer - Insérer +  \oir = Format ~  Tableau = Qutils =

i
i
il
il
m
hil
i

9 ¢ |B |Fomas~ |B 7 | A~ A~
PRI R

— o
e -
l = 5=

GERER UNE RUBRIQUE

Selon la rubrique de son choix, il est possible d'accéder directement a la modification des contenus avec les actions
présentées ci-dessous (icones a droite de chaque rubrique) :

Modifier la rubrique permet d'accéder a I'écran de modification de la rubrique et de ses contenus

Gérer la publication de la rubrique permet d'accéder a la gestion de la publication/dépublication de la rubrique et de ses
contenus (cette icone apparait uniquement lorsque la rubrique content un élément de type Document)

M Supprimer la rubrique permet de supprimer aprés confirmation la rubrique (et le contenu pour certains types de
rubriques)

Suspendre la rubrique permet de dépublier une rubrique, c'est a dire de la rendre non visible aux internautes pour
dépublier une rubrique sans la supprimer.

Pour la rendre visible par la suite, utilisez I'icone qui permettra de republier a nouveau la rubrique, et la rendra a
nouveau visible aux internautes.

Pour modifier une rubrique, aller sur la rubrique concernée, et cliquer sur le bouton Modifier. Un formulaire apparait avec les
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champs de saisie nécessaires pour le type de rubrique demandée. Faire les modifications souhaitées et cliquer sur le bouton
valider.

LA VISUALISATION DES COLONNES
Selon la mise en page de la page, une rubrique est insérée selon un ordre dans une colonne choisie. Il est possible de

visualiser le numéro de colonne dans laquelle se trouve une rubrique en passant la souris sur celle-ci, cela facilite le
repérage et la mise en forme des rubriques dans les pages.

Colonne 3

éL'équipe Lutece ﬂﬂﬂﬂ

LES DOCUMENTS

Un document est un type de contenu qui apparait dans des rubriques, aprés un processus de gestion de contenu évolué. Un
document, quel qu’il soit, passe par un processus de création, validation, publication. Une fois le document créé et
validé, il doit étre publié dans une rubrique de méme type. Un document peut étre archivé pour une éventuelle utilisation
ultérieure.

LA GESTION DES DOCUMENTS

Pour accéder a la gestion des documents, cliquez sur Contenu > Gestion des documents.

o Mﬂ‘af'ﬂ'ﬁt‘ﬂ e Contenu « Site = Applications = uUtili

Gestion des catégories de document

Administration d

Gestion des régles du Workflow
1 @ razeaccueil Gestion des types de documents
Gestion de la bibliothégque de media

Gestion des réseaux sociaux

Gestion des extensions de contenu

MNuage de Tags I

LES ESPACES DE DOCUMENTS

Les documents sont classés dans des espaces qu'il est possible de créer, modifier, supprimer, déplacer.

Par défaut, un document est classé dans les sous-espaces de |'espace "Contenu éditorial". Ces sous-espaces suivent le
processus de création, validation, publication. La création d'un document est possible dans I'espace de travail, puis ne fois la
demande de validation effectuée, le document est automatiquement déplacé dans I'espace de validation. Aprés validation,
le document est une nouvelle fois automatiquement déplacé dans I'espace de publication. Il est possible de modifier ces
parametres et de décider par exemple que les trois étapes se dérouleront au sein du méme espace.

Il est possible de supprimer ces espaces par défaut et de créer de nouveaux espaces pour gérer les documents.

Dans la fenétre de gestion des documents, il est également possible de rechercher un document en indiquant tout ou partie
de son libellé.
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Gestion des documents

/ rechercher un document

modifier les
attributs de I'espace

Rechercher créer un nouvel

espace

= Espaces

& ~-| Racine des contenus
B Acteurs locaux
Bibliotheque multimedia
Contenu Editorial
~g Archives
 Espace de publication
i Espace de travail
~ | mediation
= Espace de validation
- [ Fichiers en telechargement

supprimer
'espace

NAVIGUER DANS LES ESPACES DE DOCUMENTS

On peut trier I'affichage des documents par :

deplacer
l'espace

Type (actualité, pdf...).
Etat (publié, en attente de validation...).
Ordre croissant ou décroissant sur la date de création.
Ordre croissant ou décroissant sur la date de publication.
Mode d’affichage (détail ou miniature).
Appliquer le =
Tri par type Tri par état \Elﬂ:re de tri Choix du mode
P it\fP - d'affichage
| et
¢ Y validation
'H"PEl -Tous- E|Fi ki -Tous il :

A WV Document|® | Valider
34 - Rapport du Médiateur 2013
& o mars 2015 14:16:41 g

m TI:I CI“QISSEI‘It ou
27 - Lien vers la derniére proposition du Im%:scarggﬁg:l

& 3 mars 2015 13:42:16

validation

CREER UN NOUVEL ESPACE DE DOCUMENTS

Statut

Tri croissant ou
décroissant par
date de publication

Pour créer un nouvel espace de document, il faudra suivre quelques étapes simples :

Se positionner sur I’espace pour lequel I’on souhaite créer un sous-espace.

Positionnez-vous sur I’'espace de travail/médiation et cliquez sur I'icone créer un espace.

Dans

le formulaire affiché, renseignez les champs suivants :
Nom de I'espace

Affichage par défaut des documents, détail

pas créer ici d'autres documents que des PDF)

Description de |I'espace (qui peut étre identique au nom)

Icone (choisissez I'icGne qui va apparaitre a gauche de |'espace parmi ceux proposés
Types de documents autorisés (attention, si vous cochez par exemple I'élément PDF, cela signifie que vous ne pourrez

e Création de documents. Cochez la case Permettre la création de documents dans cet espace.

Cliquez sur le bouton créer.

MODIFIER UN ESPACE DE DOCUMENTS

Pour modifier un espace de document, il faut se positionner sur I’espace que I’'on souhaite modifier et cliquer sur le bouton
de modification.

Vous pouvez changer :

le nom de I'espace
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la description de I'espace

I'affichage par défaut des documents (détail ou miniature)
I'icone

les types de documents associés a cet espace

SUPPRIMER UN ESPACE DE DOCUMENTS

Enfin et si besoin, pour supprimer un espace de document il faudra toujours se positionner au préalable sur I’espace voulu et

cliquer sur I'icéne supprimer.
L'application vous demandera une confirmation de la suppression. Notez que celle-ci est irréversible.

IMPORTANT : Si I’espace contient des documents publiés, vous ne pouvez pas le supprimer avant d’avoir retiré la
publication de ceux-ci (voir chapitre "Publier mes contenus").

CREATION DES DOCUMENTS

Cliquez sur Contenu > Gestion des documents et positionnez-vous sur I’espace dans lequel vous souhaitez créer un nouveau

document.

En haut a droite, choisissez le type de document et cliquez sur le bouton Créer.

Gestion des documents Bouton créer
Espaces Hun Rechercher Type Tous. [=|Etat: . tous- =& Article 3
Q vt [ | Atile

E Espaces =
= Racine des contenus *

B Acteurslocaux
i Bibliotheque multimedia
- Contenu Editerial
o a‘chl'-'E‘S

space de publication 1 J
el Choix de I'espace

=] Espace de travail

g\ai::cede\-ahdanon de [Iucuments chaix du t}\‘pe
& | Fichiers en telechargement ﬂE dﬂﬂllmems

Pour créer, par exemple, un document de type article, dans le formulaire affiché, renseignez les éléments suivants :

e Le titre du document (*).
e Le résumé du document, qui représente le résumé de l'article(*).

Ces deux champs concernent les éléments qui apparaitront en chapeau de I'article.

Dans les champs d’attributs du document pleine page, renseignez les éléments suivants :
e L'url liée a votre article s'il y en a une.

e Piéce jointe, si vous avez une piece jointe a associer a votre article.

e Le contenu de votre article dans |'éditeur de texte (*).

Les champs comportant un astérisque (*) sont obligatoires.
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Gestion des documents

Création d'un document de type Article Propriétés avancées =
Titre®: Léquipe Luthoe Pértode de validité
Titre du document Début
| lweaos
Résumé*® & Debccanvies Féquipe de développemnent Lutboe Fin
=
Modile de présentation
Résumé du document
o [ Défaut
Attributs du Document ] Fleine page
B Rubrique en-dessous
url hitp Choibe du modile ntation du
Ul lide & larticle doc sur
Remarques interne
Piece jointe W Parcourir
Piece jointe
. Notes de gestion du document
Corps® Fichier - Ediler - Insérer - \Vpir~ Fommalt~ Tableau =  Oulils ~

6 7 B Fumas- B J | A-HEH-EESE
E-jE-F EH G FL B B e oo Catégories

Léquipe de aéveloppement de Lutece st francophone el travaille pour 1 Maine de Paris. Les
développeurs sont issus d'un service de collectivité de la maine el onl l'expérience des divers besoins

e ce type de service dans |a création de portails web et de tdésenvices

Mots - 45
P ¥l

LES PROPRIETES AVANCEES

Dans les propriétés avancées, on peut gérer la période de validité de son article, a savoir la date de création de I'article et la
date de fin de validité.

Si I’on ne précise aucune date de fin, I’article est pérenne. En revanche si I’on souhaite que I'article ne puisse étre publié que
jusqu’a une certaine date, on indique celle-ci dans le champ fin. De méme on peut mettre une date de début de validité
postérieure a la date de création si I'on souhaite par exemple prévoir une publication a une date donnée.

A NOTER : Si la date de début est postérieure a la date de publication, vous ne pourrez pas publier cet article
avant cette date.

Le modele de présentation représente le choix de présentation du document sur le site.

Enfin, les remarques internes peuvent vous permettre de commenter votre article. Ce commentaire n'apparaitra pas dans
I'article et sera uniquement visible dans I'administration du site.
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RECAPITULATIF DES BOUTONS D'ACTION DES DOCUMENTS

Gestion des documents

Espaces oii|/]+] Rechercher Type -Tous- [v|Etat: atice ] o

Q - Tous- Y
= Espaces — B .

: oéal  [x]

E [ Racine des contenus
i [ Acteurs locaux
I [ Bibliotheque

raultimedia [l A v -Document A + | Valider Statut A v Actions

&+ [ Contenu Editorial

'8 :fp:'::; ] [ 20-Léquipe Lutece BEEERa

p:ublicatian & 10200t 201515:31:50

=] Espace de travail

- [ Espacede Nombre par pagel 50 j ¢ -Nombre d'éléments: 1
validation
- [ Dataset 4 " | )

[ [ Fichiersen
telechargement

Soumettre a validation

Valider le document

Refuser le document

Corriger le document validé
Publier le document

Visualiser I'historique du document
Prévisualiser le document

Archiver le document

Déplacer le document

] o[e] ¢ Jiif s |clol o=

Gérer la publication

FONCTION LINKSERVICES

Cette fonctionnalité est commune aux éditeurs de texte des rubriques HTML ou texte libre, document et composition de la
newsletter. Elle permet I'insertion:

¢ deliens internes (vers d’autres pages du site);
« d'images (depuis le disque dur ou depuis la bibliotheque de médias);
e de liens vers des fichiers en téléchargement;

INSERER DES LIENS DANS L’EDITEUR DE TEXTE

Il convient de distinguer deux types de liens :
* les liens internes qui pointent sur des éléments de votre site (pages, images,pdf...)
* les liens externes qui pointent vers un autre site que le vétre.

Les liens externes
Sélectionnez le texte qui servira de lien et cliquez sur I'icone d’insertion de liens.

Dans la fenétre affichée, indiquez :

¢ L'URL ou adresse du lien

e Le texte qui sert de lien (en principe le texte déja sélectionné)

¢ Le titre de I'infobulle du lien

e La cible (ouverture dans la méme fenétre ou vers une autre fenétre)



Insérer un lien x

Url | httpfivwww. paris.fr
Texte Site de Paris.fr
Titre| Site de Paris.fr

Ciblg Mouvelle fenétre -

(0]4 Annuler

Insertion d'un lien interne
Tous les liens internes sont gérés par le Link Service.

A I’endroit ou vous souhaitez insérer le lien, cliquez sur I'icone Linkservices
Celui-ci vous propose de choisir le type de lien vers :

un média de la base des documents

un album d'images depuis un espace de travail

un document

une page du site

un media de votre ordinateur (image, fichier, video...)
vers un événement de |'agenda

Lutece x
@ Retour
Insérer
2 Un média de la base des documents (image, fichier, video, )
2 Un album d'images depuis un espace de travalil
2 Un lien vers un document
2 un lien vers une page du site
2 Un média de votre ordinateur (image, fichier, vidéo

2 Lien vers un événement de 'agenda

Fermer

Une fois votre choix validé, le linkservice vous donnera la liste des éléments disponibles pour une insertion.
Faites ensuite votre choix sur le lien a insérer.
INSERTION D’UN LIEN INTERNE (AUTRE PAGE DU SITE)

Dans la rubrique concernée, a I’endroit ol vous souhaitez insérer le lien, cliquez sur I'icéne Linkservice. Choisissez ensuite un
lien vers une page du site.

La liste des pages du site apparait, pour rechercher une page, vous pouvez entrer son nom ou bien la rechercher par son
identifiant si vous le connaissez. Une fois la page identifiée, cochez-la, indiquez le nom du lien, le texte de Iégende, la cible
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et cliquez sur valider. ' ) )
Lutece

@ Retour

(]
Paramétres d'insertion

Texte de légende
Nom du lien

Cible

_self -

Choix d'une page

©» Home - Home Page (1) &

) Qui sommes-nous ? - Description facultative (2) &

Fermer

INSERTION DES MEDIAS

Vous pouvez agrémenter vos pages avec différents types de médias (images, galeries d'images, vidéos, fichiers PDF). Le
processus de création de ces documents est identique a la création de tous les documents (création, validation, publication).
Assurez-vous de les créer dans |'espace bibliotheque multimédia.

Les images peuvent également s’insérer directement via le linkservice soit depuis votre disque dur, soit depuis la
bibliotheque multimédia.

Filtrer un document par statut (validé, archivé, brouillon...)
Valider le mode d’affichage du document (détail ou miniature)
Créer un nouvel espace de document

Supprimer un espace de document

Modifier les attributs d’'un espace de document

»|Nmfol< ]

Déplacer un espace de document
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9. GERER ET PUBLIER MES CONTENUS

Dans le chapitre précédent, nous avons créé du contenu, il s'agit maintenant de le publier. Ici, nous allons étudier comment
publier et gérer ses documents en passant par I'ajout, la modification et la suppression. Nous en profiterons pour voir
comment nous gérerons les médias, le cache et I'upload en masse.

Comme indiqué au chapitre Créer mes premiers contenus, un document créé doit étre validé avant de pouvoir étre publié.

1. Le document de type article créé précédemment est a I'état de brouillon, il vous faut le valider afin de pouvoir le
publier. Cliquez sur le bouton Soumettre a validation.

Gestion des documents

Espaces ﬂﬂﬂ Rechercher Type - Tous- EEtal: Tous - 3 Article 3
« Mo [M
B> Espaces
B Ratine des contenus
3 Acteurs locaux
# [ Bibliotheque multimedia s 5
&4 umnhfgdlmal | A v -Document A w | Valider - Statut A v Actions
[ Archives .

B Esguedcsublmu‘nn 22 - Léquipe Lutece O Non poblié 0 @]+

i P & 1230002005 1220202 [ )
gy Espacedevalidation

i Fichiers en telechargement

Soumettre a validation
Hombre parpage| 50 |=|C -Nombred'éléments:1

2. Le document change d’état et se retrouve en attente de validation. Vous pouvez alors soit valider soit refuser le
document.

Gestion des documents

Espaces (0] 6]/]4] Rechercher Type  Tous- [7]Etat: -Tous- [z article [ | e
a st [1E
B Espaces
= | Racine des contenus
- 3 Acteurs locaux
& [ Bibliotheque multimedia

& Conteny Editorisl [ A~ -Document s « | Valider - Statut A w Actions

g Archives

B Espoce depublication 0 2 véqipe Ltece c o|3]5]e]+
=

e Exace de vasdation & 122002015 124232
B

@ . Fichiers entelachargement valider le document refuser le document

3. Lorsque vous avez cliqué sur Valider le document, son état change, il devient validé. En revanche il n’est pas publié
donc non visible par les internautes.

Gestion des documents

Espaces (o] 8] ]+ Rechercher Type fous- [v]EtAt: Tous- =] atide =] R
Q “ Détail 3
B Espaces
Racine des contenus
- b8 Acteurs locaux
B Biblistheque multimedia

& = Contens Editorial A v -Document A v | Valider - Statut . v Actions
5 Archives .
&7 Espace de publication . 22-L'équipe Lutece O Hon publié :‘-] E
&

& 12a00t2015 12:42:32 [0

|5 Espace devalidation
& Fichiers en telechargement

Nembre parpage| 50 |+ ¢ - Nombre d'éléments: 1
4. Une fois votre document validé, cliquez sur I'icone publier le document.
A NOTER : Vous ne pouvez supprimer un document lorsqu’il est publié.

PUBLICATION DES DOCUMENTS
La rubrique de destination du document a publier doit étre de type Document ou Liste de documents.

Foy
1. Cliquez sur le bouton [
2. L'application vous proposera la liste de toutes les rubriques du méme type que le document.
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Gestion des documents ces

Publication du document e » nom de la page E Date de modification des rubriques Z| Descendant Elﬂ
o Eom
Liste des rubriques disponibles (Les 10 plus Listes des rubriques de publication du
22 - L'équipe Lutece récents) document
Type de document Type “Liste de document Type "Document” '
Article Aucun document affecté ou publié
Créé le . .
12 00t 2015 12:42:32 Type "Document” Rubrique pour les documents
Modifié le pleine page

12 200t 2015 12:42:32

Home > Qui sommes-nous ?(1d 1 2) [équipe Lutece)

Dates de validité
B Depuis le 12/08/2015

9 Affecter i s rubrigue
& Affecter et publier sur le site
3. Cliquez sur la rubrique dans laquelle vous souhaitez publier votre article, et choisissez I'option :
o affecter a la rubrique. L'article est publié dans cette rubrique mais on ne souhaite pas le faire immédiatement, on
affecte a la rubrigue uniquement et I’article n’est pas publié.

o affecter et publier sur le site. L'effet de mise a disposition du public est immédiat.

L'article, publié, apparait dans le front-office.

Documentation Q} S'authentifier

D LUTECE Qui sommes-nous ?

L'équipe Lutece
L'équipe Lutece

L'équipe de développement de Lutece est francophone et travallle pour la Mairie de Paris. Les développeurs sont issus d'un service de collectivite de la
mairie et ont lexpénence des divers besoins de ce type de service dans |a création de portails web et de 1éiésenvices

Un document peut étre publié plusieurs fois dans différentes rubriques de méme type.

Dans la gestion de I'affectation a une rubrique, apparait la liste des rubriques de publication du document.

Pour chaque document, vous pouvez visualiser son numéro, son statut, dépublier le document, supprimer I'affectation du
document ou gérer la rubrique de publication.

Listes des rubriques de publication du
document gérer la rubrigue  dépublier

@L'équipe Lutece

numéro du document

supprimer |'affectation
du document



GERER LA RUBRIQUE DE PUBLICATION

Vous pouvez changer |'ordre d’apparition des documents dans la liste de documents, accéder a la gestion du document, le
prévisualiser et le dépublier.

Il est possible également de visualiser le numéro de la rubrique, le numéro de la page de publication, d’accéder a la vue des
documents et a I'administration du site.

Administration du Site cestion delz publication

; @ m e
HEIET BT Liste des documents publiés : Liste des documents affectés :

@O LUéquipe Lutece 1 Ea E
=

Mode de publication changer 'ordre d’apparition

« Standard &% Auto publication

L4

4 - L'équipe Lutece

Statut : Activé [ Publiée sur
le site
Page de publication :o

PUBLIER LES DOCUMENTS DE TYPE MEDIA

Un document de type média concerne les images, les vidéos, les galeries d'images, les fichiers PDF. Le processus de
publication des documents de type média est le méme que celui des autres types de documents. Il faut simplement
s'assurer qu'ils seront publiés dans une rubrique de méme type.

LA MODIFICATION DES DOCUMENTS

A Lo . . . ’oA . 4 , . <
Méme quand un document est publié, il est possible de le modifier. Cliquez sur I'icone modifier de l'article concerné.
Vous revenez sur le formulaire de création de documents, vous pouvez effectuer les modifications souhaitées et ensuite

cliquez sur le bouton modifier.

A NOTER : si vous souhaitez modifier Pimage de I'article, vous devez cocher la case mettre a jour image
avant validation.

L'état du document change et devient en correction.

[ A w -Document a | Valider Statut A Actions
£ 2-vequipe Lutec (onse] EEECO
B 12 a0(t 2015 15:33:49 [CEF 0

Vous devez a nouveau reprendre le processus soumettre les corrections du document validé. Son statut devient en
attente validation corrections.

= A v -Document A | Valider Statut A Actions
0 2 véqipeLutec pDEEQQ

SUPPRESSION DES DOCUMENTS

Un document ne peut étre supprimé que s'il n’est plus publié dans une rubrique de méme type et des lors qu'il est archivé.
Pour supprimer un document :
chiver @

1. Sur le document concerné, cliquez sur le bout
2. Le statut du document change, il devient *
3. Vous avez maintenant acces au bouton de suppression

L'application vous demandera une confirmation de la suppression.
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LA GESTION DES CACHES

En principe, les modifications apportées dans I'interface d’administration sont automatiquement mises en ligne. S’il advenait
gu’une création ou modification n’apparaisse pas, il convient de vider les caches.

Cliquez sur le menu systéme/gestion des caches.

Systéme -

Gestion des expressions régulieres

Informations Systéme

Gestion des Caches

Indexation des contenus I

w

Configuration de la recherche

Viralicatinn Adac laere

Procéder ensuite a une remise a zéro des caches en cliquant sur le bouton vider tous les caches
UPLOAD EN MASSE DE DOCUMENTS

L'interface d'upload en masse de documents permet d'importer plusieurs ressources (images, fichiers) présentes sur le
systeme de fichier de I'utilisateur en une fois.

Les actions possibles sont :

Sélection d'un type de document
Sélection des types de fichiers
Sélection des fichiers a importer
Import des fichiers

Sélection d'un espace de destination

Vous accéderez a cette fonctionnalité depuis le menu Contenu>upload en masse de documents

Contenu ~ Site ~ Applications ~ Uil

Gestion des includes contextualisés
Gestion des catégories de document
Gestion des documents

Gestion des régles du Weorkflow
Gestion des types de documents
Gestion des statistiques des extensions

Gestion des types de vote

Upload en masse de documents

Gestion de la bibliothégue de media

y  Gestion des boutons d'actions
Gestion des réseaux sociaux
Mapping upload en masse

Gestion des extensions de contenu

e

Nuage de Tags
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Création d'un mapping
D Importer des fichiers vers un type de document®
Cheisir le type de document™ Image E|

@™ Choisir les fichiers a importer*

File d'attente

0 fichier imparté
& Choisir l'espace de destination®

" Valider [KOERETE

3 Acteurs locaux

- Dataset

en telechargement

@ hanuler

1. Sélection d'un type de document. La sélection d'un type de document est réalisée par I'intermédiaire d'une liste de
sélection contenant tous les types de documents qui contiennent un attribut (et un seul) de type fichier ou image. Par
défaut, le premier élément de la liste est sélectionné. Dés que |'utilisateur sélectionne un nouveau type de document,
la page est rechargée.

2. Sélection des fichiers a importer. Lorsque I'utilisateur clique sur le bouton Parcourir, une fenétre de sélection des
fichiers apparait et permet de sélectionner un ou plusieurs fichiers présents sur le systéeme de fichier de |'utilisateur.
Une fois les fichiers sélectionnés, ceux-ci sont placés dans la file d'attente et I'import du premier fichier de la file
démarre. Les fichiers sont importés un par un. Dés qu'un fichier est importé, le composant passe au fichier suivant.
Une barre de progression indique I'état d'avancement du fichier en cours.

Des que la file d'attente est entierement traitée, le compteur affichant le nombre de fichiers importés est mis a jour.
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Importer des fichiers vers un type de document*

Choisir le type de
document*

Choisir les fichiers a importer*

Image

File d'attente

36-Linformation-a-Paris-partout-et-tout-le-temps.jpg
Terming

39-Des-espaces-de-liberté-canins.jpg

Terming

50-U'heure-sur-la-ville.jpg.

Terming

53-Cofinancement-participatif.jpg

Terming

&1-Un-Fab-Lab-Architecture.jpg

Terming

62-Promenade-le-long-du-Canal-Saint-Martin.jpg
Transfert...

63-La-reconquete-de-la-petite-ceinture. jpg
En attente...

71-Pour-une-place-Denfert.jpg

En sttente. ..

1 fichier importé

W Supprimer les fichiers importés

Il est également possible de supprimer I'ensemble des fichiers importés en cliquant sur le bouton prévu a cet effet (a
droite du bouton parcourir).

Lorsqu'un fichier dépasse la taille maximale autorisée, un message d'erreur est affiché et le fichier n'est pas importé.
De méme, si l'utilisateur sélectionne un fichier déja importé, un message d'erreur le signale et le fichier n'est bien sar
pas ré importé.

. Choisir I'espace de destination. La sélection d'un espace de destination permet a |'utilisateur de choisir vers quel
espace existant seront envoyés les nouveaux documents.

Les espaces sont proposés sous forme d'arborescence. Le lien "remonter" permet de remonter d'un niveau dans
|'arborescence.

43



Upload en masse de documents tiste des fichiers 3 importer

Nombre de fichiers & importer: 6

+ Ajouter auxdocuments [ LT

Liste des fichiers a importer

Nom du fichier: Nom du fichier:
16_Faciliter_les_deplacements_de_tous_dans_la_ville.jpg 20_Repenser_la_place_de_|_Opera.jpg
Nom du document Nom du document

Résumé Résumé

Credits*! Credits*!

Pour chaque fichier, I'utilisateur doit renseigner un titre et un résumé, et éventuellement la liste des attributs
supplémentaires obligatoires du type de document sélectionné.

Lorsqu'un mapping a été créé pour le type de document sélectionné et que des valeurs ont été attribuées aux attributs du
mapping, alors les champs du formulaire sont automatiquement prérempilis.

Le bouton retour permet de revenir a l'interface d'upload en masse de documents et d'importer de nouveaux fichiers ou bien
de supprimer les fichiers importés.

Remarque : Si au moins un fichier est importé, la sélection du type de document ainsi que la sélection des types de fichiers
sont désactivées.

RESULTAT DE L'IMPORT
Lorsque tous les champs du formulaire sont remplis, et ce, pour tous les fichiers importés, I'utilisateur peut cliquer sur le

bouton ajouter aux documents, ce qui a pour action de créer les documents puis d'afficher I'interface de présentation du
résultat de I'import.
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Upload en masse de documents résuiat de limport

Résultat de l'import

Nombre de fichiers importés (J) Nombre de fichiers en échec ()

Nom du fichier

i

i

]

i

i

i

16_Faciliter_les_deplacements_de_tous_dans_la_ville.jpg

20_Repenser_la_place_de_|_Opera.jpg

23_Un_mobilier_urbain_et_fonctionnel.jpg

36_L_information_a_Paris_partout_et_tout_le_temps.jpg

39_Des_espaces_de_liberte_canins.jpg

50_L_heure_sur_la_ville.jpg

Nom du document

Faciliter les
déplacements de
tous dans la ville

Repenser laplace de
I'Opéra
Un mobilier urbain et

fonctionnel

L'information a Paris,
partout et tout le
temps

Des espaces de
liberté canins

L'heure sur [a ville

Accéder 3 l'espace des documents importés

Résumé

Faciliter les
déplacements de
tous dans laville

Repenser |a place de
I'Opéra
Un mobilier urbain et

fonctionnel

L'information 3 Paris,
partout et tout le
temps

Des espaces de
liberté canins

L'heure sur la ville

Attributs du document  Actions

Credits™ Faciliter les n
déplacements de tous
dans la ville

Credits™ Repenserla n
place de 'Opéra

Credits® Un mobilier u
urbain et fonctionnel

Credits* Linformation a u
Paris, partout et tout le
temps

Credits® Des espaces de n
liberté canins

Credits™ L'heure surla n
ville

Les fichiers correctement importés ainsi qu'éventuellement les fichiers en échec sont répertoriés et comptabilisés.

Le bouton "Accéder a I'espace des documents importés" permet de visualiser les documents dans |'espace de destination et

de les valider.
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10. CREER UNE LETTRE D'INFORMATION

Le plug-in plug-in-newsletter propose de créer une ou plusieurs lettres d'information thématiques, de composer les lettres
d'information a partir d'un modele que I'on peut choisir entre plusieurs éventuellement, de tester la lettre aupres d'un panel
d'utilisateur, de gérer les envois a une liste d'abonnés, de gérer les souscripteurs -inscription/désinscription possible en front
et back-office-, de gérer les archives et de proposer ces archives en front-office. Le contenu d'une lettre peut étre généré
automatiquement a partir de la liste de documents publiés sur le site. La lettre sera alors composée des articles publiés
depuis le dernier envoi. Il est aussi possible de composer directement la lettre d’information dans I'éditeur prévu a cet effet.

Sivous ne visualisez pas correctement cette letire dinformation, cliquez ici.

Lundi 6 juillet 2015

Paris contre linstallation d'un fast-food géant

Aprés l'adoption d'un voeu « anti-fast-food » lors du dernier Mairie du 2e
Censeil d'arrondissement, c'est au Conseil de Paris mardi
dernier que les élus parisiens ont décidé de se prononcer 8, nue de la Banque
contre le projet dinstallation de ce fast-food géant. T5002 PARIS
M® Bourse

i e - Tél: 015329 7502
Mercredi, ¢ est grgnde bradgrle ala F{essourcerle Lundi - Viendredi - 8h30 3 17h00
La Ressourcerie Paris-Centre fait sa grande braderie. Jeudi - 8h30 a 19h30
Retrouvez toute la journee de mercredi, une selection amE:l:i - 9h0D & 12h30

d'ceuvres et d'objets d'occasion au 13 rue Léopold Bellan, fvil uniquemen
dans la rue et en boutique. BT 0

PARAMETRER UNE LETTRE D'INFORMATION

Vous pouvez créer autant de lettre d'informations que vous le souhaitez. Chaque lettre d'information est associée a une liste
d'abonnés et un modéle de lettre et d'article.

Lettre d'information administration des Newsletters

Administration des Newsletters
[0 [FC1

Libellé Description Dernier envoi Nbd'abonnés  Actions

EER000an

A la création ou en modification vous pouvez gérer |'autorisation de désinscription par les utilisateurs, changer la date de
dernier envoi, gérer les noms et emails des envois et des tests.
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Lettre d'information créstion d'une newsletter

Création d'une newsletter

Libellé de la lettre *
Descriptionde lalettre* | & .t' (Fomas~ B I A~ A~ E E =E E
E-E-EE 4 P B B e H o
p Mots:ﬂé
Date initiale (jj/mm/aaaa) * B | 13/08/2015
Groupe de travail * <Non assigné a un groupe> EI
Autoriser l'utilisateur 3 se ( H
désinscrire

Nom de 'expéditeur *

Expéditeur de la lettre
d'information *

Objet du mail de test

E-mail(s) des Testeurs *

Vious pouvez saisir plusieurs emails de testeurs en les séparant par un point-virgule.

+ Valider X Annuler

COMPOSER, GENERER ET ENVOYER UNE LETTRE D’INFORMATION

Aller dans I'administration des lettres d’information du back-office par le menu Contenus > Lettres d'information. Choisir la

lettre d'information voulue (dans le cas ou il en existe plusieurs), cliquer sur le bouton "Composer" E pour générer et/ou
saisir le contenu.



Lettre d'information composition d'un

i
)
o
m

Lettre d'information du 2e
Gestion des attributs Configuration de la génération Composition d'une newsletter

" Enregistrer | (* Envoyer un test ® Annuler

.E.B IIFOFmatS'IEE 1= “Qlillﬁldolgl -!",() x2

Si vous ne visualisez pas correctement cette lettre d'information, cliquez ici.

p )

Lettre d’info de la mairie du 2e

Lundi & juillet 2015 Mairie2.paris.fr

Paris contre |'installation d'un fast- R
food géant

. . Mairie du 2e
Aprés I'adoption d'un veeu « anti-fast-food =

lors du dernier Conseil d'arrondissement, c'est
8, rue de la Banque

au Conseil de Paris mardi dernier gue les élus 75002 PARIS

parisiens ont décidé de se prononcer contre le

; ) ) ; M Bourse
projet d'installation de ce fast-food géant. Tél: 0153 29 75 032
Lundi - Vendredi : 8h30 a -

table Mots : 281__,

Les articles apparaissent de maniere automatique dans I'éditeur sous la forme définie dans le modeéle d'article et le modeéle
de lettre d'information apres avoir cliqué sur le bouton "Générer" .

La production automatisée d'une lettre d'information est facilitée par le "taggage" par catégorie des articles publiés sur le
site. Pour cela il est conseillé de créer des catégories dans le plug-in document, typiquement on associera un article a la
catégorie "Lettre d'information" permettant ainsi d'avoir tous les articles de la catégorie "Lettre d'information" créés depuis
le dernier envoi inséré dans votre lettre d'information.

Astuce : Si vous souhaitez voir apparaitre les articles dans un certain ordre, il faut commencer par tagger les articles qui
devront apparaitre en dernier. Ex : la lettre doit présenter les articles en ordre 1, 2 et 3. L’article 3 sera taggé en ler. L'article
2 sera taggé en 2e. L’article 1 sera taggé en 3e.

A partir de I'écran de composition, vous pouvez "Enregistrer" vos modifications, "Annuler" vos modifications, "Envoyer un
test" au panel d'utilisateur défini dans les propriétés de la lettre et enfin "Préparer I'envoi" .

ENVOYER LA LETTRE D'INFORMATION

Il est possible d'envoyer la lettre d'information en cliquant sur le bouton "Composer".
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Lettre d'information e

Préparation de l'envoi de la lettre d'information
Objetdela
newsletter
Corpsdela Sivous ne visualisez pas correctement cette lettre dinformation, eliquez ici. =
newsletter

‘
.l

Lettre d’info de la mairie du 2e

Lundi 6 juillet 2015

Paris contre l'installation d'un fast-food geant

Aprés ['adoption d'un voeu « anti-fast-food » lors du dernier Mairie du e
Conseil darrondissement, c'est au Conseil de Paris mardi
dernier que les &lus parisiens ont décidé de se prononcer 8, rue de la Banque
contre le projet dinstallation de ce fast-food geant. 75002 PARIS
M Bourse

T = - Tel:- 0153297502
Mercredi, c e_st grande bradgrle ala Ressou_rcerle Lundi - Vendredi - 8h30 a 17h00
La Ressourcerie Paris-Centre fait sa grande braderie. Jeudi - 8h30 & 19h30
Retrouvez toute la journee de mercredi, une sélection Saneﬁ - 9h00 & 12h30

d'eeuvres et dobjets d'eccasion au 13 rue Léopold Bellan, vl uniquemen
dans la rue et en boutique. HETIE )

Pour envoyer la lettre, il faut saisir I'objet et cliquer sur le bouton "Envoyer". A partir de cet écran, vous pourrez revenir a la
composition de la lettre.

GERER LES ARCHIVES

L'ensemble des envois d'une lettre d'information est consultable en cliquant sur le bouton E "Gestion des archives".



Lettre d'information cestion des archives

Gestion des archives

[0 v C 130
| 8 Supprimer |
Nom Date Suppression

[ Lettre d'information - Lundi 6 juillet 2015 6 juil. 2015 19:56:46 u
[0  Lettre d'information - Lundi 29 juin 2015 29 juin 2015 17:16:35 u
[0  Lettre d'information - Lundi 22 juin 2015 22 juin 2015 17:44:13 u
[0  Lettre d'information - Lundi 15 juin 2015 15 juin 2015 10:26:19 u
[0  Lettre d'information - Lundi & juin 2015 & juin 2015 10:44:46 u
[ Lettre d'information - Lundi 1er juin 2015 1juin 2015 11:17:14 u
[J  Lettre d'information - Mercredi 27 mai 2015 27 mai 2015 11:39:58 u
[0  Lettre d'information - Mardi 19 mai 2015 19 mai 2015 12:0T:08 u
[  Lettre d'information de la mairie du 2e - Lundi 11 mai 2015 11 mai 2015 14:33:21 u
[0  Lettre d'information de la mairie du 2e - Lundi 4 mai 2015 4 mai 2015 15:33:52 u

Il est possible d'afficher une lettre en cliquant sur son nom et de supprimer une lettre ou une sélection de lettres.

GERER LES ABONNES

Pour accéder a la gestion des abonnés, il faut cliquer sur le bouton E "Gérer les abonnés". Il est aussi possible d'exporter
X

toute la liste des abonnés par le bouton "Exporter les abonnés".

Il est possible de rechercher, inscrire un ou une liste d'internaute-s-, désinscrire un abonné ou une sélection d'abonnés.
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Lettre d'information cesticn des abonnés

Gestion des abonnés | seereners | NSV e [ e
Recherche d'un abonne

Précédent 2 | 3|4 |5 |6 |7|8|9 10| 11| .. | Suivant | Fin

Nombre par page| 10 v | C -Nombre d'éléments: 1456

il Supprimer la sélection

O Email A v Date d'inscription A v Statut Suppression de 'abonné
[  0620551834@sfr.net 31 déc. 2008 16:04:46 @) Activé n
[J  1000titre@gmail.com 26 nov. 2014 00:00:12 ) Activé n
[  4m50@wanadoo.fr 3 avr. 2013 14:29:46 ) Activé n
[ a-calle@parishabitatoph.fr 6 juin 2011 11:31:39 © Activé n
[ a.boclet@neuf.fr 15 mai 2007 17:08:25 © Activé n
]  a.puichard@notaires-paris.com 31 déc. 2008 16:04:46 ) Activé n
[ aleveque@completel.fr 15 mai 2007 17:09:25 © Activé n
[ a.musee@free.fr 31 dec. 2008 16:04:46 ) Activé n
[ a.neuser@wanadoo.fr 31 déc. 2008 16:04:46 @ Activé n
[ aregnier@free.fr 15 mai 2007 17:08:25 © Activé n
Précédent 2 3 4 5 6 T &8 9 1 11 .. Suivant Fin

LES RUBRIQUES EN FRONT-OFFICE

Dans I'Administration du site > Ajouter Rubrique vous pouvez ajouter deux types de rubriques:

e La rubrique "Souscription aux lettres d’information" permet de proposer aux internautes l'inscription a une ou plusieurs
lettre(s) d'information, on peut choisir les lettres d'informations a afficher dans la rubrique.

e La rubrique "Archives de newsletters" permet de publier toutes ou une sélection de lettre d’'information déja envoyées.

Apres avoir créé la rubrique dans une page, il vous sera proposé de cocher les lettres d’informations que vous
souhaitez y voir apparaitre.
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11. CREER UNE FAQ

Cette fonctionnalité permet de proposer aux internautes une FAQ sur un ou plusieurs sujets, ou il pourra consulter les
questions posées et les réponses apportées. Si aucune question ne correspond a ses attentes ou si les réponses apportées ne
conviennent pas, il peut, a son tour, soumettre une question. Celle-ci sera transmise a un expert ou un administrateur qui
soit lui répondra directement soit publiera cette nouvelle question et la réponse associée.

La premiére étape est de définir les sujets principaux, c'est-a-dire les regroupements de questions qui seront publiées sous
le méme sujet.

L'administrateur de la FAQ devra gérer les couples de questions/réponses (ajouter, modifier, supprimer, rendre invisible dans

les faqgs), gérer les thémes, c’est-a-dire les regroupements de questions, éventuellement, lui ou des experts désignés,
répondre et publier les questions des utilisateurs.

CREER UNE NOUVELLE FAQ
Pour créer un gérer une FAQ vous devez utiliser le plug-in Helpdesk.
En cliquant sur I'icone Gestion des sujets, I'administrateur peut modifier les sujets existants dans leur formulation et

I'ordonnancement général. Il peut également créer un nouveau sujet et le positionner dans I'arborescence générale des
sujets.

'u. E .E £} Contenu ~  Site~  Applications ~  Utilisateurs v Gestionnaires ~  Charte ~  Systéme ~ A 2:dminAdmin -~

Gestion du Help Desk wenu dadministration dessuijets dela FAQ

Liste des sujets - F.A.Q. Lutéce + Ajouterun sujet.
50 v c2
Sujets Actions
Administation du Site (Id: 1) - 2 Question(s) v > <@
Publication (Id : 2) - 0 Question(s) - 8
Documents (id: 3) -3 Question(s) ] <8

Les actions possibles sont :

e Créer un nouveau sujet en cliquant sur Ajouter un sujet.

o Modifier le nom d'un sujet existant en cliquant sur le sujet lui-méme.

e Supprimer un sujet existant en cliquant sur I'icone Supprimer. Attention, toutes les questions/réponses liées a ce sujet
seront elles aussi supprimées !

o Modifier I’ordre des sujets en descendant ou en remontant un sujet.

e Modifier la hiérarchie des sujets.

GERER LES COUPLES DE QUESTIONS/REPONSES

Ony accéde en cliquant sur I'icone Couples question/réponse associée a une FAQ dans la liste des FAQ de la premiéere page.
Une liste de questions/réponses, classées par sujet, s'affiche.

00:0: > Contenu v Site~  Applications ~  Utilisateurs ~  Gestionnaires ~  Charte ~  Systéme ~ A 2 admin Admin -

Gestion du Help Desk Gestion des couples question/répanse

Liste des sujets Administration des couples question/réponse  Ajouter un couple question/réponse:
Administation du Site Appliquer 3 la sélection : | Publier v
publication

Recherche Couples questions/réponses Etat Actions

Je viens de créer une rubrique dans I page courante et elle n'apparait pas dans ['apercu de prévisualisation o] v o@
Recherche pourquoi ?
Pourquoi sommes-nous obligés de saisir un titre de rubrique au moment de sa création lorsque lon choisit ensuite @ - s
Parue a partir du: un style "Sanstitre" ?
[ ]
au:
]
Sujets:
Administation du Site v
Rechercher aussi dans les sous-sujets
Nombre de questions par page:[10 v
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Il est également possible de retrouver un couple question/réponse via le moteur de recherche.
Les actions possibles sur un couple question/réponse sont :

Créer un nouveau couple en cliquant sur Ajouter un couple question/réponse.

Modifier la question, la réponse, ou le sujet d'un couple en cliquant sur la question elle-méme.
Supprimer un couple question/réponse existant en cliquant sur I'icobne Supprimer liée au couple.
Publier / dépublier un couple question / réponse dans la FAQ.

Ordonnancer les couples question / réponse via les icGnes Monter et Descendre.

GERER LES QUESTIONS POSEES PAR LES UTILISATEURS

On accede a l'interface de gestion en cliquant sur I'icbne Administration des questions des visiteurs. Une liste de questions a
traiter - s'il y en a - s'affiche.

Contenu~  Sitev  Applications »  Utilisateurs v Gestionnaires v Charte v Systéme A L adminAdmin ~

Gestion du Help Desk dr

Liste des themes Administration des questions des visiteurs
* Administration du Site Questions des visiteurs Expéditeur Date Actions
Comment ajouter une vignette 3 une page ? Internaute 1 Internaute 1 05/08/2015 n

Les actions possibles sont :

e Répondre a une question en cliquant soit sur I'icbne Répondre soit sur la question.
e Visualiser les questions archivées auxquelles I'administrateur a déja répondu.
e A noter : il n’est pas possible de modifier ou de supprimer une question d’un utilisateur.

En répondant a une question, I'administrateur accede a un formulaire de réponse. Au travers duquel il peut :

S'informer sur I'identité de I'utilisateur qui a posé une question,

Modifier I’objet du mail de réponse qui va lui étre envoyé,

Composer une réponse a sa question,

Décider d’ajouter cette question / réponse aux autres couples de question / réponse en cochant la case en bas du
formulaire.
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'U.E.E @ Contenu~  Site  Applications v Utilisateurs v+ Gestionnaires »  Charte v Systéme v A | L :dminAdmin -

Gestion du Help Desk zépondre & une question dunvisiz
Répondre & une question

Nom
Internaute 1

Prénom

Internaute 1

Date

Question

Commentajouter une vignete 3 une page ?

Objet

Réponse *

Fichier v  Editer + Insérer v Voir +  Format~  Tableau v  Qufils ~

Lo e e )

K Fomats~ B [ |A~- B~ E

P Mots -0,

Ajouter aux couples question/réponse

Une fois la réponse envoyée, modifiez I'intitulé de la question, le sujet proposé par |'utilisateur et sa réponse pour I'insérer
dans la FAQ via un formulaire rechargé, I'administrateur verra ensuite apparaitre la question / réponse dans la liste des
questions / réponses.

A noter : il est possible d’importer un grand nombre de questions/réponses a partir d’un fichier tableur a I'initialisation de la
FAQ.

Sur le site internet, I'internaute consulte les différentes questions et réponses de la FAQ.

Foire Aux Questions

Administation du Site

Publication
> Documents

wotre guestion reste sans réponse Contactez-nous

' Administation du Site

+ Je viens de créer une rubrique dans la page courante et elle n‘apparait pas dans l'apercu de prévisualisation :
pourgquaoi 7

11 pedt s'acie o rmocidle de présentation seleclionng powr volie pace | SIVOUS CHEET LN FIBFIGUE GUe vous places
en e colohne, 2sSUIeF-Vous que fe moddle 3ss0cié & la page en colrs camprend dewx cofonnes (par défaut fa
cormpasition § une colonhe est sélectionhés).

Uin autre cas peut se présenter | vous avez Wiilise e plan du site pour accéder & une page etvous Whllsez ensuite
e formulaive oadministation pouy créer upe ribrigue dans Ja page. Vérfier en haut oy formuiaire
d'adrninistation du site que iz page courante st bien calle affichés en prévispalisation. Dans le cas contraire, ia
FUbICNE QUE WOUS VENeZ de créer a été placée dans Ia page Indiquée corume padge cowanie.

Haut de page 4

+ Pourquoi sommes-nous obligés de saisir un titre de rubrigque au moment de sa création lorsque I'on choisit
ensuite un style "Sans titre” 7
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Les controfas efecilles 0K es TONSs de 531508 g1 Imomeht e [a Vaidation du formuiaie de cheathon oiine FUBnGgLS
sont les mdrmes, quelale sojt e cholyx oe iz mjse en forme reteny. Cormime les sivles corresnonoont & des inises on
farme spéciales du contendy, NOUS N'Evons pas fes Moyens de savolr, a0 nivead dy formuiaire, sifa mise en forme
choislie affiche ou non fe e,

Dans uhe prochalne veralonh de loubll If sera possible de créer des allas de rubrigque, cesta-dive de placer dans
uhe autre page, e conteny dune rubrigue défa crége, sans avalr 3 resaisir son conleny. Le cholx de fa ribrique a
cuplicier sera fara & partie die son titve (gl faldra avolr Fenssigné).

Havt de page 4

* Publication

' Documents

b Larticle que je viens de publier n‘apparait pas en previsualisation dans la rubrique sélectionnée :
pourgquaoi 7
La pubiicabion conslste  créer Un lien entre Un article prodlit par un fournisselr et une rubrigue de bpoe
" Liste ciarbicios " Pour s'assurer que g valloite o'un artiche pubilié sur e portail ne s0it pas dépassse, on
ciefinit au niveay de chaque article fa période pendant laquelle l'aricle sera wisibie sur fe porkail (date de
ciabut die valicite et date oe fin de valldite). Das que Ta date oe fn de valldité est attainte, l'article n'apparait
s dans la late,
Sivous publier un article dont ia date de debut de validité n'est pas encore atheinke ou dont fa date de fin de
valiciité st dépassde, laricle n'apparaltra pas cdans Ia rubriogue !

Havt de page 4

-

L article que je viens de créer n‘apparait pas dans la liste des articles a publier : pourquoi ?

Dans e cas oe NWilisation dune base pattagde ef dun ensamble de bases locales (cormme cest e cas pour
laa portalls des malties darrondiasernant), Iz création d'un article se falt dans la base partagée, méme sl la
portée o flux uiilise pour sa création estlocale a votre portail,

Pour pasivalr publier volre article dans les rubriques de volre porall vous devez aynchroniaer volre hase
avec la hase partanée. Celte apération consiste & rapattier dans volte hase Jocale les arlicles créés en base
partagée.

Haut de page -

-

A quoi sert M'awuto-publication ?

Lauto-publication & 84 mise en place pour permettre & coralins Fournisseurs de confenu de valr laurs articlas
publiss direchorment dans Whe FUbroue oy porkall, sans que o webimestie interilenne.

Exemale | Le fournissewr peut dire une assaciation jocale, pow laquelle un fiux jocal d'articies aura eié creéé
SUF e portall et un cornpte Wsatalr aUra 818 mis & disposition de son responsabie. Cornrme l'aulo-
puRbieation permeat o'associer Un fwx iocal & We rubricue de hoe liste d'aficles, les articles procdults par e
responsabie de lassociation seront directement publies dans sa rbrigue.

Haut de page 4

wotre guestion reste sans réponse Contactez-nous
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PROPOSER DES SERVICES AU PUBLIC

12. COMMENT CREER DES FORMULAIRES ?

13. CONSULTER ET DIFFUSER LES RESULTATS DU
FORMULAIRE

14. PRISE DE RENDEZ-VOUS USAGER
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12. COMMENT CREER DES FORMULAIRES ?

Le plug-in Form permet de créer des formulaires facilement paramétrables pour dématérialiser des demandes d'inscription,
des dossiers de candidatures, des formulaires de réclamation ou de déclaration d'incident. Il permet de disposer rapidement
de fonctionnalités permettant de récupérer les données saisies par les utilisateurs et de les exporter par exemple dans un
fichier CSV qui peut étre ouvert dans un tableur. Il est aussi possible de consulter, gérer ou traiter ces données dans le back-
office de Lutece.

Cet outil peut permettre de répondre a des demandes trés simple mais peut également permettre de gérer des demandes
beaucoup plus complexes comme faire un suivi de dossier. On peut par exemple interfacer un module d'authentification
pour récupérer les données de |'utilisateur (ses coordonnées, son quotient familial) ou des données déja renseignées dans
son profil.

PRISE EN MAIN DES FORMULAIRES

Pour accéder a la gestion des formulaires, cliquez sur Gestion des formulaires dans le menu Applications.

Applic

Gestion de |a cartographie
Gestion des annuaires Liste des annuaires +
Gestion des réseaux soclaux
Titre Actions
B E
Gestion des wo

Gestion des utilisaieurs & Administration du Site @

Liste des annuaires @

Liste de formulaires +
Administration du Site — —

Nombredepiugis isties Derniére rubrique modifiée B3 rermis de végétatiser  [EJE]
[ Page 1- Html ou Texte libre E Nombre de réponses 0 E

B rermis devégétaliser B E]

Administration du Site @ Nombre de réponses 0 n

Qu'attendez vous d'un E E
B

Gestion des Plugins ©

CMS open-source 7
Nombre de réponses 0

Liste de formulaires @

Liste des workflows +

Titre Actions

Liste des workflows @

L'interface de Gestion des formulaires récapitule les actions pouvant étre effectuées sur un formulaire, en fonction des roles
de I'utilisateur.

La liste des formulaires est triée par date de création du formulaire, du plus récent au plus ancien. Cette derniere peut étre
filtrée sur le statut d'un formulaire ainsi que sur I'appartenance d'un formulaire a un groupe de travail.
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Gestion des formulaires O Aide

Liste des formulaires Statut.  -Tous- |Z| Groupe d'utilisateur  <Non assigné 4 un groupe> Q, Filtrer

Titre A

Nombreparpage| 50 j C -Nombred'éléments: 3

Période de disponibilité Actions

E Permis de végétaliser & EEEEEE
BPermis de végétaliser @ EEEEEE
ﬂQu'attendezvous d'un CMS open-source 7 @ EEEEHE

-Nombra d'éléments: 3

[Tl | »

Les boutons d'actions, visibles en fonction des droits des utilisateurs, permettent d'effectuer les actions suivantes :

EERED oD@

5D

Acces a I'administration du formulaire, afin d'ajouter ou de modifier des champs de
saisie.

Acceés a l'interface qui gére I'affichage du récapitulatif des données qui ont été
saisis par |'utilisateur.

Acces a l'interface qui permet de gérer les messages qui sont affichés juste avant
le formulaire, une fois qu'il n'est plus actif pour modifier les conditions générales
d'utilisation.

Acces a l'interface qui permet de récupérer sous format CSV I'ensemble des
réponses qui ont été effectuées.

Tester le formulaire en back-office avant qu'il ne soit publié.

Publier un formulaire afin qu'il soit visible par les utilisateurs en front office.
Dupliquer un formulaire.

Acceés a l'interface qui permet de créer un annuaire (directory) permet de traiter les
données des utilisateurs dans un outil de back-office et d'envoyer un accusé de
réception a I'utilisateur avec le récapitulatif de sa demande (avec workflow).
Suppression du formulaire.

Gérer les validateurs (validateur de dates, de comparaison).

s Cré fi Lail
CREATION D'UN FORMULAIRE

Cliquez sur créer un formulaire. Dans |'interface suivante, indiquez le nom du formulaire et sa catégorie.
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Gestion des formulaires créstion d'un formulaire O Aide

Création d'un formulaire

Titre *
permis devégétaliser

Titre court qui décrit le formulaire.

Description *

Téléservice permettant de

Descriptif plus complet du formulaire.

Catégorie

Catégorie du formulaire
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Enregistrer &) Annuler

Remplissez les différents champs qui permettent de décrire le formulaire que vous créez. Cliquez sur Enregistrer et vous
parviendrez a |'écran permettant de construire votre formulaire en y ajoutant des champs.

AJOUTEZ DES CHAMPS DE SAISIE LIBRE
Une fois le formulaire créé, il faut définir I'organisation, les regroupements, les informations que I'utilisateur aura a

renseigner. Il arrive fréquemment que I’'on demande a I'utilisateur de saisir une information ouverte (nom, prénom, adresse).
Dans ce cas, il est possible de passer par une zone de texte court (une seule ligne) ou long (multiligne).

Choisissez les champs a ajouter dans la premiére liste déroulante et cliquez sur son bouton .

Gestion des formulaires wodicaton dun formuie @ ice
permis de végétaliser Bivegitrer
Titre * permis de végétaliser Listede questions | Paramétresavancés  Publication  Gestion desréponses

Titre court qui décrit le

formulaire.
K EIEr Un regroupement <Aucun regroupement> j
.
Description  Tléservice permettant Case & cocher
* de Commentaire
Date .
Liste déroulante Type 2] Actions

2:::32:2::|L.; Nombre par page| 50 jc-Nombred'élémems:O
Fichier

Liste déroulante SQL
Géolocalisation

Descriptif plus complet

du formulaire.

Image
Session
Catégorie j Humérotation
Cases a cocherobligatoires
Catégorie du Attribut de l'utilisateur MyLutece
formulaire Tableau
Enregistrer | " Appliquer

XAnnuler

Vous étes alors dirigés vers une page permettant de valider un certain nombre de propriétés du champ.

o Titre : il s’agit du texte accompagnant le champ et mentionnant son role. Prenons I'exemple d’'un champ demandant
I'identité et écrivons Nom,

o Obligatoire : cochez la case si vous souhaitez forcer I'utilisateur a donner cette information. C’est la case
typiguement utilisée dans le cas d'une acceptation de conditions d’utilisation, par exemple.

» Message d’erreur si aucune valeur n’est saisie : permets d’informer I'utilisateur que nous souhaitons qu'il
remplisse cette information, éventuellement en lui expliquant. Ici nous avons écrit Le permis est nominatif. Merci de
mentionner votre état civil.

e Largeur de la zone de texte : correspondant a la dimension de la zone dans la page, cette dimension est a
renseigner en pixels.

o Longueur maximale du texte saisi: permets de limiter le nombre de caractéres que I’'usager pourra écrire. Dans le

cas d’'un nom, on peut penser que 50 puisse étre suffisant. Dans le cas des numéros de téléphone, cela pourrait étre
10, ce qui permet d'éviter des erreurs de saisie.

Enregistrez alors les modifications. Répétez I'opération pour les autres champs par exemple un prénom.
AFFICHER DES CHOIX PREDEFINIS

Dans de nombreux cas, il sera possible, voire nécessaire, de définir un certain nombre d’options de réponse. En effet, les
formulaires ouverts sont plus difficiles a traiter. Des qu'il est possible de restreindre le champ des réponses sans casser
I'esprit du questionnaire, autant le faire.

Il'y a plusieurs types d’interface parmi lesquels, les boutons radio, les cases a cocher et les listes déroulantes. La création de
ces éléments sera un peu plus longue que pour les textes. Essayons de donner le choix entre deux options a |'utilisateur.

Attention, il n’est pas possible de modifier le type de champ apres I’avoir créé.

1. Créez un bouton radio et renseignez le texte qui doit apparaitre

2. Cliquez ensuite sur Enregistrer et gérer les réponses pour arriver sur une nouvelle page permettant d'établir les
différents choix que nous mettrons a disposition.
3. Dans la fenétre liste des réponses, cliquez sur le bouton Créer une réponse.
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Liste de réponses

Titre valeur (2] Action

4. Dans la nouvelle page, saisissez un texte pour la réponse, la valeur qu’elle aura au traitement, en générale plus courte
(sans caractéres spéciaux comme des signes de ponctuation ou espaces) ou chiffrée. Si vous cochez la case Valeur par
défaut, cette option sera automatiquement cochée dans la page.

Gestion des formulaires creation dune réponse 32 question @ Aide
Création d'une réponse a la question : 'Je souhaite recevoir...'

Titre *:

Des graines de fleurs sauvages

Valeur *:

graines fleur

Commentaire :

Valeur par défaut :

v

Ne pas afficher le titre de laréponse :

" Enregistrer ® Annuler

Enregistrez et reproduisez pour chacun des choix. La liste des réponses apparaitra dans la page. Elle reste modifiable et

Liste de réponses

Titre valeur @  Action
Des graines de fleurs sauvages grainessauvages
Des graines de plantes aromatiques grainesaromatiques n

Des fleurs en plastigue plastique n

I'ordre interchangeable.

S'il vous convient, enregistrez. Les boutons radio et les listes déroulantes ne permettent qu’une seule réponse. La case a
cocher a un statut spécial : lorsqu’une seule option, elle sert a valider ce choix unique (par exemple dans le cas d'acceptation
de conditions d'utilisation); lorsqu’il y a plusieurs options, elle permet a I'utilisateur d'en sélectionner plusieurs.

ORGANISER LE FORMULAIRE

Si votre formulaire s’allonge, il peut étre intéressant de le structurer de maniére a ce que les usagers et vous-méme puissiez
mieux vous y repérer. Par exemple dans le cas d’un formulaire d’inscription a un service de centre de loisirs, il y aura
souvent plusieurs noms ou prénoms et il faut prévenir toute confusion. Regrouper les informations permet d’y voir plus clair
en ligne, de la méme facon que les encadrés le font sur un formulaire papier.

1. Saisissez le nom de votre rubrique dans le champ Créer un regroupement puis cliquez sur .
2. Cliquez sur le bouton Déplacer le champ pour afficher les propriétés de regroupement.
3. Dans le nouvel écran, choisissez le regroupement auquel vous souhaitez associer votre champ et validez.
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Gestion des formulaires ® Aide

Déplacer le champ : 'Prénom’

Cliquer sur le regroupement de destination

(») Identité
« Déplacer X Annuler

4. De retour dans la liste de vos champs, il doit apparaitre décalé comme dans I'exemple ci-dessous. Ici Nom n’est pas
placé dans le regroupement Identité.

=] Titre Type Q Actions
O wom Lo EO@En
= |dentité 2 Hv s

b prénom . A ER@ED
Nombre par pagel 50 j (* -Nombre d'éléments : 3

5. On remarquera que les chiffres placés en colonne représentent I'ordre dans lequel les champs seront affichés. Il suffit
de changer le chiffre dans la liste et de cliquer sur le petit bouton bleu juste a sa droite. Les champs accompagnés
d’une coche sur fond gris ne peuvent étre déplacés. Ici, le chiffre 1 apparait deux fois car celui du champ Prénom
indique la position dans son regroupement.

6. Cliquez sur le bouton Enregistrer pour mémoriser les changements avant de quitter la page.

TESTER LE FORMULAIRE

Apres modification des ordres et des regroupements, il est souhaitable de tester le formulaire. L'interface de saisie affiche le
formulaire tel qu'il apparaitra a I'usager, cependant privé du style d'affichage de la rubrique ou il sera inséré. Les tests sur
les formulaires permettent de vérifier que I'ensemble des informations du formulaire sont bien présentes et que les
contréles concernant la saisie utilisateur sont bien effectués. Pour tester un formulaire

1. Aprés modification des ordres et des regroupements, il est préférable de tester le formulaire. Cliquez sur le bouton E
dans la liste des formulaires.

2. Vous étes alors dirigé vers une page vous donnant un apercu du résultat et vous permettant d'évaluer la clarté de vos
choix.
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Tester un formulaire Exporter les réponses

o @
permis de vegetaliser
Message de bienvenue

Identite

Nom *

Prénom *

Ma participation

Je souhaite recevoir ... *

Des graines de fleurs sauvages Des graines de plantes aromatiques

* ) Des fleurs en plastique

3. Remplissez alors le formulaire et vérifiez qu’il se comporte correctement. Cela inclut que la saisie fonctionne bien,
mais aussi que la vérification des champs obligatoires est bien faite.

4. Lorsque tout est bon c6té formulaire, vérifions que tout I'est aussi dans les données recues. En haut de la zone de test,
dans la partie Exporter les réponses, choisissez CSV et cliquez sur le bouton pour télécharger les résultats. Vous
pourrez ouvrir ce fichier dans un tableur pour vérifier les données et les trier.

Il est possible de consulter les résultats en exportant les réponses saisies durant le test (les réponses insérées ne sont
stockées que durant la période du test). Pour consulter les résultats, cliquer sur le bouton idoine apres avoir sélectionné un
format de sortie.

AFFINER LES MESSAGES D’ACCUEIL ET DE REPONSE FOURNIE

Dans I'exemple précédent, on observe bien qu’il y a des petits détails a régler. Par exemple, le texte Message de bienvenue
est affiché alors qu’il serait bien sir plus engageant d’en avoir un qui corresponde a I'opération. Il est possible de modifier
les messages liés a votre formulaire tels que :

Le message d’indisponibilité.

Le message de bienvenue.

Les conditions d'utilisation.

(]
(]
(]
o Les libellés des boutons de validation et de réinitialisation.

Toutes ces options sont regroupées en un seul endroit pour plus de facilité.

1. Retournons dans la liste des formulaires par Applications > Gestion des formulaires.

2. Cliquez sur le bouton Gérer les messages d’un formulaire u correspondant a celui que nous souhaitons
modifier.
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Gestion des formulaires Gestion des messages 0 Aide

Gestion des messages : 'Permis de végétaliser'

Libellé du bouton de validation * Soumettre

Libellé du bouton de réinitialisation

Message d'indisponibilité* | Fichier ~ Editer~ Insérer~ Vo~ Fomat~ Tableau~  Qutis ~
h ¢ Bjfomas- B /] A-E-EEZEE-E-EE LSFH
‘fp @ M o
Message dindisponibilité
D Mols:,’i___

Message affiché  la place du formulaire aprés expiration de la date limite de disponibilité.

Message de bienvenue Fichier +  Edfer ~ Insérer» Voir~ Fomal~ Tableau~  Qutis

h ¢ B fmasr B J AH-EEZEEE-EE LSE

‘ﬁ ® 0o

Message de bienvenue

p Mols:S___

Conditions d'utilisation * Fichier +  Edier~ Insérer~ Voir~ Format~ Tableau~  Qutils »

4 ﬁ@lFomalsv B Iuvﬁv
‘Ep@ oo

S ECEE 44 B

Conditions d'utiisation

p Mots: 2,

v Enregistrer IEFANE

3. Allez dans la zone Message de Bienvenue et changez le texte.
4. Enregistrez vos changements et vérifiez le formulaire.




Bienvenus

Vous &tes nombreux & vouloir une ville plus verte et fleurie. Ce
formulaire vous permet de participer & une opération
exceptionnelle financee par la ville et visant a augmenter a tous
notre confort de vie.

ldentité

Nom *

Prénom *

Ma participation

Je souhaite recevoir ... *

+) Des graines de fleurs sauvages Des graines de plantes aromatiques

Des fleurs en plastique

+ Je participe !!

Dans I'exemple précédent, nous avons modifié le texte de bienvenue ainsi que le libellé du bouton.
Gestion du récapitulatif d'un formulaire

Pour certains formulaires importants, il peut étre utile de présenter a |'utilisateur un récapitulatif de ce qu’il a saisi. Cela est
particulierement vrai pour les formulaires ayant un impact dans la vie réelle (acquisition de droits, inscriptions) mais aussi
lorsque les formulaires sont assez longs.

Le bouton E de la liste des formulaires donne accés a une interface de saisie récapitulant les messages qui devront étre
affichés apres validation du formulaire par un répondant. Pour que le récapitulatif soit affiché, cochez la case Afficher un
récapitulatif.

URL de retour est I'adresse de la page web vers laquelle I'utilisateur sera automatiquement conduit. Cela peut étre une page
de remerciement construite pour I'occasion ou simplement la page d’accueil.

Gestlon du recapitulatil : '"Permis de végdtaliser”
URL do retour * Epiame/Portal pnTpagesioem
bessape du récapiulatil Femar = Edder = eder =  Yoir - Formal - Tebkeau = Ouwiis =
B Fomas~- B F |A-N-E X A R | E-E-3 @ |9 £ 8
e 32 oo
Messa08 o r&0 apausant
[ Mots -3

Afficher anricapitelatif

¥

Alficher un graphique

m e

RENDRE PUBLIC LE FORMULAIRE

Une fois les vérifications effectuées et messages adaptés, il va étre possible de le publier et permettre aux usagers d’y avoir
acces.

1. Retournons dans la liste des formulaires par Applications > Gestion des formulaires.

2. Cliquez sur le bouton pour l'activer.

3. Vous pouvez alors cliquer sur I'icdne représentant la petite Terre auprés du nom du formulaire pour voir son aspect
final, avec la mise en forme publique.

4. Si vous avez anticipé la création du formulaire et souhaitez qu’il ne soit disponible qu’ultérieurement ou que sur une
période donnée, cliquez sur I'onglet Publication.

5. Passez en mode Automatique et saisissez les dates de début et de fin de disponibilité.
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Publication

wode de publication @ Manuel Automatique

utomatique, le formalaire sera publié automat

Date de début de disponibilité &2 oo = pate de fin de disponibilité

La gestion du mode de publication, qui peut étre réglée de maniére manuelle, totalement gérée par le créateur du formulaire,
ou de maniére automatique pour programmer sa date de début et de fin de disponibilité. De cette fagon, plus besoin d'y
penser, pas d’oubli possible. Il ne restera qu’a venir traiter les réponses une fois I'opération terminée.

Vous pouvez visualiser sur le site de démonstration de Lutece.
VISUALISATION DES RESULTATS D'UN FORMULAIRE

La derniere opération liée au formulaire sera souvent le traitement des données. L'outil de visualisation des résultats donne
un apercu rapide de la fréquentation du formulaire, et de son évolution dans le temps. Il s’agit d’'une premiére approche qui
permet éventuellement de réviser une stratégie de publication. Par exemple, on peut anticiper qu’un formulaire aura une
centaine de réponses par jour parce qu’il s’agit d’'un taux moyen pour un formulaire identique déja utilisé les années
suivantes. Un chiffre de fréquentation étrangement bas pourrait amener a vouloir mettre le formulaire plus en avant,
éventuellement sur la page d’accueil du site.

]

estion des formulaires

¥

réponses du formulaire : 'Permis de végétaliser’

Date de validation comprise entre & e B | Graphigue du nombae réponses @  par pour par semaing par mals
Statistique de fréquentation Exporteriss chsultats au format, - cw b & Eeporer |
e Té|
oy P | e 3 o
(01 Date de la premidre répons: =
£ Dat fidre répor "
-f_

Il est possible d'affiner les résultats en choisissant un intervalle de date de validation pour les réponses.

Dans tous les cas, pour obtenir des résultats détaillés, il faudra exporter les résultats au format CSV et les ouvrir dans un
tableur pour traitement. La liste des formats est administrable dans Gestion des feuilles XSL d'export. Pour obtenir de
nouveaux formats, demandez a votre intégrateur ce qui est faisable dans un temps convenable.

Pour plus d’informations sur la visualisation des résultats, reportez-vous au chapitre Consulter et diffuser les résultats d'un
formulaire.

DESCRIPTIONS DES OPTIONS DE FORMULAIRE

Lors de la prise en main, nous avons construit un exemple allant a I’essentiel et nous avons laissé de c6té la description d'un
grand nombre de possibilités.

D’abord, plusieurs parameétres plus généraux vous permettent d'administrer le formulaire :

e Les parametres avancés.
e La publication.
e La gestion des réponses.

LES PARAMETRES AVANCES
Les parametres avancés permettent de :

e modifier le titre qui sera affiché en front office,

d'associer un formulaire a un groupe de travail Lutece et restreindre I'administration aux utilisateurs du groupe,

de notifier aux membres d'une liste de diffusion a chaque validation du formulaire par un répondant, ainsi qu'une
notification de fin de validité du formulaire a I'expiration de ce dernier,

de modifier le theme, I'apparence du formulaire parmi ceux proposés,

de limiter a une réponse par répondant,

de tracer les utilisateurs selon leur adresse IP,

d'activer les conditions générales d'utilisation et obliger le répondant a cocher une case correspondant aux conditions
d’utilisations du formulaire, que ce dernier doit connaitre (les conditions d'utilisations, sont accessibles a partir des
boutons d'administration généraux du formulaire.

Les informations complémentaires correspondent a un message qui sera diffusé en dessous du libellé du formulaire quand
celui-ci est dans une liste regroupant plusieurs formulaires.
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Le support des connexions sécurisées permet d'éviter qu’une tierce personne, écoutant le trafic du réseau, intercepte le mot
de passe des utilisateurs (technique dite de sniffing).

EEnregistrer | o Appli

e die questions Bariimitres avar

Front office: Titre

# de choisir le titre afliché pour ce for

Front office: Afficher le titre 7

Parmet d"afficher ou non [ titre ci-dessus en front-offion.

Groupe de travail =Mon assigne 3 un groupes ]

Hotifier 4 un groupe
d'utilisateur
indisponible.
Thitme de la xpage Théme par défaut =

Limiter le nombre de réponses

ofse par repondant.

1 de n"autoriser qu'une

Tracer les ulilisateurs

Permet de sio

ker 'adresse P duré pandant.

Activer les conditions

Oblige N'utilisateur 3 valider les conditions d'utilisation avant de soumettre le formulaire.
Information complémentaire 1
Information complémentaire 2
information complémentaire 3

Information complémentaire 4

Information complémentaire 5

ont visuakisab

formailai

Support des connexions
sécurisées

Cocher cette case pour forcer |e passage en mode séouriss (sl disponible)

GESTION DES REPONSES

Liste de-questions Publication Gestion des réponses

[ Nettoyer automatiquement les réponses

Méthode de nettoyage Suppression @ Anonymisation

Nombre de jours de o [é
conservation des réponses

L'onglet Gestion des réponses est une interface qui permet de supprimer les données automatiquement au bout d'un
certain temps, notamment pour étre en conformité au regard de la CNIL. Vous pouvez soit les supprimer, soit les anonymiser
en enlevant toutes les données a caractere personnel (nom, prénom).

GERER LES TYPES DE QUESTIONS

L'interface de modification permet de modifier les informations renseignées lors de I'insertion du formulaire et d'administrer
les entrées du formulaire (questions, textes libres et regroupements).

Vous pouvez créer un regroupement qui va permettre visuellement et graphiquement de regrouper certains types de
données. Il vous suffira ensuite de rattacher chaque champ a ce regroupement

Exemple :
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Coordonnées du demandeur (nom du regroupement)

Nom :

Prénom :

Date de naissance :
Adresse :

Code postal

Ville

Pour créer une nouvelle question ou commentaire il suffit de sélectionner dans la liste des champs possibles le type de
champ a insérer et de cliquer sur le bouton Ajouter.

Bouton radio

Caze & cocher
Commentaire

Date

Liste déroulante

Zone de texte court

Zone de texte long

Fichier

Liste déroulante SQL
Géolocalisation

Image

Session

Numérotation

Cases & cocher obligatoires
Attribut de l'utilisateur MyLutece
Tableau

Le champ Bouton radio améne une question a choix unique.

Le champ Case a cocher améne une question a choix multiples.

Le champ Commentaire est un texte permettant de commenter un élément du formulaire.

Le champ Date ameéne une question amenant une réponse sous forme de date exclusivement.

Le champ Liste Déroulante amene une question a choix unique dont les réponses sont représentées sous forme d'une

liste déroulante.

Le champ Zone de texte court amene une question dont la réponse est sous forme de texte tenant sur une ligne.

Le champ Zone de texte long améne une question dont la réponse est sous forme de texte tenant sur deux ou

plusieurs lignes.

e Le champ Fichier permet a un utilisateur de déposer un fichier via le formulaire.

e Le champ Liste déroulante SQL amene une question a choix unique dont les réponses proposées sont le résultat d'une
requéte SQL paramétrable.

e Le champ Géolocalisation améne une question dont la réponse sélectionnée peut étre saisie puis géolocalisée sur une

carte ou étre cliquée sur une carte pour en avoir les coordonnées exactes sous réserve d'avoir activé le module form-

gis.

Le champ Image permet a un utilisateur de déposer une image via le formulaire.

Le champ Session permet de récupérer une information de la session utilisateur a la soumission du formulaire.

Le champ numérotation permet une incrémentation a partir d'un calcul défini par le concepteur du formulaire.

Le champ case a cocher obligatoire identique a case a cocher mais rend la saisie d'une valeur obligatoire.

Le champ attribut de I'utilisateur Mylutece permet de récupérer les informations sur |'utilisateur connecté pour un

formulaire sur un site authentifié.

e Le champ tableau permet d'insérer un tableau dans le formulaire.

GESTION D’UNE QUESTION

La création d'une question s'effectue apres avoir sélectionné le type de champ que I'on veut utiliser.
Lors de la création d'une question, I'interface affichée dépend du type de question sélectionné.

L'interface de saisie suivante récapitule les informations nécessaires a la modification d'une question fermée (radio bouton,
case a cocher, liste déroulante) et permet I'administration des réponses associées.

Les actions possibles concernant les réponses a une question sont :

Déplacement d'une réponse a l'intérieur d'une question
Création d'une réponse

Modification d'une réponse

Suppression d'une réponse

Le déplacement des réponses dans une question se fait en utilisant les fleches bas et haut placées a c6té de chaque réponse.
Les questions conditionnelles créées s'afficheront lors de la sélection de la réponse par le répondant.

Par exemple, celles-ci peuvent étre utilisées pour apporter une précision, poser une nouvelle question induite par la réponse
choisie ou encore de saisir une autre possibilité que celles déja proposées.

Options d'une question de type ouvert (question entrainant une réponse libre)

Dans le cas d’'une question de type Zone de texte court il est possible de demander qu’un ou plusieurs contréles soient
effectués sur le format du texte saisi. Il en existe deux :

e Le champ de confirmation de saisie permettant de créer un deuxiéme champ identique au premier, mais ayant un
intitulé différent permettant de s’assurer de I’exactitude de I'information saisie.
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o Le test de I'unicité de la réponse permettant de vérifier que la réponse est unique pour éviter des répétitions
(doublons) dans les réponses d’une question qui ne doit pas en avoir. Par exemple, pour la création d'un login, il ne
doit pas en exister deux identiques dans la base de données.

Grace a cela, nous évitons des erreurs de saisies éventuelles et augmentons la fiabilité des informations recues.
Actions possibles sur une question

Les actions possibles sur les entrées d'un formulaire (questions, commentaires, regroupement de questions) sont :

Déplacement d'une entrée a I'intérieur d'un formulaire.
Duplication d'une question ou d'un commentaire.
Création d'une nouvelle entrée.

Modification d'une entrée.

Suppression d'une entrée.

Le déplacement des entrées dans le formulaire se fait en utilisant les fleches bas et haut placées a coté de chaque entrée.
Pour grouper des questions il suffit de créer un regroupement en saisissant son libellé puis de déplacer les questions
concernées a l'intérieur de ce dernier.

L'insertion des questions ou des commentaires dans un regroupement se fait en cliquant sur I'icéne correspondante puis en
sélectionnant le regroupement de destinations.

De méme pour sortir une question ou un commentaire d’un regroupement il suffit de cliquer sur I'icone correspondante, la
question se place alors en derniere position dans la liste des questions du formulaire.

GESTION DES PROCESSUS EXTERNES

Par défaut un seul processus externe "notifier I'émetteur du formulaire" est proposé.
¢ Notifier I’émetteur du formulaire

Ce processus externe permet d’envoyer un message pouvant éventuellement contenir un récapitulatif des réponses
fournies a condition d’avoir au préalable prévu un champ dans le formulaire récupérant I’adresse mail de I'émetteur du
questionnaire.

Pour bénéficier d'autres fonctionnalités qui permettent d'étendre le traitement des données saisies d'un formulaire il faut

que I'administrateur du site ait installé les composants nécessaires. On peut citer I'export dans une base de données, la
création d'alertes.

=
Gestion des validateurs d’un formulaire

La gestion des validateurs permet I'attribution de regles régissant la cohésion des réponses dans un formulaire. Il existe
deux types de validateurs (sous réserve que les modules de validateurs soit installés sur la webapp puis activés et ayant un
pool renseigné dans I'onglet Systeme fonction Gestion des Plugins) :

Le validateur de date (le module form-date-validators doit étre installé, activé et avoir un pool défini)
Ce validateur ne peut étre appliqué qu’avec des réponses d'un champ « Date ». Il existe 3 types de régles avec ce validateur
e Comparaison avec une seconde entrée du formulaire : Compare deux champs « Date » |'un par rapport a l'autre.
e Comparaison avec une date de référence : Compare un champ « Date » avec une date de référence.
e Comparaison avec une date calculée : Compare un champ « Date » avec une date calculée.
Le validateur de comparaison (le module form-compare-validators doit étre installé, activé et avoir un pool défini) :
Ce validateur peut étre appliqué avec tous types de champ, il consiste a comparer deux champs et donne 2 types
d'opérateur :

e Egal a « = » : Oblige & avoir la méme réponse dans les deux champs.
o Différent de « != » : Oblige a avoir une réponse différente par champ.
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13. CONSULTER ET DIFFUSER LES RESULTATS DU FORMULAIRE

Les données des enquétes, sondages, formulaires sont consultables de deux fagons différentes :

e |'un tres simple permettant I'export des résultats dans un format CSV
e un second plus complexe qui permet de faire un traitement plus avancé des demandes, d'envoyer un mail

personnalisé au participant pour I'informer de I'avancement de sa demande ou de la publication des résultats de
I'enquéte.

CONSULTATION DES RESULTATS

Il est possible de consulter les résultats des formulaires depuis I'outil dédié ou I'annuaire (plugin directory). Pour accéder aux

résultats de votre enquéte ou sondage depuis I'outil formulaire, cliquez sur le bouton export du formulaire dans le back-
office :

Gestion des formulaires © aide

Liste des formulaires Statut| Toss [+] Groupe d'utlisatenr <ton ssgnésungrovper [2] Qs
Nombre par page| 50 || ¢ -Mombred'éléments:3

Titre A v Période de disponibilité Actions

2] votants physiques campagne budgst participatif 2015 @ G |=]m] BEaEE

B qui etesvous 7@ (G| =[] Consulter les réponses |
mQu'ahentfez vousd'un CMSopen-source?Q EEDEE E

- Momibre d'éléments : 3

Vous accédez a l'interface suivante, cliquer ensuite sur Exporter pour obtenir un fichier de type excel, format CSV, contenant
les données.

Gestion des formulaires consuita

O Aide
réponses du formulaire : 'Votants physiques campagne budget participatif 2015'
Date de validation comprise satre fif et fiff Graphique du nombre réponses @ par jour par semalne par muls
Statistiquede fréquentation Exporter les résultats au format. o=y w
L0
& Nombre de réponses 1
_!f L
) Date de la premiére réponse 06/08(2015 T ey .-.'..awu sk Ina Dask b Daed
[ Date de la derniére réponse  06/08/2015

Dans le chapitre précédent, vous avez appris qu'il était possible de préparer le site pour que les informations saisies dans un
formulaire soient exportées automatiquement vers un annuaire permettant de les consulter, de les modifier ou de les
supprimer.

Une fois I'annuaire créé via le module d'export dans I'outil de formulaire, vous pouvez y accéder depuis le plugin directory, a
partir du menu Gestion des annuaires.

Gestion dela cartographie

Gestion des formulaires

O Ade
Gestion des réseaux sociaux
Liste des formulaires Statt| -+ Gesvondesformiares owper[] Qe
Gestion des workflows
Nombre parpage| 51 |=] ¢ -Mombred'dhéments:3
Titre A Période de disponibilité Actions
[EJ votants physiques campagne budget participatif 2015 @ BEQEEaRER
B qui etesvous 7@ CELEEEREE
[EJ av'attendez vous d'un CMS open-source ? @ (=|m|=]|[o]A]&

-Hombre d'éléments: 3

Puis en cliquant sur le bouton d'action n présent sur la ligne de votre annuaire.
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Gestion des annuaires cestion des annuaires 8 ade

Statut -Tous- ~ Groupe d'utilisatewr ! <Mon zssigné 3 un groupes -

Nombre parpage| 50 |=| C - Nombred'@éments: 2

Titre A w Actions

n Votants physiques campagne budget participatif 2015 @ E % n n
Qu'attendez vous d'un CMS open-source 1 @ E Eir:r les fiches n n
-

- Nombre d'éléments : 2

Vous accéderez a l'interface suivante :

Gestion des annuaires session des fiches ; Bt
Votants physiques campagne budget participatif 2015 unn Export C5V = @ na
Recherche Exporter tout

e
Nom
Amrondissement  “AUIUNE valeurs -

Type d'umes) Fixe
Mobile

Hombere par page| 50 [=| ¢ - Nombre d'@léments: L

Hom Arrondissement Type d'umne Kombre de personnes ayant voté b de votants pour tout Paris
N A w A e o aw AW Actions
1 Lemaire Zeme Eixe 150 109 BaEoan

- M brs ol dldersnie « §

VISUALISER LES DEMANDES DANS L'ANNUAIRE
Vous pouvez accéder aux données de votre annuaire en cliquant sur le bouton d'action.
Cette interface d’administration se compose de trois blocs :

e Le premier bloc contient le formulaire de recherche. Les champs présents dans ce formulaire ont été sélectionnés
comme faisant partie de la recherche. Ce formulaire permet de filtrer la liste des fiches de I'annuaire

e Le deuxieme bloc contient les fiches de I'annuaire résultats de la recherche. Les champs a afficher pour chaque fiche
ont été sélectionnés comme faisant partie de la liste des résultats. Les fiches de I'annuaire affichées sont triées par
date de création, du plus ancien au plus récent

o Le dernier bloc permet d’exporter les fiches de I’annuaire. Il est possible d’exporter I'ensemble des fiches ou le résultat
d’une recherche. Les formats disponibles pour I'export des fiches peuvent étre administrés dans le menu.

RECHERCHE DE DEMANDES

Il est possible de réaliser une recherche sur les demandes selon plusieurs critéres pouvant étre combinés. Ces criteres mis a
disposition de I'utilisateur sont définis et configurés par I'administrateur.

EXPORTER LES DEMANDES
Cliquer sur le bouton exporter tout pour exporter toutes les données ou uniqguement le résultat de votre recherche.

CONSULTER UNE DEMANDE

Pour consulter une demande, et donc recueillir les informations saisies par I'usager, il suffit de cliquer sur I'icone n
Les différentes actions pouvant étre effectuées sur les fiches de I’annuaire sont :

Création d’une fiche.

Modification d’une fiche.

Duplication d’une fiche.

Suppression d’une fiche.
Activation/Désactivation d’une fiche.
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POUR ALLER PLUS LOIN... LA MODIFICATION D'UN ANNUAIRE

Sans entrer dans les détails, il peut étre nécessaire de modifier la structure de I'annuaire pour optimiser les traitements sur
les fiches. Afin de permettre par exemple :

de modifier le tableau d'affichage des données pour qu'il soit plus lisible, rajouter des champs manquants ;
d'ajouter une date de création pour chacun des enregistrements ;

de faire apparaitre I'historique ;

de paramétrer I'historique des traitements effectués sur chaque fiche ;

de modifier la recherche et de faire apparaitre une recherche avancée ;

de modifier le libellé d'un champ ou sa présence dans la fiche de résultat.

LES ACTIONS POSSIBLES SUR UN ANNUAIRE

Les boutons d'action présents sur la ligne de chaque annuaire permettent d'effectuer les actions suivantes. Leur affichage
dépend des réles qui sont attribués a chaque utilisateur.

Modifier I'annuaire
Gestion des fiches de I'annuaire

Importer des fiches

Supprimer I'ensemble des fiches de
I'annuaire

Activer

Dupliquer I'annuaire

wfo]fofofe]a

Supprimer l'annuaire
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14. PRISE DE RENDEZ-VOUS USAGER

Lutece fournit un ensemble de fonctionnalités assurant la gestion de prise de rendez-vous par des internautes. Il est ainsi
possible pour |'utilisateur du service de configurer divers créneaux de rendez-vous au sein d'un agenda, et pour I'internaute
de réserver a son nom un ou plusieurs créneaux.

La gestion de rendez-vous peut répondre a plusieurs usages et besoins métier, parmi lesquels :

e Permettre aux clients d'une société d'électroménager de prendre rendez-vous avec un réparateur.

e Permettre aux usagers d'une collectivité de prendre rendez-vous avec les services municipaux (état civil, obtention de
cartes de stationnement, dépét de permis de construire, vaccination et autres traitements médicaux.).

e Permettre aux employés d'une société de s'inscrire aux différentes sessions de formation organisées par I'entreprise.

Chaque type de rendez-vous est associé a un formulaire, via lequel il est possible de configurer entre-autre :

Les jours de la semaine sur lesquels les créneaux sont ouverts (lundi, mardi, etc.).

Les horaires minimum et maximum par jour.

La durée d'un créneau, exprimé en minutes.

Le nombre de rendez-vous (ou disponibilités) pouvant étre réservés a chaque horaire de créneau.

Un éventuel workflow de gestion des rendez-vous, permettant par exemple au service mettant en place le systéme de
valider ou refuser des prises de rendez-vous, ou encore d'affecter le rendez-vous a une ressource (agent, guichet, etc.).
o Etc.

L'OUTIL DE RENDEZ-VOUS VU PAR L'INTERNAUTE (VISION DITE FRONT-OFFICE)

Plusieurs types de rendez-vous pouvant étre paramétrés au sein d'une méme application Lutece, lorsque I'internaute
accede au service de gestion de rendez-vous, il est dans un premier temps invité a choisir le formulaire auquel il souhaite
accéder :

STATIONNEMENT RESIDENTIEL, STATIONNEMENT PROFESSIONNEL,

PRENEZ RENDEZ-VOUS POUR PRENEZ RENDEZ-VOUS POUR
OBTENIR VOTRE CARTE EFFECTUER VOTRE DEMANDE

Le service de rendez-vous affiche un calendrier a I'internaute présentant les créneaux horaires disponibles ou réservés, sur
une semaine. Plusieurs types de calendrier sont disponibles. L'utilisateur pourra choisir celui correspondant a ses attentes :

o affichage de tous les créneaux qui restent disponibles ou non,
o affichage en grisé,
e pas d'affichage des créneaux non réservables.
L'affichage suivant ne présente par exemple que les créneaux pour lesquels une réservation est encore possible :

LUNDI MARDI MERCREDI JEUDI VENDREDI SAMEDI DIMANCHE
20/04/2015 21/04/2015 22/04/2015 23/04/2015 24/04/2015 25/04/2015 26/04/2015

09h00 = Réserver
- K

09h30 Réserver

~—— —
10h00 § ] Réserver }

10h30 Réserver 10h30 - 11h00

-

L'internaute dispose de boutons lui permettant d'afficher les créneaux de la semaine suivante ou de la semaine précédente,
et d'un mini-calendrier (appelé également date picker) lui permettant de choisir une semaine précise :

« Avril 2015 »
L MaMe J V § D

L'internaute peut alors décider de réserver un créneau. Il est alors dirigé vers un formulaire de maniere a ce qu'il puisse
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décliner son nom et son prénom, ainsi que son adresse email. La saisie de cette derniére est fortement souhaitable, car elle
lui permettra de recevoir une confirmation de la prise de rendez-vous qu'il aura effectuée ainsi que le moyen d'annuler son
rendez-vous.

Des champs de saisie supplémentaires peuvent étre paramétrés par I'utilisateur. Ces champs seront en général voués a
préciser soit des informations complémentaires sur |'internaute (personne privée ou morale, adresse postale, numéro de
téléphone ou de fax...), soit des précisions quant a sa prise de rendez-vous (objet précis du rendez-vous, observations
diverses).

Objet du rendez-vous *

® Je souhaite obtenir une carte de stationnement résidentiel

® Je souhaite obtenir une carte basse émission (véhicules électriques, au gaz naturel et
hybrides rechargeables)

O Je souhaite obtenir une carte de stationnement résidentiel et une carte basse émission

stationnement résidentiel véhicules basse émission

En cochant cette case, j'accepte d'étre contacté par la Mairie de Paris dans le cadre
d'enquétes de satisfaction

B J'accepte

Aprés saisie des renseignements requis pour la prise de rendez-vous, une page de résumé reprenant I'ensemble des données
saisies par l'internaute est affichée, et ce dernier est invité a valider sa demande.

Selon le paramétrage de formulaire de rendez-vous effectué par I'utilisateur, I'internaute peut recevoir un courriel
reprécisant les principales informations concernant son rendez-vous, ainsi qu'un lien Internet cliquable lui permettant
d'annuler sa prise de rendez-vous.

Madame, Monsieur,
Nous vous confirmons votre rendez-vous du 05/08/2015 a 09h15.

Vous pouvez annuler si vous le souhaitez votre rendez-vous, en cliquant sur ce lien.

Cordialement,
Votre bienveillant conseiller bancaire

CONFIRMATION DE VOTRE ANNULA’

Date du rendez-vous

05/08/15

CREATION ET PARAMETRAGE D'UN FORMULAIRE PAR L'UTILISATEUR (VISION DITE BACK-
OFFICE)

Nous allons expliciter dans un premier temps comment paramétrer un formulaire simple. Nous lui associerons par la suite un
workflow de maniére a permettre aux utilisateurs métier accédant a I'application de valider ou refuser une prise de rendez-
vous, et d'indiquer qu'un rendez-vous a été honoré ou non par l'internaute.

Le paramétrage d'un formulaire de rendez-vous est réalisé sur I'espace d'administration de Lutece, appelé plus
généralement back-office. Le menu du back-office donne accés aux pages d'administration des formulaires de rendez-vous :

Applications ~

Gestion des workflows
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Gestion des rendez-vous

Gestion des modéles de calendrier

Title Actions
EJ Formulaire non active BEOoBRaEE
[E)) stationnement professionnel, prenez rendez-vous pour effectuer votre demande Q@ (o [@]m] @]

a Stationnement résidentiel, prenez rendez-vous pour obtenir votre carte Q D nn
Nombre d'éléments: 3

La liste des formulaires y est présentée, avec pour chaque formulaire :

e Une icéne indiquant si le formulaire est activé (icone verte) ou non (icone rouge).
e Le nom du formulaire tel qu'il sera affiché a l'internaute.
e Pour les formulaires actifs, une icone représentant le globe terrestre et permettant d'accéder au formulaire en page
front-office (tel que vu par les internautes).
e Cing boutons d'action :
o Modification des parametres.
Gestion des messages affichés aux internautes.
Visualisation du calendrier des rendez-vous réservés.
Activation / désactivation du formulaire.
Suppression du formulaire.

0o o o o

L'utilisateur dispose également d'un bouton lui permettant de créer un nouveau formulaire :

CREATION D'UN FORMULAIRE DE RENDEZ-VOUS SIMPLE

Afin de créer un nouveau formulaire, appuyez sur le bouton Créer un formulaire. Le formulaire créé sera par défaut désactivé,
de maniére a n'étre rendu visible aux internautes qu'aprés complet paramétrage. La création d'un nouveau formulaire se
poursuit par la saisie des données suivantes :

Titre du formulaire, tel qu'il sera affiché aux internautes.

Description du formulaire, non visible par les internautes.

Heures de début et de fin des rendez-vous, horaire de fin du dernier créneau inclus. Exemple : 09h00, 16h30.

Durée des rendez-vous, exprimé en minutes. Ainsi si I'horaire de fin des rendez-vous est 16h30 et que la durée des
créneaux est 15mn, alors le dernier créneau réservable aura pour horaire 16h15.

e Délai minimum de prise de rendez-vous, exprimés en heure. Ce délai coure entre I'heure a laquelle I'internaute accede
au service de rendez-vous, et I'heure du premier créneau qu'il pourra réserver. Ce délai de prévenance peut permettre
par exemple d'éviter qu'un internaute ne réserve un rendez-vous pour le jour méme, de facon a ce que le service
métier puisse organiser sa journée de réception.

Date de début et de fin de validité du formulaire, permettant de planifier la disponibilité du formulaire aux usagers.
Autoriser un internaute a annuler son rendez-vous

Nombre de semaines affichées aux utilisateurs.

Nombre de rendez-vous simultanés pouvant étre réservés sur un méme créneau.

Préfixe ajouté aux numéros de référence des rendez-vous fournis aux internautes.

Nombre maximum de rendez-vous pouvant étre pris par un internaute dans une période donnée, permettant d'éviter
qu'un internaute ne prenne plusieurs rendez-vous dans un délai trop court, voire qu'un virus de type "robot" ne bloque
automatiquement tous les créneaux. A noter que la gestion des doublons de rendez-vous se base exclusivement sur
I'adresse email de I'internaute.

Jours d'ouverture.

Affichage du formulaire de saisie en priorité, avec affichage du calendrier des créneaux dans un second temps.
Eventuel workflow associé.

Modeéle de calendrier, permettant de modifier la représentation graphique fournie a I'internaute.

Activation d'un captcha permettant d'éviter toute réservation en masse des créneaux par un systéme externe
malveillant.

PARAMETRAGE PRECIS DES CRENEAUX

Il est possible de paramétrer spécifiquement chaque horaire de créneau : ouverture/fermeture, nombre de disponibilités. Il
est ainsi possible de gérer les spécificités de planning du service métier concerné, les horaires de repas, la charge des
rendez-vous en fonction de I'horaire, etc.

Jours d'ouverture Créneaux d'ouverture

Créneaux d'ouverture

Lundi Mardi Mercredi Jeudi Vendredi samedi Dimanche

oo EEJc $EEc (@ E Eme B3 =
o0 EE@C @ @B B @ @B &3
osnao @ (over 2 En @\
osh3o  Ferms W | ouvert Nl 09h30- 05h40 - | ouver: e e Ferme
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PARAMETRAGE EXCEPTIONNEL PAR DATE

Il est également possible de réaliser un paramétrage exceptionnel date par date, en agissant sur I'ouverture/fermeture, les

horaires, le nombre de disponibilités, de facon a gérer par exemple les congés des employés du service, les jours fériés, etc.

Formulaire de rendez-vous Jours d'ouverture Créneaux d'ouverture Gestion des ressources

Date Ouvert Action

10/08/2015 (O |
11/08/2015 (O |
12/08/2015 B8
13/08/2015 B
14/08/2015 (O |
15/08/2015 B

16/08/2015 B

Le paramétrage d'un jour d'ouverture donne acces a |'écran suivant :
Madifier une ouverture ou fermeture exceptionnelle : '11/08/2015"
Date *: 11/08/2015

Ouvert * : s
Cocher cette case si ce jour est une ouverture exceptionnelle. Ne pas cocher 5'il s'agit d'une fermeture exceptionnelle,

Heure de début des rendez-vous * @ 10h00

Horaire quotidien de début de prise de rendez-vous (HHhMM)

Heure de fin des rendez-vous *: 12000

Heraire quotidien de fin de prise de rendez-vous [HHhMM)

Durée moyenne des rendez-vous * : 0

Nombre de rendez-vous simultanés * : | 4

AJOUT DE CHAMPS DE SAISIE

Afin d'enrichir le formulaire de saisie de données et permettre au service métier de bénéficier de toutes les informations
nécessaires au bon déroulement du rendez-vous, il est possible d'ajouter un ou plusieurs champs de saisie.

Objet du rendez-vous

® Check-up général

® Vaccination

® Radiologie
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Autre
Merci de préciser

Demande de traitement en

Ces données sont accessibles au service métier via le back-office d'administration :
Objet du rendez-vous

[ Check-up général
[[J Vaccination
[J Radiologie

[ Autre
Merci de préciser

Demande de traitement en khinésithérapie

Coordonnées de votre médecin traitant

Mme Duval Renée, 30 rue de Vaugirard, Paris

=» Valider et changer la date du rendez-vous

® Retour

AJOUT D'UN WORKFLOW

Par défaut, le module de gestion de rendez-vous fournit un workflow minimal de gestion de rendez-vous. A chaque rendez-
vous est associé un statut. Celui-ci est positionné a "réservé" lorsque la prise de rendez-vous est effectuée par I'internaute,
et a "non réservé" lorsque l'internaute ou I'administrateur annule le rendez-vous.

Néanmoins certains besoins fonctionnels peuvent nécessiter la mise en place de procédures de gestion enrichies. Il est pour
ce faire possible de brancher un workflow sur un formulaire de rendez-vous, de maniéere a associer des états aux rendez-
vous et des actions et taches a chaque changement d'état.

Pour associer un workflow a un formulaire, il convient :

e Dans un premier temps de créer un workflow et de le paramétrer en tout ou partie. Pour de plus amples informations,
le lecteur est invité a se reporter au chapitre traitant de la création d'un workflow.

Applications « Uti

Gestion des rendez-vous

Gestion des modéles de calendrier

e Dans un second temps, d'associer ce workflow au formulaire dans I'écran de paramétrage des formulaires :

[CJ Affichage formulaire priorité

Workflow :

ROV SSVP professionnel avec validation automatique - NEW

RDV SSVP résidentiel avec validation automatique - NEW

[CJ Activer le captcha

«  Modifier @ Annuler

AJOUT DE RESSOURCES

Il est également possible d'utiliser, conjointement avec le module de gestion de workflow, celui de gestion des ressources
afin de permettre d'associer a chaque rendez-vous une ressource pouvant étre un agent de réception, un guichet, une salle,
etc.

Pour ce faire, il convient :
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e Dans un premier temps de créer les ressources concernées. Pour plus d'informations, le lecteur est invité a se reporter
au chapitre concernant la création de ressources sous Lutece.

Contenu ~ Site = Applications ~ Utilisateurs ~

Gestion des ressources

Statistiques PIWIK

e Dans un second temps d'associer un workflow au formulaire, lequel workflow devra contenir une tache d'affectation de
ressource permettant a I'administrateur d'associer a chaque rendez-vous une ou plusieurs ressources :

Affecter une ressource a un rendez-vous

Formulaire de rendez-vous
Prise de rendez-vous en cabinet médical v

2 Actualiser

Type de ressource :

‘ Medecin r

#| Champ obligatoire

+ Enregistrer ® annuler

QUELQUES PRECONISATIONS

Il est conseillé, dans la limite des nécessités du service métier, de laisser aux internautes la visualisation qu'un nombre
limité de semaines. L'expérience montre que les prises de rendez-vous sont faites sur la semaine méme ou la semaine
suivante. Cette préconisation permet a I'administrateur fonctionnel de pouvoir agir sur le nombre de créneaux et les
ouvertures / fermetures des semaines non visibles ; il est en effet impossible de modifier ou supprimer un créneau si celui-ci
a déja fait I'objet d'une ou plusieurs prises de rendez-vous.

Il est d'autre part préconisé d'éviter des durées de créneaux inférieures a 10 voire 15 minutes, quitte a agréger les rendez-
Vvous : ainsi peut-il étre préférable de paramétrer des créneaux de 15 minutes avec 6 disponibilités plutét que des créneaux
de 5 minutes avec 2 disponibilités. Premiérement il ne sera présenté a l'internaute qu'un nombre raisonnable de propositions
d'horaire, deuxiémement cette mécanique permet de lisser la charge des rendez-vous aupres des agents de réception
lorsque les internautes se présentent en retard.
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FAIRE PARTICIPER LE PUBLIC

15. CREER UN ESPACE PARTICIPATIF
16. CREER UNE ENQUETE
17. PARAMETRER LES EXTENSIONS
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15. CREER UN ESPACE PARTICIPATIF

Demander a la population de donner son avis, de proposer, de commenter un sujet que la municipalité souhaite mettre en
avant est devenu un moment incontournable de la vie de la cité : le participatif est partout.

Pour répondre a ce besoin, Lutece propose le plugin Digg qui va permettre de créer une page ou les internautes pourront
poser des questions, réagir en commentant ou en notant sur quelque sujet que ce soit. Il y a de nombreuses questions qui
peuvent ainsi étre soulevées. On pourra en particulier se référer a_https://budgetparticipatif.paris.fr/ pour des exemples a
grande échelle.

CREER UN ESPACE PARTICIPATIF EN UTILISANT DIGG

Prenons un exemple, la collectivité souhaite recueillir I'avis de la population sur un projet de réaménagement. La demande

une fois formulée, le webmestre de la collectivité va alors utiliser le plugin Digg, qu'il retrouvera dans I'administration du
site dans le menu Application > Gestion des diggs.

L'interface de gestion des diggs récapitule les actions pouvant étre effectuées sur un digg en fonction des roles de
I'utilisateur.

g Gestion des diggs 6

Liste des diggs @ Paramelres avances

Statut -Tous- [+]| Groupe dutiisateur| <Hon assigne a un groupe> =
s0fx & -6
Titre Statut Actions
Copie du digg Rythmes éducatifs @ ﬂ n n
Rythmes éducalifs @ Bnn
Votre avis sur la bibliothéque Marguerite Audoux @ B n n
Votre avis sur la bibliothégue Couronnes @ (x| B n n
Votre ado face au monde virtuel | Et vous, vous en &es ol ? @ [ x | E n n
0 DBDo0a

CREER D’UN DIGG
Pour créer le digg, il suffit de cliquer sur I'icéne qui se trouve sur la page de gestion des diggs.
La création d'un digg comporte 6 étapes nécessaires, et 3 facultatives :

. Général

. Présentation

. Autorisation

. Notification
Parameétres avancés
Enregistrement
(Champs)

. (Catégorie)

. (Type de proposition)

CONOUIAWNK

Les trois derniéres colonnes ne sont accessibles qu’aprés la création d’un digg.
GENERAL

Dans cette partie, on renseigne les informations générales du digg.
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Gestion des diggs

o
m
L=]

Général Présentation Autorisation Notification

Titre *

Titre court qui décrit le digg.

Titre de la contribution ™

Titre de la contribution

Libellé du bouton de validation *

Nombre de caractéres de la proposition *

E0D

Nombre de caractéres de la proposition affichées dans la liste des propositions du digg.

Méthode de vote
Vote

Permet de définir la méthode de vote.

Désactiver les votes Supprime le systéme de vote sur les propositions du Digg

Autoriser les commentaires Permet de spécifier si les commentaires sont autorisés,

Message d'indisponibilité *

Paramétres avancées

Fichier -  Editer - Insérer - Voir ~  Format - Tableau - Qutilz -
B Fomats~- B J A~ A- E E = E
ST e E E |G L = s s 3 oo
P Mots : O

" Enregistrer @Appliq uer @ annuler

e Le titre : Ce champ est obligatoire, il permet d’identifier un digg parmi I’ensemble des diggs listés dans 'interface

d’administration.

o Le titre de la contribution : Ce champ est obligatoire, il permet d’identifier un digg parmi I'’ensemble des diggs listés

dans l'interface d’administration.

o Le libellé du bouton de validation : Ce champ est obligatoire, c’est le nom que portera le bouton de validation.
¢ Le nombre de caracteres de la proposition : Ce champ est obligatoire, c’est le nombre de caracteres de la

proposition affichée dans la liste des propositions du digg.

¢ La méthode de vote : C’est la fagon de voter qui permet dans un cas de s’exprimer sur un choix, dans 'autre de

noter a I'aide d’étoiles.

La désactivation des votes ou non
L'autorisation des commentaires ou non
Le message d’indisponibilité

La description du digg

Une fois que ces champs sont renseignés, il faut valider en cliquant sur Enregistrer ou Appliquer.

Trois nouveaux onglets apparaissent alors :
o Champs

o Catégories
e Type de propositions

Gestion des diggs medication dunaigg

Boite a idées

Champs Catégories Type de proposition Géndral
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Insérer un champ L lm] Hspmetar
Titre Type Actions

Votre proposition Zone de texte long uﬂ

CHAMPS

L'onglet Champs permettra de créer I'interface que I'utilisateur va rencontrer une fois qu’il aura fait une proposition sur le
Front Office.

L’administrateur peut ajouter des champs de types :

Zone de texte court

Zone de texte long

Url

Image

Vidéo

Editeur Bbcode (Bulletin Board Code) qui permet la mise en page en front Office sans utiliser le langage HTML.

CATEGORIES

Ce paramétre offre la possibilité a I'utilisateur de classer ses propositions dans des catégories pour une meilleure
ergonomie. Pour ajouter une catégorie, il faut la sélectionner dans la liste déroulante et la valider. L'administrateur peut
supprimer la catégorie.

Type de propositions

Ce parametre offre la possibilité a I'utilisateur de s’identifier professionnellement sur son type de métier. Pour ajouter une
catégorie, il faut la sélectionner dans la liste déroulante et la valider. L'administrateur peut supprimer la catégorie.

Présentation

Cet onglet permet de gérer la présentation du digg. Il s’agira d’agir sur les informations qui s’afficheront dans la page des
diggs ainsi que sur la facon dont elles s’afficheront. Par exemple, on pourra décider du nombre de propositions par page ou
de mettre en avant les propositions les plus actives (exemple de résultat dans Accéder aux propositions). Les possibilités
sont les suivantes :

Activer ou non la pagination de la page

Gérer le nombre de propositions affichées par page

Choisir ce que I'on veut afficher en bloc (Catégorie/Top popularité/Top commenté)
Gérer le nombre de propositions dans « Top score »

Gérer le nombre de propositions dans « Top comment »

Trier par défaut les propositions (date/score/nombre de commentaire/manuel/vues)
Choisir le theme de la xpage

Gérer le nombre de commentaires a afficher par proposition

Gérer le nombre de caracteres a afficher par commentaire

Gérer le contenu du chapeau du digg

Gérer le contenu de message de confirmation

Gérer les conditions d'utilisation
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Présentation Autorisation No

Paramétres avancées

Activer la pagination

Nbr de propositions affichées par page

Nombre de propositions affichées par page si la pagination est activée
Afficher les blocs

' Catégories

+' Top popularité

Nombre de propositions dans "Top score'

+' Top commenté

Nombre de propositions dans "Top comment'

Permet de spécifier les blocs & afficher coté front office

Afficher les commentaires dans la liste des propositions

Nembre de commentaires a afficher par proposition

Nombre de caractéres a afficher par commentaire

Autorisation

Cet onglet permet de gérer les autorisations du digg. Selon les cas, objectif ou public concerné, il faudra changer ces
autorisations. On peut :

82

Affecter un groupe de travail au digg : pour limiter le champ d’application a certaines personnes identifiées et
classées sur la plateforme.

Restreindre I’accés aux personnes ayant un acces au Back-Office grace a des réles.

Modérer les propositions : le webmestre devra valider les propositions et éviter ainsi que le site soit pollué par des
propositions farfelues voire des messages inadéquats.

Modérer les commentaires : dans le cas ou les commentaires sont autorisés, et a plus forte raison si I'utilisateur peut
faire des propositions, il convient parfois de pouvoir contréler les contenus des messages pour éviter les
commentaires déplacés, par exemple.

Activer ou non les signalements.

Activer ou non les conditions d’utilisation.

Limiter le nombre de vote : cette fonction a évidemment un intérét pour éviter qu’un groupe d'utilisateur ne fasse
pression sur une proposition en votant plusieurs fois, bafouant les regles essentielles de la démocratie. Ce systéme ne
saurait étre 100% efficace, mais permet un premier contrdle.

Requiert authentification : ajouter une demande d’authentification pour créer, voter ou commenter. Cela permet
éventuellement de responsabiliser le participant, de le fidéliser, ou simplement de garder son contact pour prendre
rendez-vous avec lui sur le sujet.



Champs Catégories Type de propositions Général Présentation Autorisation Notification Parameétres avancées

Groupe de travail

<Non assigné & un groupe= ¥ | Permet de restreindre |'administration du digg & un groupe de travail.

Accés restreint au réle

Wiki Administrator (can remaove content) ¥ | Permet de restreindre ['accés & un digg & partir du réle sélectionné

v Modérer les propositions

Permet au webmestre de contréler la saisie d'une proposition avant de l'afficher.

Modérer les commentaires

Permet au webmestre de controler la saisie d'un commentaire avant de |'afficher.

' Activer les signalements

Permetre aux utilisateurs de signaler des propositions

Activer les conditions d'utilisation

Force 'utilisateur & accepter les conditions d'utilisation avant de poster une proposition

' Limiter le nombre de vote

Permet d'éviter qu'un utilisateur vote plusieurs fois sur la méme proposition.
Requiert une authentification

réation vote commentaire Permet de spécifier si la soumission, le vote ou le dépot d'un commentaire requiert une authentification.
P P q

+ Enregistrer @Appliq Tl ®annuler

Certaines de ces options sont reliées a des champs qui ont été activés par ailleurs, comme |'option Autoriser les
commentaires de I'onglet Général.

Notification

Cet onglet permet de gérer les notifications du digg. Elles permettent d’ajouter des options permettant de tenir informés les
votants sur I'évolution de la démarche ou des votes. On peut ainsi :

o Notifier une personne s’il y a des nouvelles propositions.
o Notifier une personne s’il y a des nouveaux commentaires.
o Notifier une personne s’il y a des nouveaux signalements.

Pour savoir qui sera le destinataire de I’email, il faut le sélectionner dans la liste déroulante et choisir le contact ou la liste de
diffusion. Le contenu des messages de notification est personnalisable, avec une structure de base fournie.

Parameétres avancés

Cet onglet permet de gérer les parameétres avancés du digg, on peut :
e Ajouter une image qui représente le digg.
e Gérer la durée maximum d’une proposition sans vote.
e Ajouter un éditeur de bbcode pour les commentaires.
MODIFICATION D’UN DIGG

Aprés la création d’'un digg, il est possible de le modifier en cliquant sur sur la page de gestion des diggs.

Les boutons d'actions présents sur chaque ligne d'un digg permettent de modifier un digg existant. Ces boutons d'actions
sont fonction des réles attribués |'utilisateur.

Sur cette interface on peut gérer des diggs, via les boutons d'actions suivants :

Modifier un digg

Gérer les propositions d'un digg
Activer/désactiver un digg
Dupliquer un digg

Supprimer un digg

Mettre a jour I'affichage des propositions d'un
digg

poonAn

83



GERER LES PROPOSITIONS

Avec I'onglet de la liste des propositions, on peut :

e Actions (Activer ou désactiver les votes/Activer ou désactiver les commentaires/Punaiser ou dépunaiser les

propositions/Catégorie
e Ajouter une proposition
e Exporter la liste des propositions

Avec I'onglet de gestion de I'ordre des propositions, on peut changer I'ordre des propositions.

Parameétres avancés

Sur I'interface de gestion des diggs, il est possible de modifier les parametres avancés du plugin, dans le but d’avoir des
parametres avancés prédéfinis pour les diggs créés. Pour accéder a cette fonction, il faut cliquer sur le bouton (encadré en

rouge)

ACCEDER AUX PROPOSITIONS

L'utilisateur a partir du site de la collectivité va pouvoir accéder aux débats et visualiser I'ensemble des propositions.

Des valeurs a vivre

Contribution libre

=]

Godt de l'sxigence

Trier par: | Tous

=]

1 2 @ Suivant

=

ombre de suggestions trouvées : 20 Résultats - 1 - 10

Parce gue nos valeurs font notre
valeur, n...

8 22 juin 2012 12:12:41 |

Commentsires) | [Eritlr ot

Parce que nos valeurs font notre valeur, nous avons intérét a
les faire connaitre !

Lire la suite =

Les valeurs ne sont-elles pas a
penser com...

£ 22 juin 2012 14:19:.05 | &
Commentaire(s) |
Les valeurs ne sont-elles pas 3 penser comme se complétant ?
Le goit de 'exigence en matiére de solidarite, 'audace dans
I'suwerture, la solidarité dans l'audauce ...

Lire la suite =

A partir de cet écran I'utilisateur peut, faire une recherche, trier les propositions par catégorie, date de publications, voir les
plus commentés, les plus vues et directement voter, commenter, s'abonner (nécessite une authentification) ou signaler des

contenus inappropriés.

VOIR LE DETAIL D'UNE PROPOSITION

En cliquant sur le libellé d'une proposition ou le "lire la suite..." on peut afficher le détail de la proposition et les

Ouverture

X S'sbonner sux propositions

Solidarite

# Faire une proposition

Rechercher

Les valeurs ne sont-elles pas &
pENsEr o,

Parce gue nos valeurs font
nofre valeur,...

Bienveillance.

Top popularité

Réaffirmer gue la Ville sssure
LN SEMVIc..

Le service public peut &tre le
liesudel..

Les plus commentés

Jimagine bien évidemment
gue toute orit...

Les valeurs ne sont-elles pas &
DEnser c..

Comment articuler valeurs de
la Wille et. .

La bienveillance 3 'sgard des
ussgers

commentaires associés dans leur intégralité. On pourra aussi voter, commenter ou s'abonner.
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Parce que nos valeurs font notre valeur, Rechercher

nous avons intérét & les faire connaitre | n
& S'sbonner & cette proposition m Score 2 TOD DDDU|Eirité

B8 22 juin 2012 12:12:41

Les vsleurs ne sont-elles pas &
D'accard DENSEr C..
Parce que nos wvaleurs font notre waleur, nous a A les

faire connaitre !

Parce que nos valeurs font
notre valeur,...

NoUE valeur,...

3 Commentaire(s)

Bienveillance.

AJOULEr Un commentaire Réaffirmer que Is Ville sssure

Le service public peut étre le
lieudel. .

® Ajouter un commentaire

Les plus commentés
B4 28/06/2012 11.69:29

Jimagine bien évidemment
que toute orit...

Les valeurs ne sont-elles pas &
DENSET C...

Comment articuler valeurs de
Iz Ville et .

Ls bienveillance & I'égard des
usagers

O Répondre a ce commentaire

gue valent les valeurs au
guotidien 7

£ 25/06/2012 18:03.05

0 Répondre a ce commentaire

&3 228/06/2012 11:07:42

Pour information, le vote peut se paramétrer en échelle de valeurs, comme dans la copie d'écran ci-dessus soit en D'accords
/ Pas d'accord voir ci-dessous.

Bonjour,il faut a mon humble avis
revoir |...

B3 11 janv. 2015 13:32:30 | ® 10 Commentaire(s) | . o

Score 9

Bonjour,il faut @ mon humble avis revoir les critéres d’embauche,et
aussi faire des avancements de carriére aux agents compétents.

DPE

Lire la suite >

LAISSER L’UTILISATEUR CREER UNE PROPOSITION

Pour participer I'utilisateur peut lui aussi créer sa proposition sur laquelle les autres participants pourront voter ou réagir en
utilisant le bouton Faire une proposition situé au-dessus des blocs Top.

Faire une suggestion Top popularité

Contribution libre : Les valeurs ne sont-elles pas &

PENSErGC..

Parce gue nos valeurs font
notre valeur,..

Guelles Bignveillance.
actionsiguels
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comportements
illustrent au mieux
les waleurs
Proposees :

Que pourrait-on
faire de plus/de
mieux dans nos
pratiques internes
pour faire vivre les
waleurs proposees

Categorie *

Si plusieurs catégories peuvent étre associées a la proposition, il sera nécessaire d'en choisir une avant de la valider. Si le

Veuillez sélectionner une catégorie

Reaffirmer gue |a Ville sssure
LN SEMVIC..

Le service public peut &tre e
ieude [

Les plus commentés

Jimagine bien evidemment
gue foute ont...

Les vsleurs ne sont-zlles pas &
DENser C..

Comment articuler valeurs de
lz Ville et...

digg n'est pas modéré la nouvelle proposition apparaitra dans la liste des propositions.
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16. CREER UNE ENQUETE

Recueillir des informations aupres de la population, enquéter sur un sujet précis est possible avec une des fonctionnalités de
Lutece nommeée Form, qui va vous permettre de récolter, compiler et traiter les informations si besoin est.

Ce plugin peut vous permettre de répondre a des types de demandes, du formulaire simple de type enquéte, a des
formulaires de demandes beaucoup plus complexes nécessitant un suivi fin du dossier et ce grace a des plugins et modules
complémentaires. On peut l'interfacer, par exemple, a un module d'authentification pour récupérer les données de
|'utilisateur (ses coordonnées, son quotient familial) ou des données déja renseignées dans son profil.

L'ENQUETE

Il s'agit de compiler des informations sur un programme ou des pratiques, pour cela un formulaire est proposé aux personnes
concernées pour qu'elles puissent saisir leurs réponses.

Dans I'exemple ci-dessous il s'agit d'interroger une population sur leurs pratiques numériques:

Quel utilisateur des outils numériques étes-vous ?

Vous fréquentez les réseaux [ (0) Occasionnelement
sociaux

D (%) Au moing 1 fois par jour

|:| (+) Jamaiz (raconter sa vie sur Internet... trés peu pour vous 1)

Pour vous, envoyer des fichiers |:| {0} Un casse-téte chinois : vous y passer le temps gu'il faut mais finissez
lourds, c'est toujours par réussir a tout envoyer... et ce, méme si c'est en 15 fois !

(%) Un jeu denfant : vous réduisez les images, zippez vos documents et utiizez
les logiciels en libre acceés sur internet sans vous poser de guestions.

[F] (+) Toujours le méme scénario : vous appelez votre collégue préfére au
SECOUrS.

Si on vous dit « réseau social D (0} A une sorte Facebook pour la Vile ?
interne », vous pensez
|:| (+) Qu'est-ce gue c'est encore gue ce truc!

|:| (%) A Foutil dont vous révez pour échanger avec vos collgues et partager vos
projets !

Lorsque vous envoyez un email, la (0) Vous n'y pensez pas toujours.
dis%nc‘tion entre « A », « Cc » et D

Cein [ (x) Vous matrisez.

D (#) Jamais entendu parler !

Imaginez que vous ayez besoin de |:| (+) Pas grave... vous quittez votre bureau sur le champ et c’est parti pour une
aire rapidement un point avec petite demi-heure de transport pour vous rendre au bureau de votre collégue.
de:ﬁiﬁ%ﬁg:ﬁg:;t:nievlgu\;”fé [C] (0) Pas grave... aprés tout femail sert aussia ca!

1

travaillez pas sur le méme site... ) . L .. o
|:| ((X) Pas grave... deux petites manip’ sur votre téléphone et vous voicitous les
trois en audioconférence.

Vous partez en congé... |:| [U]i\.ﬁ:luts pensez systématiguement & activer votre message d'absence
automatique.

|:| (+) Vious prévenez bien tous vos collégues : « Sion me demande, je rentre le
250w

|:| () Vous briefez un collégue sur les projets en cours et n'oubliez pas de le
mettre comme contact dans votre message d'absence automatique.

Votre agenda Outlook, il est plutdt |:| (%) A jour et partagé avec votre service.

(0) Moyennement renseigné... Vous répondez aux invitations mais ne pensez
pas toujours a indiguer vos autres rendez-vous.

D (+) En version papier.

Lorsque vous devez travailler a D (X) Bien. Vous avez Fhabitude de produire vos documents ensemble grice au
distance & plusieurs pour produire calepin collaboratif.
un document commun, ¢a se R ) , -
passe plutdt D (#) par mail, chacun se chargeant d'envoyer sa contribution aux autres.

[C] (0) autour un serveur partagé ol sont rangés tous vos documents de travail

On vous propose d'intégrer un D (+) Vous trainez les pieds... encore un outil complexe qui vous est imposé.
groupe de travail sur le collab’, la

plateforme collaborative de la Ville. =) () « Enfin! ». Cela fait des semaines que vous attendez d'aveir foccasion de
Quelle est votre reaction ? futiliser.

[0 () « Et une de plus ! ». Vous étes déja membre de 3 groupes sur la plateforme.

w Valider vos réponses

REALISER LE FORMULAIRE D'ENQUETE

Pour accéder a la gestion des formulaires apres vous étre authentifié en Administration du site, cliquez sur Gestion des
formulaires dans le menu Applications.
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Applica

Gestion de la cartographie

Gestion des annualres Liste des annuaires

Gestion des réseaux soclaux
Actions
EE

Administration du Site @

Liste des annuaires @

Liste de formulaires +
Administration du Site — —

Gestion des
Gestion des utilisateurs &

ML PR Srtnths Derniére rubrique modifiée [EJ permis devégétaliser [ERE]
n Page 1 - Html ou Texte libre E Nombre de réponses 0 E
Gestion des Plugins ©
B permisdevégétatiser  [EE
Administration du Site @ Nombre de réponsﬁ 0

n Qu'attendez vous d'un -E

CMS open-source 7
Mombre de réponses 0

Liste de formulaires ©

Liste des workflows +

Titre Actions

Liste des workflows @

Pour savoir comment réaliser ce formulaire, allez au chapitre Comment créer un formulaire ?
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17. PARAMETRER LES EXTENSIONS

Partager ses contenus de fagon aisée, voter, proposer de commenter, avec modération ou sans modération, les articles de
son site en un click, c'est ce que permet |le plugin Extend.

De facon globale au site, par page ou par document, il est possible d'ajouter des fonctions de commentaires ou d'évaluation
qui pourront étre recueillis, modérés et/ou affichés.

(s C . E3 Extensions ~ N . . - . .
Tous ces éléments sont intégrables via le menu situé en haut a droite dans Site > Administration du site.

Administration du Site

o Home =R Rubrique sions ~  / Propriétes ge fille 34 Plan dusite

£ Barre d'action
[™ Nombre de vues
M Commentaires
& Réseaux sociaux
C votre opinion

* Vote

AJOUTER DES FONCTIONS DE COMMENTAIRE

Des fonctions de commentaires peuvent étre ajoutées a vos contenus. Un commentaire peut étre :
e autorisé ou non autorisé
e modéré a priori ou a posteriori.
e vous étre notifié par mail

Ces options peuvent étre paramétrées dans la gestion des extensions par ressource.

AJOUTER DES COMMENTAIRES A UN CONTENU

Insérez cette fonction via le menu Extensions > Commentaires > Ajouter I'extension commentaires.

me X = Rubrique + Extensions ~ = # Propriétés Pagefille gk Plan dusite

£ Barre d'action

LD E. E ™ Nombre de vues

D sjouter l'extension 'commentaires' Commentaires

& Réseaux sociaux
C votre opinion
* Vote

Les fonctions de commentaires ont bien été associées a votre contenu, en revanche il convient de les paramétrer.

Les boutons suivants sont visibles sur la page ou I'élément ol la fonction commentaire a été ajoutée :

Voir tous les commentaires Ajouter un commentaire

LE PARAMETRAGE DES EXTENSIONS DE COMMENTAIRES

Le paramétrage est accessible depuis le menu Contenu > Gestion des extensions de contenu.

La gestion des extensions est classée par ressource (commentaires sur un contenu) ou par type de ressources (en général).
Le nom de I'extension pour les commentaires est "comment".
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Gestion des extensions par ressource

Gestion des extensions par ressource Gestion des extensions par type de ressource

Rechercher une extension extension <Tous> ~ 1D ressource Type de ressource <Tous> - xAnnuler

Nombre par pagem ¢ - Nombre d'éléments: 3
Extension A v IDressource A v Type deressource A v Nom Actions
comment 1 PAGE LUTECE ¢ ] |u]
rating : PAGE ¢ |m|n]
document n u

-Nombre d'éléments:3

opengraph

Dans cet exemple-ci, nous allons paramétrer les commentaires pour le seul document auxquels ils ont été associés.

Les actions possibles sont les suivantes :
ﬂ modifier la configuration

E voir les informations de I'extension

supprimer
La configuration permet les actions suivantes :

mettre en place une modération des commentaires a priori (recommandé)

choisir le nombre de commentaires a afficher (10 par défaut)

autoriser des sous-commentaires

choisir I'emplacement du formulaire de soumission de commentaires parmi 4 choix de position, ou le non-affichage du
formulaire

notifier par e-mail le compte administrateur

personnaliser le badge affiché sur les messages des administateurs

e personnaliser le message affiché aux utilisateurs aprés soumission du formulaire

Les autres options ont été laissées avec les valeurs par défaut.
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Configuration de |'extension

Modération des
commentaires :

Nombre de commentaires
a afficher:

Autoriser les
sous-commentaires :

Emplacement du
formulaire de soumission
de commentaire :

utiliser un editeur
BBCode:

Notification par email :

Badge affiché sur les
message des
administrateurs :

Message affiché aux
utilisateurs aprés avoir
posté un commentaire :

@ Qui © Non

10

©) Qui @ Non

Dans une autre page -

@ Qui © Non

<Pas de notification= -

Sélectionner |a liste de diffusion & notifier lorsqu'un commentaire est soumis.

Fichier = Editer = Insérer = \oir = Format =  Tableau -

Quitils =

l"\ ﬁlﬁlFUWﬂﬁIS'lB Ilﬂ'ﬂ'lEEEE
lEE'iE‘EElhooﬂlﬁﬁzg <

p Mots - 1
Fichier = Editer = Insérer +  \oir = Format ~  Tableau -~

Qutils =
lﬁ f’ltllFDFmalS'lB Ilﬂ'ﬂ'IEEEE
E-E-EE 4 L B B8 e B o
\otre commentaire a bien &té créé.
Il sera disponible une fois gu'il aura &té validé pas un administrateur.

p Mots : 18 _

' Modifier ® Annuler

Les fonctions de commentaires associées a votre contenu ont été mises a jour. Dorénavant, I'utilisateur est prévenu que ses
commentaires sont soumis a approbation du webmestre.
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Les commentaires sont soumis a approbation du webmestre.

Email *:
Pseudo *:

Commentaire *:

Une fois qu'il aura posté son commentaire, le message de confirmation paramétré dans la configuration de I'extension sera
affiché.

GERER LES COMMENTAIRES

Dans I'outil d'administration, revenez sur la page qui contient votre document commenté et cliquez sur Extensions >
Commentaires > Gérer les commentaires.

Administration du Site

o Home X B Rubrique « Extensions = = # Propriétd
= = ||
= Barre d'action >
[™ Nombre de vues 3 -

W Gérer les commentaires Commentaires
& Réseaux sociaux
9 Retirer 'extension ‘commentaires’ | (3 viotre opinion

¥ Vote

Dans la fenétre suivante apparaissent les commentaires non publiés. Les actions possibles :
s publier/dépublier
e répondre
e supprimer

Attention: toute suppression est définitive.

Gestion des extensions par ressource

Gestion des extensions par ressource Gestion des extensions par type de ressource

Rechercher une extension extension <Tous> ~ |D ressource Type de ressource <Tous> - )Annuler

Nombre par pagem C - Nombre d'éléments: 3
Extension A IDrassource A v Type de ressource A v Nom Actions
comment 1 PAGE LUTECE ag
rating 8 PAGE u n u
document u u

- Nombre d'éléments : 3

opengraph
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SUPPRIMER DES FONCTIONS DE COMMENTAIRES
Dans le menu extensions>commentaires, cliquez sur retirer I'extension commentaires.

EVALUER LES CONTENUS

Il est possible d'ajouter I'extension Votre opinion permettant a |'utilisateur de donner un avis sur un contenu ou de faire
remonter une expérience ou autre sur le sujet. Le contenu saisi par I'utilisateur n‘apparait pas sur le front-office, il s'adresse
uniquement a I'administrateur et n'est donc pas sujet a une quelconque modération.

Pour insérer I'extension, allez dans le menu Extensions > Votre opinion > Ajouter I'extension 'votre opinion'.

Administration du Site

o Home X E= Rubrique « Extensions =  / Propriété

—_ ) -
= Barre d'action »
[™ Mombre de vues 3

||
M Commentaires 3
& Réseaux sociaux 3

€ Ajouter l'extension 'votre opinion’ Votre opinion

* Vote

Il suffit ensuite de paramétrer le message a afficher et de paramétrer la notification par e-mail.

Gestion des extensions de contenu configuration de lextension © Aide

Configuration de l'extension

Message  afficher: Fichier + Editer * Insérer ~ Voir~ Format~ Tableau ~  Qutils =

& | Fomas* | B [ | A~ A~ =

— 1— _—
—v = v =
— = =

.
[l

Ly P BB H o
\Vous avez une remarque a faire, une expérience a raconter sur le contenu de la page ou sur le
service dont il est question ?

p Mots : 24

Notification paremail *;  admin -

Sélectionner |a liste de diffusion A notifier.

« Modifier ¥ Annuler

En front-office, sur la page a laquelle a été ajoutée I'extension, un cadre de saisie de texte s'affiche avec le titre défini dans
le back-office.

93



\ous avez une remarque a faire, une expérience a raconter sur le contenu de la
page ou sur le service dont il est question ?

RETIRER L'EXTENSION VOTRE OPINION

La procédure est identique a celle concernant les commentaires, dans le menu Extensions > Votre opinion, cliquez sur retirer
I'extension Votre opinion.

NOTER LES CONTENUS

L'extension Vote (rating) permet a I'utilisateur de voter sur un contenu. Pour insérer |'extension Vote, allez dans le menu
Extensions > Vote > Ajouter I'extension vote.

+ mm Rubrique - Extensions ~ | # Proprictés

£ Barre d'action
™ Nombre de vues
M Commentaires
& Réseaux sociaux

C votre opinion

€ Ajouter l'extension 'votes' | Vote

L'application vous positionne directement sur les options de paramétrage. Les actions possibles sont les suivantes :

e Demander une notification par email lorsqu'un vote est effectué

Choisir le type de vote (70 0T, ‘? L7 ou vote simple)

Déterminer une période d'activation du vote (date de début et date de fin)

Indiquer si I'internaute ne peut voter qu'une seule fois ou plusieurs fois dans le temps
Déterminer que I'internaute soit authentifié avant de voter

Choisir si I'internaute peut annuler son vote

Lilmiter le nombre de votes par utilisateur
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Gestion des extensions de contenu configuration de l'extension

Configuration de ['extension

Notification par email : <Pas de notification> EI

Sélectionner la liste de diffusion 3 notifier lorsqu'un vote est éffectué.

Type de vote : Star EI

Du

i

au

i

Période d'activation du vote :

@ vote unique (L'internaute ne pourra voter qu'une seule fois la
ressource.)

Options

@) Vote temporel (L'internaute pourra voter plusieurs fois la ressource dans
le temps.)

[T cochez si I'utilisateur doit &tre authentifié pour voter.

Cochez si l'utilisateur peut annuler son vote.

Limite de vote : @ Désactive
@) Activé

' Modifier ® Annuler

Le menu Contenu > Gestion des extensions de contenu permet de revenir plus tard sur cette page de configuration et de
gérer toutes les extensions.

RETIRER L'EXTENSION "VOTE"

La procédure est identique a celle concernant les autres extensions, dans le menu Extensions > Vote > Ajouter I'extension
vote, cliquez sur "retirer I'extension vote".

PARTAGER SUR LES RESEAUX SOCIAUX

Vous pouvez associer, a chaque page de votre site, une barre de réseaux sociaux sélectionnés.

Extensions « : , ) ) , i , 3
Dans le menu cllquez Sur reseaux sociaux > ajouterl extension réseaux sociaux.

Rubrique + Extensions » = Propriét

£ Barre d"action »
[™ Nombre de vues 3
M Commentaires 4
C votre opinion b
* Vote

h 4

Cochez dans la liste les réseaux sociaux que vous souhaitez afficher et cliquez sur le bouton modifier.



Gestion des extensions de contenu 8 aide

Configuration de l'extension

Configuration de |'extension

Réseaux sociaux 4 afficher:
Facebook
Google+
Twitter (share)

Twitter (follow)

Les réseaux sociaux choisis apparaitront sur le site a I'endroit déterminé lors de I'intégration graphique du site.
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POUR ALLER PLUS LOIN

18. CREER UNE BILLETTERIE
19. LES PETITES ANNONCES
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18. CREER UNE BILLETTERIE

Des fonctionnalités de gestion d'une billetterie en ligne sont disponibles sur Lutece. Elles sont composées en front-office
d'une présentation des différents spectacles a I'affiche, que I'internaute/intranaute peut consulter, réserver, gérer en ligne.
La partie back-office va permettre de gérer les salles de spectacles, les spectacles eux-mémes, les calendriers de séances,
les listes de réservations.

GESTION DES SALLES DE SPECTACLES

La gestion des salles de spectacles se gere via le menu déroulant correspondant, Gestion des Salles.

® LUTECE ¢

@ Gestion des salles

Liste des salles + Ajouter une salle

2 3 4 5 6 7 8 9 10 11 Suivant Fin

Nombre par page | 10 B G - Nombre d'éléments : 230

Ala Folie Thédtre ﬁ
Académie Fratelini ﬁ
AMPHITHEATRE ASIEM ﬁ
Apollo Thésire ﬁ
Atelier i |
Atelier de Paris-Carolyn Carlson ﬁ
Auditorium de I'Hotel de Ville ﬁ
oao

Batofar ol m

POWERED BY
4 MHEE

Il est possible d'ajouter autant de nouvelles salles que nécessaire, ou d'éditer une fiche de Salle de spectacles.
La fiche permet de renseigner les éléments suivants :

Nom de la Salle.

Adresse.

Quartier (une liste de noms de lieux correspondant a des appellations du langage courant).
Les caractéristiques d'accessibilité.

La station de transport en commun a proximité.

@, Gestion des salles

Modification d'une salle

Nom *
Contact
} 3
Adresse
Numéro de téléphone du
contact
]

Courriel du contact

Quartier ﬁ
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AT RS A

Accessible

Commentaire accessibilité

Indications métro

® Annuler

GESTION DES GENRES DE SPECTACLE

L'administrateur créé une liste de genres de spectacles qui va permettre de catégoriser ceux-ci, et de leur associer une
couleur d'affichage qui permettra de les différencier sur la liste des spectacles en front-office.

@ Gestion des genres 1o

MNom *:
Cirque
Description :
Cirque
Couleur * -

#FF0000 [ |

Cliquer sur une couleur pour la sélectionner :

® Annuler

GESTION DES SPECTACLES

Une fois ces éléments renseignés, le gestionnaire du site peut créer des spectacles. L'interface de gestion des spectacles
permet de rechercher/filtrer la liste qui peut devenir longue un spectacle en particulier, sur des critéres tels que le titre, la
salle, le genre, les dates.

) Gestion des spectacles Liste

Liste des spectacles & Gérerles genres de speciacles

Titre -

Précédent 2 3 4 5 6 7 8 9 10 M .. Suvant Fin
Salle : Nombre: par page | 10 B C - Nombre d'éiéments - 1887
[
Titre & v Salle s v Genre A v Dates Actions
Genre - 1,2, 3l éfait une fois... Comédie Tour Eiffel Spectacle enfanis Du 13/01/2015 au 26/06/2015
El 10 ans de musique sur France 4 Comedia Emission TV Du 17/03/2015 au 23/03/2015
Date des réservations entre le - 100 ans de la police judiciaire de Paris. Champ de Mars Exposition Du 25/11/2013 au 26/11/2013
B 120 secondes présente la Suisse expliquée aux pauvres Francais L'Européen One man Show - Café théatre  Du 13/11/2014 au 03/12/2014
e:-le. 134 table Saint-Georges Comédie Boulevard Du 21/09/2012 au 14/12/2012
= 1789, les amants de la Bastille Palais des Sports Comédie musicale Du 12/10/2012 au 2012/2013
En page d'accueil | []
1946-1960 Ces années-a a Saint Germain des Prés Gaité Montparnasse Comédie musicale Du 12/10/2012 au 03/12/2013
Q Recherch 1984 Theétre de Ménimontant  Théatre contemporain Du 25/11/2013 au 13/12/2013
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22h13 Rond Point Théatre contemporain DU 03/09/2012 au 04/09/2012 ﬁ

ao

22h22 Pépiniére Comédie musicale Du 11/01/2013 au 08/04/2013

Suivant  Fin

o
IS
o
=

Nombre d'éléments - 1887

Il est possible, a partir de cette interface de gestion, de créer un spectacle ou d'accéder a la fiche de modification d'un
spectacle existant.

Les données de saisies d'un spectacle sont :

une photo de I'affiche du spectacle ;

le titre ;

son affichage ou non en page d'accueil du site ;
son genre ;

la salle ;

la distribution ;

le type de public concerné ;

une présentation détaillée, via un éditeur de texte riche ;

les dates de début et de fin du spectacle, sur lesquels se feront les réservations ;

le lien du site internet éventuel ;

la possibilité pour les internautes de s'abonner aux informations sur ce spectacle (dates de disponibilité de créneaux
de réservations par exemple, réouverture pour un spectacle récurrent).

La fonctionnalité standard de Lutece d'ajout d'une extension de type vote, nombre de vues, commentaires est gérable
unitairement au niveau de la fiche de spectacle ou de maniére globale sur tous les spectacles via l'interface de gestion des
extensions des ressources Lutece

Affiche * - Distribution ki
1™ Nombre de vues

¢ de Michael Curry (le Roi Lion-Disney) sur une crég H
) €D Ajouter l'extension ‘commentaires'

Mis en scéne par Guy Caron (Dralion- KA, le Cirque du St
musique d'Ella Louise Allaire et Martin Lord Ferguson

Public

Tout public B

Présentation du spectacle -

Paragraphe v | Stykes v X BB =«

3 i BH— 2 = x 2 Q@A e

L'Age de Glace Live ! met en scéne vos héros préférés pour une toute nouvelle histoire
bourrée d'humour, d'amitié, de solidarité et d'aventure

Sid, Scrat, Manny, Diego... ils sont tous Ia et en vrai! Accompagnés de 30 arfistes, acrobates,
comédiens, patineurs et chanteurs, ils vous embarquent dans une nouvelle aventure
totalement givrée. Du rire, de I'emotion et des surprises vous attendent !

Refroivez-unis en famile nour nartaner les deix eures de IAne de Glace | ive |
Chemin: p Mois114

Date de début des réservations *

Auan tcior slctonn Wi

Titre *

Renseigner le champ ci-dessous pour modifier le poster :

Date de fin des réservations * -

AGE DE GLACE LIVE! =
B 15/02/2013

En page daccuell - [ Site internet -
Genre
http:/flagedeglacelive f
Spectacle enfants B

Abonnement utilsateur possible ? * [
Salle *:

Palais Omnisports Paris Berc! B

d60.rec.apps.paris.mdp/billetterie/+ e

GESTION DES REPRESENTATIONS
La fonctionnalité de gestion des représentations permet de créer, modifier, administrer différents éléments des

représentations de chaque spectacle. La liste des représentations peut étre filtrée selon les criteres de nom de la
représentation (facultatif), titre du spectacle, et les dates de représentations.
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Liste des représentations

Nom de Ia représentation :

Précéde 2 3 4 5
Speciacle -
Nom de la Spectacle & + Type &
Type de représentation : représentation A v
B v
B Lage d'or de la bande  Tarif
Date des représentations comprise dessinée beige - rABdult
—— Exposition
B Les fables de la Tarif
] Fontaine au Jardin rA®duit
et
B
B Quel Cirque ! Tarif
Ul rA®duit
=
B Les fables de la Tarif
Fontaine au Jardin ~ rA@duit
B Quel Cirque ! Tarif
rA®duit

+ Créer une représentation

6 7 8 9 10 " Suivant Fi

n

Mombre par page 10 B C - Nombre d'éléments : 32864

Date Nombre de  Nombre de Actions disponibles
places initial places
disponibles

04/10/2015 - 0 ol a @
& 8888
30/09/2015 - 30 ol + &
2 3BEE
30/09/2015 - 23 ol + &
& LI
27/09/2015 - 30 ol + &
& 3BEE
27/09/2015 - ol + &
2 LR

@

Les fonctionnalités d'administration de chacune des entrées sont accessibles via les boutons d'action présents pour chaque
item de représentation. Un certain nombre de ces actions sont standard dans Lutece (visualiser, modifier, dupliquer,
supprimer) auxquelles s'ajoutent des actions spécifiques a la gestion de la représentation.

Envoyerla liste des réservations a la
salle de spectacle

inscrits

Envoyer une notification a la liste des

Annulerla représentation

Exportcsv de la liste des réservations

L'attribution des droits d'acces a ces actions sont gérées par les fonctionnalités de base de gestion des utilisateurs de Lutece

La fiche d'édition d'une représentation permet de saisir le nom de la représentation, le spectacle a laquelle elle se rattache,
un éventuel contact particulier a cette représentation, le type de réservation possible sur cette représentation (par exemple
tarif réduit, invitation, ...), la date et I'heure de la représentation, le nombre de places disponibles (qui permettra a un

compteur de place d'étre décrémenté au fur et a mesure que les places sont réservées par les internautes), le prix de la

place.

@ Gestion des représentations Modification d'une représentation

Nom de la représentation :

Spectacle * -

Personne & contacter -

Type *

Invitation ‘ > |

Date * ©
| 04/10/2015
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Aeue -

11:00

Nombre de places disponibles * -

Prix en tarif réduit -

3

LA GESTION DES RESERVATIONS

La gestion des réservations permet d'accéder a la liste compléte des réservations des spectacles réalisées par les
internautes. Il est possible de filtrer la liste par le titre du spectacle, les dates de représentation, le type de tarif de la
représentation, le nom du réservataire. Les actions associées a la réservation permettent de notifier le réservataire, de lui
exporter une contremarque a imprimer de sa réservation, de modifier ou supprimer la réservation.

@ Gestion des réservations

Liste des réservations

Spectacle :

Date de Ia représentation entre :
&
et
B
Date de la réservation entre :
&
et
B
Type de la représentation :

Invitation

Nom de I'agent :

Q Rechercher

Spectacle o v Datedela
représentation

[] Bensé chante 24/07/2015 - 20:00
I'amour (et la haine)

[[] Jane Resmond-Va  30/08/2015 - 20:15
falloir y aller

[7] Jane Resmond -Va  30/08/2015-20.15
falloir y aller

[[] Jane Resmond -Va  30/08/2015 - 20:15
falloir y aller

[[] Jane Resmond-Va  30/08/2015 - 20:15
falloir y aller

[[] Jane Resmond -Va  23/08/2015 - 2015
falloir y aller

[[] Jane Resmond -Va  16/08/2015 -20:15

falloir y aller

[[] Jane Resmond -Va  09/08/2015 -

203 4 5 7 8 9
Datedela Type de Agent
réservation représentation A v
23/07/2015 Invitation
23/07/2015 Invitation
23007/2015 Invitation
23/07/2015 Invitation
23/07/2015 Invitation
23/07/2015 Invitation
23/07/2015 Invitation
23/07/2015 Invitation

LA RESERVATION DE SPECTACLE PAR LES INTERNAUTES

Suwant | F

n

Nombre par page | 10 EI G | - Nombre d'éléments - 177815

Nombre de places Actions
réservées

2

Les spectacles publiés sont disponibles sur le front-office du site pour consultation et réservation par le public du site.
L'acces a la liste des spectacles se fait via un moteur de recherche, qui reprend pour filtre un certain nombre des éléments

paramétrés en back-office.

e

Vous étes ici - accueil > Reche

Recherche filtrée sur

Recherche avancée Ie q ua f'tler
© Arafiche
° RJécroissante
A venir

© Mes réservations

© Reégles dujeu 0-Résultals = 1-10

102

Recherche filtrée sur
le genre de spectacle

une comédie
amenés a

aur est bien
 dinier, |a belle

:eptionnels du

ira-til 3 monter

»» RECHERCHE AVANCEE

Recherche sur une
période proche

-

Thédtre de Verdure du Jardin
Shakespeare

Route de Suresnes - Paris Bois de
Boulogne - M* Porte Maillot puls bus 244
arrét Bagatelle Pré Catelan

Du 23/06/2014 au 30/09/2015


la-gestion-des-utilisateurs

Thédtre de Verdure du Jardin
Shakespeare
Route de Suresnes -Paris Bols ge

1o Magie (22) an _lardin
Il est ainsi possible dans la recherche simple de trouver un spectacle a partir de son titre, du genre de spectacle, d'un
quartier, d'une période type ce soir, ce week-end, la semaine prochaine. La recherche avancée va permettre d'ajouter des
précisions sur les dates exactes de spectacles ou de cumuler les genres de spectacle par exemple. Le détail du spectacle va
permettre d'accéder aux informations du spectacle, de réserver des places, d'accéder aux commentaires des internautes
ayant déja été voir ce spectacle.

[ Ok Vousétesici: accusl = Molérs malyré moi

Recherche avancee

Bienvenue,

¢ U - . ’
Déconnexion Moligre malgre MOl

0 Arafich Distibuton:De

o A venir Francis Perrn

Mise en scéne
Francis Perrin
Avec

Francis Perin

© Mes réservations

© Regles dujeu

Genre: Comédie Boulevard

Salle: Gaité Monfpamasse
26, rug de la Gaté, 75014 Paris

Dates:: du 04/05/2013 au 0410812013

Malgré mai ne veut pas dire que jai décidé de faire revie
Moligre contre mon gré. Bien au contraire | Je n'ai pas pu fare
autrement C'est Iui qui m'y 2 poussé en quelgue sorte. Ca
n'est pas seulement Moliere qui va reprendre vie, ce sontles
comediennes ef les comédiens de sa froupe, ce sont ses
amis Boileau, La Fontaine, le peintre Mignard, ce sont tous
ses ennemis (et Dieu sait s'ls ont éte nombrew !) et cest
aussi Louis XV en personne. Ce sont les 15 demisres
années dune vie balotés entre Iamour pour ses
. : comédiennss (Madeleine et Amande Béjan Cathering de
THEMHE []E lﬁ Brie, Marquise du Parc) et|'amour du Theatre. Ce sont quinze
GAITE MUNTPAHNASSE années dune vie déchirée qui ne 'accomplit waiment que
5Ur Ies planches. Efaitl plus Dom Juan que Sganarelle, plus
Alceste que Philinte, plus Scapin que Géronte, plus Gearge Dandin que Monsieur Jourdain ? I étaittous ceur1a  la fois mais
il était surtout Moliere et c'est plus que suffisant

Pafron dentreprise avant [heurs, Premier Farceur de France, auteur dramatique de génie, en triomphant de toutes les
frahisons, en amaur comme en amitié, aiagué de toutes parts, blessé, malade, agonisant Moliere nous prowve quil est
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toujours bien vivant et quiil a su depuis plus de trois sigcles nous ransmeftre 52 passion du Theatre, celle que nous allons
partager aujourd'hui

Placesa10€

Resenvation

Wrmars 20(5- 2000 v Vairles places dispanibles

Tarif rA@duit (10€)
Places dispanidles ﬁ
Places aréserver 0 v
Reserver
Commentaires
Yoir tous les commentaires
Commema”es Alouter un commentaire
(AT W b

Je [écris pour Ia premiére fois mais 13 céfalt une déception, wu
pendant les jours de chaleur M Pemin semblat fout excité son
bégaiement que je croyals passé depuis longtemps faisalt un retour
manfeste ef rendait quelgues fois I compréhension des fextes e vers
dificie. En plus mal placés en corbellle, coincés par le peu d'espace
mpossible de bouger les jambes - malgré fa gentilesse du placeur
qui malheLreusement nous a oubliés suite & notre solicitation (toutes
les places du premier rang élaient vides..). Malgré 13 passion évidente
e M Perrin pour Moliére, cela nous semble assez indigeste, débit top
rapite, trois Drefs infermedes musicau...Le tout payant Bref soirée
decevante vu nofre aftente. Peut-élre un accident.

Posté e 3 aolt 2015 12.59:11

[T P L1
Si vous aimez Moliére, nhésitez pas! Monsieur Francis Perrin lui rend

GESTION DES RESERVATIONS DE L'INTERNAUTE

Lorsqu'un internaute a réservé pour un spectacle, il regoit par mail la notification de sa réservation. Il a également la
possibilité d'accéder a la liste de ses réservations, d'imprimer une contremarque, d'annuler une de ses réservations en cours
" ".___ I

Yous étes ici: accusi = Mes réservations




Mes réservations

Rirnvenug

Déconnexion
0 A laffiche Bonjour Antoine. Bienvenue survotre espace de réservation.
© Avenir
© Mes réservations
© Régles dujeu

Lafée des chaussettes - Funambule - 01/04/2015 - 16:30

Tarif rA@duit 1 f=n

CONTREMARQUE INVITATION

Valable pour made hippocrate :

Pépiniére

7 rue Louis Le Grand,

Délivrs per e

Embrassons-nous Folleville !

75002 Paris

2 places le 29/11/2012 a 19h00

= 29/11,/2012 & 16:40
Iy
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19. LES PETITES ANNONCES

Le plug-in Petites annonces permet de mettre en place facilement un service de proximité autour d'échange de services, de
ventes de produits. L'administrateur devra créer la structure des annonces qu'il souhaite proposer et les utilisateurs auront a
charge de publier et gérer leurs annonces. Cette fonctionnalité nécessite une authentification pour les utilisateurs front-
office. Lutece propose par défaut plusieurs types d'authentification (base de données, CAS, oauth).

METTRE EN PLACE LE SERVICE D'ANNONCE

Les annonces sont organisées depuis le back-office par domaine et dans chaque domaine on va pouvoir associer des
catégories dans lesquelles les annonces pourront étre déposées par les internautes.

LES DOMAINES

Il s'agit de créer les domaines qui permettront de regrouper les catégories de site.

o Pg{,’(&] Aﬂﬂﬂmﬂ @ Contenu~ Sitew  Utilisateurs~  Gestionnaires»  Chartev  Systéme » & | L dmin Admin

Gestion des petites annonces

Gestion des domaines

s annonces Gestion des domaines Gestion de:

tégories  Listedes utlateurs

50 v G -8
Libellé Description Nombre de catégories Ordre Actions
Autos / Motos Autos [ Motas 3 IR A" nn
Immobilier Immobilier 6 2 T nu
Animaux Animauxs de compagnie 4 3 v nn
Mode, vétements et accessoires Mode, vétements et accessoires 6 L ov|y nn
Multimédia Multimédia 4 5 v v nu

La création d'un domaine permet de donner la structure de premier niveau des annonces. On peut associer des tags a un
domaine pour faciliter la recherche et décider si les annonces publiées dans ce domaine doivent étre modérées.

LES CATEGORIES

Les catégories sont associées a un domaine et permettent de créer la structure des annonces en définissant en plus des
champs définis par défaut, lesquels champs (images, localisation, texte) seront ajoutés au formulaire de création des

annonces.

o Pgﬁmﬂ;{mm@g Contenu v~ Sitev  Utilsateurs+  Gestionnaires v Charte v Systéme v A Luininadrin -

Gestion des petites annonces ¢

Gestion des domaines +Crrune atdaoie

sannonces  Gest es utilisateurs

domaines | Gestion des categories

NG -4

Libellé Nombre d'annonces Actions

Autos Motos > Equipement Auto Motos 1 #[e|c]0}
AutosMotas > Motos 2 oues i /]e[a]d}
Autos Motos > Voitures B /]e]2]4]
Immobier>Colocatons : #[o]al8
immoblier> ocaionsimnobies i [¢]e|@]1]
Immoblier>Locstions vacances fi /]e]a]d}

La création de I'annonce permet de préciser si les annonces de cette catégorie seront modérées (par défaut elle hérite de la
valeur du domaine choisi), de la notification, si I'attribut prix sera renseigné et si éventuellement il faut associer un
traitement a la publication des annonces.
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Utilisateurs « Gestionnaires ~ Charte ~ Systéme -

Contenu

O Fetites Annonces =

Gestion des petites annonces c-ation dv

Création d'une nouvelle catégorie

Libellé *:
Libellé
Domaine*: |Choisissez un domaine
Modérer les annonces *: | Parametres globaux v
Selectionnez "Paramétres globaux" pour utiliser les informations du domaine
v

Aucun
Notification par mail a chaque dépot d'annonce

Notifier 3 un groupe
d'utilisateurs:
Permet d'afficher le prix / tarif directement dans la liste des annonces

Afficher un attribut "prix
[ tarif" pour cette
catégorie:

Prix obligatoire:
Permet d'obliger les utilisateur a saisir un prix ou un descriptif du prix

Workflow :
% Annuler

Pour créer la structure de la catégorie, il faut passer par le formulaire de modification une fois la catégorie créée ;
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o Pgﬁmﬂmlam'@g Contenus  Sitew  Utilsatewrs~  Gestionnaires v Charte »  Systéme » & Ladvinadnin »

Gestion des petites annonces

Libellé *:  Equipement Auto/Motos Attributs par (éfaut
Domaine*: | Autos Motos ' Titre del'attribut Type d'attribut
Modérerles annonces QUi v Titre de | annonce Texte
Selectionnez "Paramétres globaux" pour utiliser les Descption Totelong
informations du demaine
Notifier 3 un groupe | Notficationmonce ¥ Liste des attributs Créerun attribut detype (s cocher 'ﬂ
d'utilisateurs:  Notification parmail 3 chaque dépat d'annance
Titte  Type @ Ordre Action
Afficher un attribut "prix v
[tarif" pour cette - permet'aficher e prix tarf drectement dans ot @) ! v /]
catégorie:  isteces annonces phatof
Prix obligatoire ¢
Permet d'obliger les utlisateur asaisirun prix ou un
descriptifdu prix
Workflow: '

X Annuler

Il est possible d'associer en plus des attributs obligatoires que sont le titre et la description des attributs de type :

o Texte.

Texte long.

Image, si vous ajouter plusieurs champs images cela permet de créer une galerie de photo automatique dans
I'annonce.

Géolocalisation.

Case a cocher.

Bouton radio.

Liste déroulante.

Date.

Commentaire.

Numérotation.

Regroupement, pour pouvoir associer plusieurs champs.
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GERER LES ANNONCES DEPOSEES PAR LES UTILISATEURS

o Potito Annonces @ Contenus  Stev  Utlisateurs v Gestionns n A Ladnin Adnin »

Gestion des petites annonces

Liste des petites annonces

Liste des petitesannonces ~ Gestion desdomaines  Gestion descatégories Liste des utilisateurs

1234567>
Nombreparpage 50 » G - Nombre d'éléments:347
Titre A ¥ Description & ¥ Categorie Datedecréation A ¥ Datedemodification ¥ Etat  Actions
BRNNSIERN  Bjuin20151E3300 g 8Ean
v Tmai NG M mai 00513741 /] Enn
RNonpublide
[remaET 1 mai2015124831  21mai 2015124844 /] Emnn
PRSP )1 015124624 2Lmai 015124624 /] Emnn

Une fois les premieres annonces publiées |'administrateur a la possibilité de consulter les annonces créées, de les publier si
elles sont modérées par défaut, de les dépublier, des les suspendre ou méme de les supprimer.

QUELQUES POINTS A CONNAITRE

L'administrateur peut aussi consulter la liste de tous les comptes utilisateurs ayant publié une annonce. Il existe aussi une
fonctionnalité d'archivage automatique des annonces avec notification alertant les utilisateurs sur la suppression
programmée de leur annonce.

PUBLIER MES ANNONCES

L'internaute une fois connecté sur le site en front-office peut choisir de publier, une, deux ou autant d'annonces qu'il le
souhaite en étant guidé par la structure d'annonce prédéfinie par I'administrateur. |l bénéficie de la possibilité de gérer son
annonce (créer, modifier, publier, suspendre, supprimer), de s'abonner a une catégorie, une recherche. S'il n'est pas
connecté, I'internaute ne peut qu'effectuer une recherche et envoyer un mail au créateur de I'annonce.
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= Accueil Imprimer cette page

© Bienvenue,
I
* Categories
-Autosfl'o‘lotos[tl-s] @Rechercherune annonce B Passer une annonce ™ Mes annonces . Mes abonnements
& Immobilier(131)
Colocations (3) [
- Locations immoiliéres (16) [
| Locations vacances (64) Rechercher une annonce
Recherche immobilire (5) [
- Vente vacances/étranger (10) [ Rechercher
i VVentes Maisons/Appartemen... (33) [ Tous les Domaines |
E ;:I::a,l\‘fxéltluents ot accesso...[157] E%lt];%%:?ess Tous les Domainss ¥ Toutes fes Catégories v
= Multimédia(39) Ajoutée entre le etle
[+ Maison(156)
[+ Loisirs(103) Prix compris entre £et £
[+ Services(16)
Rechercher Effacer les critéres de recherche
I

Trier par:| Date de Création de 'annonce v

Pages:1234567891011..2>> Nombre d'éléments : 666

Pull rouge grenat T.44 [03/08/2015 ] 9¢

Pull rouge grenat, motifs a 'avant 2 écureuils, acrylique, trés bon état.

@ Femmes/vétements et chaussures O Afficher les autres annonces de la personne

- Televiseur sur meuble incorporé [ 03/08/2015 100 €

téléviseur sur meuble incorporé, Samsung, année 2002, gris métallisé - Trés bon état de
marche - Largeur écran : 0,88 cm - Hauteur &cran : 0,66 cm - Profondeur totale : 0,51 cm -

CONSULTER LES ANNONCES ET RECHERCHER

Par défaut les petites annonces sont présentées paginées avec la possibilité de naviguer en filtrant par domaines et
catégories affichés sous forme arborescente.

Un formulaire de recherche permet de faire une recherche textuelle dans les champs textes de I'annonce et offre des filtres
sur les domaines/catégories, les dates de création, et les prix des annonces. Si on valide le formulaire les annonces
s'affichent sous forme de liste on peut en cliquant dans les résultats, afficher le détail de I'annonce, voir toutes les annonces
de la méme catégorie ou toutes les annonces de I'annonceur.

* Categories

i Autos / Motos(49)

&} Immobilier(130)

i Colocations (3) B

i Locations immobilieres (16) [

Locations vacances (64) [ APPARTEMENT 3 PIECES SAINT MAUR DES FOSSES
Recherche immobiliere (5) [ Prix / Tarif : 238000 €

& Vlente vacances/étranger (10) &=
L Ventes Maisons/Appartemen... (32)
B
H Animaux(11)
# Mode, vétements et accesso...(167)

; Multimédia(39) .
+ Maison(156) Ajouter une photo

t Loisirs(103)
I m |

 Services(18)
T mim

enechercherunennnonoe B Passerune annonce ™ Mes annonces . Mes abonnements

g T e OO o e OO oy B P
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lays

Immaobilier || maison | appartement | vacances

Contacter I'annonceur :

CREER SON ANNONCE

Pour pouvoir créer une annonce, il convient d'étre connecté et de cliquer sur le bouton Passer une annonce. La procédure se
fait en deux étapes, on choisit d'abord la catégorie dans laquelle on souhaite publier I'annonce, enfin on saisit les champs
nécessaires a la description de I'annonce.

= Accueil Imprimer cette page
© Bienvenue,

* Categories
- Autos | Motos(49) @Rechercheruneannonce ~ Mes annonces . Mes abonnements

H Immobilier(131)

H Animaux(11)

7: Mode, vétements et accesso...(167)
«+ Multimédia(39) Catégorie: Inmobilier > Locations immobiliéres Retour
+: Maison(156)

 Loisirs(103) Titre de I'annonce *

- Services(16)

&
[
[
B
£
&
[
[

Description *

I

Ajouter photo(s) Choisir la photo  Cliquer pour sélectionner une ou plusieurs
photo(s)

Précisez I'adresse du
bien

Prix | Tarif (3

Contact *

Mots clés = :
Immabilier ® || maison % || appartement x
vacarnces %

Mots clés pour faciliter la recherche de 'annonce. Cliquez sur la croix pour supprimer les mots
clés qui ne correspondant pas & vofre annonce. Vous avez également la possibilite d'en créer
dautres.

Valider

GERER SON ANNONCE

Une fois son annonce publiée, on peut par le bouton Mes annonces, afficher la liste des annonces publiées.
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= Accueil 2 Imprimer cefte page
© Bienvenue,
I

% Categories
- Autos | Motos(24) eﬂechercheruneannonce a Passeruneannonce . Mes abonnements
& Immobilier(63)

[+ Animaux(6)

& Mode, vétements et accesso...(89)
[

[

B

£

- Multimédia(23)
- Maison(78) Mes annonces

+ Loisirs(52)
t Services(4)

Etat Actions
1500 €

"0 VI X- L

@ Locations immobiliéres

150 €

) o 220

Les actions possibles sont la modification de I'annonce, la suppression ou la suspension de la publication de I'annonce.
S'ABONNER

On peut aussi si on le souhaite s'abonner pour suivre la publication des nouvelles annonces et étre notifié automatiquement
de leur publication.

Il est possible de s'abonner a :
e Une catégorie,

e Un annonceur,
e Une recherche.

@ Rechercher une annonce Passer une annonce = Mes annonces
Information

Lorsgue vous vous abonnez & une catégorie d'annonces, vous recevrez une alerte par mail lors de la création dune
nouvelle annonce dans cette categorie .

Vous pouvez a tout moment ajouter ou supprimer un abonnement

Mes abonnements

Abonnement aux annonces de la catégorie : "Motos / 2 roues™ ° @

Abonnement aux annonces de la catégorie : "Equipement Auto/Motos” ° @

Abonnement au filtre de recherche d’annonces suivant ° @

Mots clés : "coffret”

Retour
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